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Abstract 
This manual describes the computer program CONTAMW version 2.0 developed by NIST. 
CONTAMW is a multizone indoor air quality and ventilation analysis program designed to help 
you determine: airflows and pressures – infiltration, exfiltration, and room-to-room airflows and 
pressure differences in building systems driven by mechanical means, wind pressures acting on 
the exterior of the building, and buoyancy effects induced by temperature differences between 
the building and the outside; contaminant concentrations – the dispersal of airborne 
contaminants transported by these airflows and transformed by a variety of processes including 
chemical and radio-chemical transformation, adsorption and desorption to building materials, 
filtration, and deposition to building surfaces; and/or personal exposure – the prediction of 
exposure of building occupants to airborne contaminants for eventual risk assessment. 

CONTAMW can be useful in a variety of applications. Its ability to calculate building airflows 
and relative pressures between zones of the building is useful for assessing the adequacy of 
ventilation rates in a building, to determine the variation in ventilation rates over time, to 
determine the distribution of ventilation air within a building, and to estimate the impact of 
envelope air tightening efforts on infiltration rates. The program has been used extensively for 
the design and analysis of smoke management systems. The prediction of contaminant 
concentrations can be used to determine the indoor air quality performance of buildings before 
they are constructed and occupied, to investigate the impacts of various design decisions related 
to ventilation system design and building material selection, to evaluate indoor air quality control 
technologies, and to assess the indoor air quality performance of existing buildings. Predicted 
contaminant concentrations can also be used to estimate personal exposure based on occupancy 
patterns. 

Version 2.0 contains several new features including: non-trace contaminants, unlimited number 
of contaminants, contaminant-related libraries, separate weather and ambient contaminant files, 
building controls, scheduled zone temperatures, improved solver to reduce simulation times and 
several user interface related features to improve usability. 

Key Words: airflow analysis; building controls; building technology; computer program; 
contaminant dispersal; controls; indoor air quality; multizone analysis; smoke control; smoke 
management; ventilation 
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Disclaimer 
This software was developed at the National Institute of Standards and Technology by 
employees of the Federal Government in the course of their official duties. Pursuant to title 17 
Section 105 of the United States Code this software is not subject to copyright protection and is 
in the public domain. CONTAMW is an experimental system. NIST assumes no responsibility 
whatsoever for its use by other parties, and makes no guarantees, expressed or implied, about its 
quality, reliability, or any other characteristic. We would appreciate acknowledgement if the 
software is used. This software can be redistributed and/or modified freely provided that any 
derivative works bear some notice that they are derived from it, and any modified versions bear 
some notice that they have been modified. 

Users are warned that CONTAMW is intended for use only by persons competent in the field of 
airflow and contaminant dispersal in buildings and is intended only to supplement the judgment 
of the qualified user. The computer program described in this report is a prototype methodology 
for computing the airflows and contaminant migration in a building. The calculations are based 
upon a simplified model of the complexity of real buildings. These simplifications must be 
understood and considered by the user. 

Certain trade names and company products are mentioned in the text or identified in an 
illustration in order to adequately specify the equipment used.  In no case does such an 
identification imply recommendation or endorsement by the National Institute of Standards and 
Technology, nor does it imply that the products are necessarily the best available for the purpose. 
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 INTRODUCTION – WHAT IS CONTAMW? 

1 Introduction 
1.1 What is CONTAMW? 
CONTAMW is a multizone indoor air quality and ventilation analysis computer program 
designed to help you determine: 

 (a) airflows:  infiltration, exfiltration, and room-to-room airflows in building systems driven 
by mechanical means, wind pressures acting on the exterior of the building, and 
buoyancy effects induced by the indoor and outdoor air temperature difference. 

(b) contaminant concentrations:  the dispersal of airborne contaminants transported by these 
airflows; transformed by a variety of processes including chemical and radio-chemical 
transformation, adsorption and desorption to building materials, filtration, and deposition 
to building surfaces, etc.; and generated by a variety of source mechanisms, and/or 

(c) 0personal exposure:  the predictions of exposure of occupants to airborne contaminants 
for eventual risk assessment. 

CONTAMW can be useful in a variety of applications. Its ability to calculate building airflows is 
useful to assess the adequacy of ventilation rates in a building, to determine the variation in 
ventilation rates over time and the distribution of ventilation air within a building, and to 
estimate the impact of envelope air tightening efforts on infiltration rates. The prediction of 
contaminant concentrations can be used to determine the indoor air quality performance of a 
building before it is constructed and occupied, to investigate the impacts of various design 
decisions related to ventilation system design and building material selection, and to assess the 
indoor air quality performance of an existing building. Predicted contaminant concentrations can 
also be used to estimate personal exposure based on occupancy patterns in the building being 
studied. Exposure estimates can be compared for different assumptions of ventilation rates and 
source strengths. 

1.2 What's New in This Version? 
Throughout this manual you will find new features of the program highlighted with either solid 
grey lines in the margins (printed version) or in a different color text (on-line version) as 
illustrated by this paragraph. 

CONTAMW 2.0 maintains the same features as CONTAMW 1.0 [Dols, Walton and Denton 
2000] with many enhancements - several of which are listed below. CONTAMW 2.0 is 
backwards compatible with version 1.0 meaning you can open existing projects created with 
CONTAMW 1.0. 

Enhancements to CONTAMW 2.0 

• Building controls – Controls include sensors, actuators, modifiers and links. Control 
actuators can be used to modify various characteristics of building components based on 
control signals obtained from sensors and even modified by signal modifiers. For example, a 
sensor can be used to obtain a contaminant concentration within a zone, and a proportional 
control actuator can be used to adjust supply airflow into the zone based on the sensed 
concentration.  
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INTRODUCTION – SYSTEM REQUIREMENTS 

• Scheduled zone temperatures – Zone temperatures can now be varied through the use of user-
defined schedules. This allows for the change in zone pressures due simply to the change in 
temperature within the zone according to the ideal gas relationship. 

• Contaminants 
o Non-trace contaminants – You can now account for the impact of contaminant 

concentrations on the density of the air, e.g., water vapor. 
o Unlimited number of contaminants – CONTAM no longer restricts the number of 

contaminants you can simulate. The previous limitation was 10. 
o Contaminant-related libraries – Contaminant related elements can now be shared through 

CONTAM library files. These elements include contaminant species, filters, source/sinks 
and kinetic reactions. 

• Numerical methods 
o Variable air density – CONTAMW now provides the ability to simulate non-flow related 

processes that can lead to the accumulation/reduction of mass within building zones, e.g., 
due to non-trace contaminant sources and to variations in the zone pressure due to the 
change in zone temperature. 

o Improved numerical solver implementing sparse matrix techniques to greatly reduce 
transient simulation times for large problems. 

o Separated solver from graphical user interface to provide for batch execution of 
simulations and directly utilize .PRJ files. 

• Transient weather 
o Separate transient weather and contaminant files – Weather files (.WTH) no longer 

contain contaminant concentrations (except for outdoor humidity ratio). This means you 
don’t have to create different weather files depending on the types of contaminants you 
are simulating. CONTAM now provides you with the option of simulating transient 
ambient contaminant concentrations using a contaminant file (.CTM). 

o Weather file creation/conversion software – NIST has developed a software tool that 
allows you to convert existing weather files to CONTAMW 2.0 compatible weather files. 
You can convert your existing 1.0-compatible files, TMY2 and EnergyPlus weather files. 

• User interface 
o Longer zone names – Zone names can now be up to 31 characters long. 
o SketchPad zooming feature – You can now reduce the icon size of the SketchPad to 

allow the display of larger projects on the screen. 
o Display of net inter-zonal airflow results for highlighted zones 
o Distinct simple air-handling system zones – The implicit zones of multiple simple air-

handling system are now distinguished from each other to allow for the plotting of 
individual system zones. 

o Airflow direction indicators are now displayed in the Status Bar when viewing airflow 
path results. 

 

1.3 System Requirements 
CONTAMW runs under Windows 95/98, NT/2000, and XP. 

 

 2



 GETTING STARTED – INSTALLING CONTAMW 

2 Getting Started 
2.1 Installing CONTAMW 
� Obtaining CONTAMW 
CONTAMW installs from a set of installation files that you can obtain from NIST. These files 
can either be downloaded from the NIST website (www.bfrl.nist.gov/IAQanalysis) directly onto 
your computer's hard disk, or you can obtain a set of floppy disks or CD that contains the setup 
files from the Indoor Air Quality and Ventilation Group (301) 975-6431. 

� Installing CONTAMW 
If you downloaded CONTAMW from the NIST website then you first double click the self-
extracting archive file "contamw2z.exe" to decompress the setup files. Extract the files to the 
subdirectory of your choice, or simply select the default location. Once you have extracted the 
setup files, you can run the setup program, "setup.exe." This will prompt you to perform an 
automatic installation of the program. Read the directions to complete the installation. 

To install from a set of floppy disks or CD, insert the disk labeled "Disk 1" into the drive and run 
the program, "setup.exe." This will prompt you to perform an automatic installation of the 
program. Follow the directions to complete the installation. 

� Files Installed 
The following table lists the files installed by the setup program. For each file, the directory to 
which it is installed, the name and a brief description are given. The <program> directory is that 
selected by you when you install the program. The default is C:\Program Files\CONTAMW2. 
The <font> directory is that of the operating system fonts. The default is <windows>/FONTS, 
where <windows> depends on the operating system you are using, e.g., Windows 2000 
<windows> = WINNT and Windows 95/98 <windows> = WINDOWS. 

Directory File Name Description 

<program> contamw2.exe user interface 

 contamx2.exe Solver 

 contam.cfg Configuration file 

 cwhelp2.hlp 
cwhelp2.cnt 

help files 

 olch2d32.dll 
roboex32.dll 

charting and help display 
dynamic link libraries 

<program>\samples *.prj, *.wth and *.ctm sample project files 

 *.lb? CONTAM library files 

<font> walton##.fnt SketchPad fonts where ## 
ranges from 01 to 16 for 
different SketchPad 
resolutions 
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GETTING STARTED – RUNNING CONTAMW 

� Uninstalling CONTAMW 
The CONTAMW setup program will also provide you with an uninstall feature. You uninstall 
CONTAMW much as you would a typical Windows program. Access the Control Panel from 
the Settings selection of the Start menu. Select Add/Remove Programs from the Control Panel. 
Select CONTAMW from the list of installed programs and click the "Add/Remove…" button to 
uninstall CONTAMW. 

2.2 Running CONTAMW 
After you install CONTAMW, you can run it by selecting CONTAMW from the NIST program 
group of the Start menu. 

2.3 User Tasks 
The use of CONTAMW to analyze airflow or contaminant migration in a building involves five 
distinct tasks: 

1. Building Idealization:  Form an idealization or specific model of the building being 
considered, 

2. Schematic Representation:  Develop a schematic representation of the idealized building 
using the CONTAMW SketchPad to draw the building components, 

3. Define Building Components: Collect and input data associated with each of the building 
components represented on the SketchPad, 

4. Simulation:  Select the type of analysis you wish to conduct, set simulation parameters, 
and execute the simulation,  

5. Review & Record Results:  Review the results of your simulation and record selected 
portions of the results. 

� Task 1 - Building Idealization 
Building idealization refers to the simplification of a building into a set of zones that are 
relevant to the user’s goal in performing an analysis. A building can be idealized in a number 
of ways depending on the building layout, the ventilation system configuration and the 
problem of interest. This idealization phase of analysis requires some engineering knowledge 
on the part of the user and is an acquired skill that you can develop through experience in 
airflow and indoor air quality analysis and by becoming familiar with the theoretical 
principles and details upon which indoor air quality analysis is based. 

It is important to note that CONTAMW provides a macroscopic model of a building. In this 
macroscopic view, each zone is considered to be well-mixed. Well-mixed means that a zone 
is characterized by a discrete set of state variables, i.e., temperature, pressure and 
contaminant concentrations. CONTAMW is well suited for analyzing the interaction between 
the zones of a building on a macroscopic level but is not well suited for the analysis of the 
microscopic airflow and contaminant characteristics within a given zone of a building. 
Computational Fluid Dynamics (CFD) analysis is better suited for analyzing the airflow and 
contaminant transport characteristics of a given zone of a building. However, to date the 
computational resources required to perform a CFD analysis for an entire building is 
prohibitive. 
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� Task 2 - SketchPad Representation  
Developing the SketchPad representation will be the focus of your interaction with 
CONTAMW. With CONTAMW's SketchPad you will be able to draw a diagram – a  
SketchPad diagram – of your building idealization using drawing tools and libraries of icons 
to represent components of the building system. CONTAMW translates your diagram into a 
system of equations that will than be used to model the behavior of the building when you 
perform a simulation.  

� Task 3 -  Data Entry  
Data entry can be one of the more time-consuming parts of the process of using 
CONTAMW. It involves the determination and input of the numerical values of the 
parameters associated with each of the SketchPad icons. These icons represent the elements 
of the building model and include air leakage paths (windows, doors, cracks), ventilation 
system elements (fans, ducts, vents), contaminant sources, filters, and sinks and control 
network components. Each of these elements is associated with a number of parameters, and 
you must obtain the values of these parameters for entry into the model. Depending on the 
element and the application, these values can be obtained from building-specific data, 
engineering handbooks, and product literature. In many cases, a degree of engineering 
judgment will be involved. CONTAMW allows you to create libraries of these elements that 
you can use in current and future modeling efforts. 

� Task 4 -  Simulation 
Simulation is the use of CONTAMW to solve the system of equations assembled from your 
SketchPad representation of a building to predict the airflow and contaminant concentrations 
of interest. This step involves determining the type of analysis that is needed; steady- state, 
transient or cyclical, and a number of other simulation parameters. These parameters depend 
on the type of analysis you wish to perform (steady state or transient), and include 
convergence criteria and in the case of a transient analysis, time steps and the duration of the 
analysis. 

� Task 5 -  Review & Record Results  
CONTAMW allows you to view the simulation results on the screen and to output them to a 
file for input to a spreadsheet program or a data analysis program developed by the user. 
Airflows and pressure differences at each flow element can be viewed directly on the 
SketchPad. Contaminant concentrations for a zone can also be plotted as a function of time 
directly from the SketchPad. You can then decide which data you wish to examine more 
closely and export these to a tab-delimited text file that can then be imported into a 
spreadsheet for further analysis. 

There is also a controls-related feature that provide the ability to report the values of user-
selected control nodes to a control "log" file for each time step of a transient simulation. 

 5



GETTING STARTED – THE CONTAMW GRAPHICAL USER INTERFACE 

2.4 The CONTAMW Graphical User Interface 
The CONTAMW graphical user interface (GUI) is what you use to create and view your airflow 
and contaminant dispersal analysis projects. It consists mainly of a drawing region referred to as 
the SketchPad, a set of drawing tools, a title bar, a set of menus, and a status bar. The following 
sections provide brief explanations of each of the features of the CONTAMW GUI. See the 
Using CONTAMW section for details on how to use these features.  

 

 
Figure - The CONTAMW Graphical User Interface 

2.4.1 SketchPad 
The SketchPad is the region of the CONTAMW screen where you draw the schematic 
representation of a building you wish to analyze. This representation is in the form of a set of 
simplified floor plans that represent the levels of a building. The SketchPad is used to establish 
the geometric relationships of the relevant building features and is not intended to produce a 
scale drawing of a building. It should be used to create a simplified model where the walls, 
zones, and airflow paths are topologically similar to the actual building (See Working with the 
SketchPad). 

2.4.2 Title Bar 
The title bar is the typical rectangular region at the top of the main CONTAMW window. The 
CONTAMW project filename will be displayed within this region. 

2.4.3 Menu 
The menu is typical of a Windows program with differences that provide functionality specific to 
the CONTAMW application. It is through this menu that most CONTAMW operations can be 
performed including: saving and retrieving project files, selecting various modes of display, 
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setting up and performing simulations, as well as accessing the on-line help system. Note that 
some of the menu items have shortcuts or hot-keys that enable quick access; for example, to save 
the current project file use the Ctrl+S key combination. 

2.4.4 Toolbar 
The toolbar, shown in the following figure, appears below the menu and provides convenient 
shortcuts to some of the menu items. Several of the toolbar buttons are similar to those found in 
other Windows applications. Other buttons provide a shortcut to functionality specific to 
CONTAMW. 

  

2.4.5 Status Bar 
The status bar, shown in the following figures, is the region displayed below the SketchPad at the 
bottom of the main window. This region is broken up into three separate panes that display 
various information depending on the current mode of the SketchPad.  

� Left Pane 
This pane always displays the type and number of building component icon, e.g., zone, path, air 
handling system, etc.  

In the normal mode of operation, the leftmost pane displays summary information of the 
currently highlighted cell or icon.  

In the simulation results mode, the leftmost pane displays the results for the currently highlighted 
icon. For a zone this includes the temperature and pressure relative to the ambient pressure at the 
base of the building (see Wind Properties), for paths it will be the airflow and pressure drop 
across the path along with symbols to indicate the direction of flow (>, <, ^, v). For a simple air 
handling system icon the outdoor airflow, recirculation airflow and exhaust airflows for the 
implicit flow paths will be displayed. 

� Center Pane 
In the normal mode of operation, the center pane indicates the location of the currently 
highlighted icon or cell in SketchPad coordinates (numbered from the top-left corner). In the 
simulation results mode the center pane displays the current simulation time step for which the 
results are being displayed.  

� Right Pane 
The rightmost pane displays the name and number of the current level and the total number of 
levels in the project.  

  
Status Bar during Normal Mode of operation 

 
Status Bar displaying airflow path results during Results Viewing Mode of operation 
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GETTING STARTED – COMPONENTS OF A CONTAMW PROJECT 

2.5 Components of a CONTAMW Project 
2.5.1 Project Files 
All data related to the characteristics of the projects you work with are stored in a "project" file 
having a "PRJ" extension (See Working with Project Files). This is an ASCII file, which is 
intended to be "viewed" only by the CONTAMW program. You should keep careful records of 
your project files and establish a naming convention that is meaningful to you for the various 
versions of a project that you may wish to save. 

There are other files utilized by CONTAMW including: simulation results files, weather files, 
library files, and the log file. Simulation results are stored in files created automatically by 
CONTAMW with the same name as the PRJ file except that the "PRJ" extension is replaced by 
the "SIM," "SUM" and "EXP" extensions depending on the type of results generated by the 
simulation (see Working with Simulation Results). Weather files and contaminant files, typically 
given the WTH and CTM extension, respectively, may contain up to a years worth of weather 
and outdoor contaminant data and are used when performing transient simulations (see Working 
with Weather). Weather and contaminant files are ASCII files, but the data is of a format unique 
to CONTAMW. Library files are the means by which you can share various types of data 
between CONTAMW projects. Each type of library data has a different extension: LB0 
(contaminants and source/sinks), LB1 (schedules), LB2 (wind pressure profiles), LB3 (airflow 
elements) or LB4 (duct flow elements). You create libraries of data using CONTAMW (see 
Working with Data and Libraries). The log file, "CONTAMW2.LOG," is created in the directory 
in which the executable program resides each time you run the program. This file keeps track of 
operations that you perform during your session with CONTAMW and is a useful tool in the 
event that you require technical support from the program developers when working with the 
program (see Getting Help). 

2.5.2 Building Components 
Building components are the items that characterize the physical makeup of a building that you 
define using the CONTAMW graphical user interface. This section briefly describes these 
components. 

� Levels 
CONTAMW represents buildings in terms of multiple levels, accounting for the 
communication of air and contaminants between these levels. Levels typically correspond to 
floors of a building, but a suspended ceiling acting as a return air plenum or a raised floor 
acting as a supply plenum may also be treated as a level.   

� Walls 
Walls are used to designate zones which are regions surrounded by walls, floor and ceiling. 
These walls include the building envelope and internal partitions with a significant resistance 
to airflow. 

� Floors and Ceilings 
Floors and ceilings are included implicitly by CONTAMW for building zones. When you 
draw a zone on the SketchPad, CONTAMW automatically includes the floor of the zone. To 
create a roof with penetrations into the floor below requires a blank level above the top floor. 
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It is also possible to create a phantom zone with no floor or ceiling as might be required to 
create an atrium that spans multiple levels (see Working with Zones). 

� Zones 
A zone indicates a volume of air with uniform temperature and contaminant concentration. 
There are three types of zones in CONTAMW: normal, phantom and ambient. Normal zones 
are separated from the zone below by a floor. The ambient zone, which surrounds the 
building is implicitly defined and is identified by the symbol at the upper-left corner of the 
SketchPad. Any additional ambient zones must be connected to the default ambient zone. For 
example, you could use an ambient zone icon to define a courtyard. Phantom zones indicate 
that the area on the current level is actually part of the zone on the level immediately below. 
There is no floor between a phantom zone and the zone below. You could use the phantom 
zone to define building features such as an atrium. 

� Airflow Paths 
An airflow path indicates some building feature by which air can move from one zone to 
another.  Such features include cracks in the building envelope, open doorways, and fans. 
Path symbols placed on the walls are used to represent openings between zones or to 
ambient; any other placement represents an opening in the floor to the zone on the level 
below. CONTAMW can implement several different models or airflow elements to define 
airflow paths. The basic categories of airflow elements or models are as follows: small and 
large crack/openings represented by power-law and quadratic pressure relationships, small 
and large doorways elements, and fan/forced airflow elements. (See Working with Airflow 
Paths) 

� Simple Air-handling Systems 
The simple air-handling system (AHS) provides a simple means of introducing an air-
handling system into a building without having to draw a duct system. It provides a 
reasonable model of an air-handling system that delivers user-specified flows where the 
system is properly balanced and the fan is not impacted by any other pressurizing effects in 
the building. The AHS consists of two implicit airflow nodes (return and supply), three 
implicit flow paths (recirculation, outdoor, and exhaust air), and multiple supply and return 
points that you place within the zones of the building. You can set the air flows of the AHS 
to vary according to a schedule. 

� Ducts 
You can use ducts to implement a more detailed model of an air-handling system that 
handles a broader range of conditions.  For example, when an air handler is off, the ductwork 
may provide flow paths between zones which are significant in relation to the normal 
construction cracks or openings. Ductwork consists of duct segments (paths) and junctions or 
terminal points (nodes). CONTAMW can implement several different duct segment models 
or duct flow elements to define duct segments. The basic categories of duct flow elements are 
as follows: resistance models, fan performance curves, and back-draft dampers. (See 
Working with Ducts) 

 9



GETTING STARTED – COMPONENTS OF A CONTAMW PROJECT 

� Contaminants, Sources and Sinks 
You can define an unlimited number of contaminants within a single project with a 
practically limitless number of sources associated with the contaminants. CONTAMW can 
simulate contaminant transport via airflow between zones, removal by filtration mechanisms 
associated with flow paths, and removal and addition by chemical reaction. CONTAMW can 
also implement several source and sink models to generate contaminants within or remove 
contaminants from a zone. These models include: constant generation, pressure driven, 
decaying source, cutoff concentration, reversible boundary layer diffusion, and burst models. 
(See Working with Contaminants and Working with Sources and Sinks) 

� Schedules 
Schedules are used to control or modify various properties of building components as a 
function of time. You can set schedules for airflow paths, duct flow paths; contaminant 
sources and sinks; and inlets, outlets and outdoor air delivery of simple air-handling systems. 
The effect of setting a schedule on a building component varies depending on the properties 
of the component. For example, you can set a schedule to adjust the airflow delivered to a 
zone by an inlet of a simple air-handling system. (See Working with Simple Air Handling 
Systems) 

CONTAMW 2.0 provides the ability to schedule zone temperatures. 

� Controls 
Controls include sensors, actuators, modifiers and links. Control actuators can be used to 
modify various characteristics of building components based on control signals obtained 
from sensors and even modified by signal modifiers. For example, a sensor can be used to 
obtain a contaminant concentration within a zone, and a proportional control actuator can be 
used to adjust supply airflow into the zone based on the sensed concentration. 

2.5.3 Occupants 
Occupants can be used to determine the amount of contaminant exposure a person would be 
subjected to within a building. Occupants can also generate contaminants. You can set a schedule 
to establish each occupant’s movement within a building. Occupant schedules can also be used 
to define periods of times when occupants are not in the building. (See Working with Occupant 
Exposure) 

2.5.4 Weather 
CONTAMW enables you to account for either steady-state or varying weather conditions. 
Weather conditions consist of ambient temperature, barometric pressure, humidity ratio, wind 
speed and direction, as well as ambient contaminant concentrations. 

2.5.5 Wind Pressure Profiles 
Wind pressure profiles are used to describe the wind direction effects on the envelope of a 
building. Wind pressure profiles simplify the somewhat difficult process of accounting for the 
fact that the facades of a building envelope are affected differently depending on their orientation 
relative to the wind. 
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2.5.6 Simulation 
In CONTAMW, simulation is the process of forming a set of simultaneous equations based upon 
the information stored in the project file, performing the numerical analysis to solve the set of 
nodal equations according to user-defined specifications, and creating simulation results files that 
can be viewed using the CONTAMW interface. There are three basic types of simulations that 
you can perform for airflow and contaminant analysis using CONTAMW: steady state, transient 
and cyclical. (see Working with Simulations)  
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3 Using CONTAMW 
This section provides detailed information on how to use the features of the CONTAMW 
application as well as a detailed explanations of the terminology of the user interface. You 
should think of this section as your detailed conceptual and contextual guide to working with the 
CONTAMW program. 

3.1 Working with the SketchPad 
The SketchPad is the region of the CONTAMW screen where you draw the schematic 
representation of a building you wish to analyze. This representation is in the form of a set of 
simplified floor plans that represent the levels of a building. The SketchPad consists of an 
invisible array of cells into which you place various icons to form your schematics of a building. 
The SketchPad is used to establish the geometric relationships of the relevant building features 
and is not intended to produce a scale drawing of a building. It should be used to create a 
simplified model where the walls, zones, and airflow paths are topologically similar to the actual 
building. 

When working with CONTAMW you will notice a blinking square on the SketchPad. This is 
known as the system caret, and it is the size of a single SketchPad cell. This caret is the same 
thing as the blinking vertical bar that is common to many word processing applications. The 
caret indicates the currently selected cell of the SketchPad. Any icon-related information that 
appears in the status bar is associated with the location of the caret. To move the caret around the 
SketchPad you can use the keyboard arrow keys or you can move the system cursor with the 
mouse and click the left mouse button to set the caret position. 

The specific operations that you will perform using the SketchPad are as follows: 

 1. Drawing Walls, Ducts and Controls  

 2. Drawing building component icons  

 3. Defining building component icons  

 4. Viewing results  

5. Viewing envelope pressure differentials due to wind effects  

� SketchPad Modes 
There are three modes of the SketchPad: normal, results and wind pressure. The SketchPad 
mode basically refers to the type of information that is displayed upon the SketchPad. You 
can tell what mode the program is in by looking at the items in the View menu to see which 
ones are checked. 

In the normal mode CONTAMW displays only the building component icons. In this mode 
you can add, delete, copy, and move icons. 

In the results mode, CONTAMW displays simulation results upon the SketchPad. In this 
mode you will not be allowed to add, delete, copy and move icons upon the SketchPad (See 
Viewing Results).  

The wind pressure mode is provided to verify wind speed and direction information visually 
on the SketchPad. (See CheckingWind) 
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� Printing SketchPad Images 
You can obtain images of your SketchPad drawings to print or edit using the Windows print 
screen feature. To do this, size the CONTAMW window and press Alt+PrintScrn on the 
keyboard to copy the current window to the Windows clipboard. Then you can immediately 
paste the image into the desired program. For example, you can paste the image into the 
Windows Paint program for editing or directly into a word processing program. You can then 
print the image from either of these programs. 

� Exporting .PCX SketchPad Files 
You can save a SketchPad image of the currently displayed level to a .PCX graphics file 
using the File → Save SketchPad to .PCX File… menu item. The Save As dialog box will 
appear allowing you to name the file. The file will contain a black and white image made up 
of 8 by 8 pixel icons. 

3.1.1 Drawing Walls, Ducts and Controls 
You use various tools to draw the physical features of the building such as walls and ducts. All 
drawing can be accomplished with either the mouse or the keyboard. When drawing, the 
following mouse and keyboard keys produce common behavior. The left mouse button (LMB) 
corresponds to the ↵ , or Enter key; the right mouse button (RMB) to the Esc key. Vertical 
motion of the cursor corresponds to the ↑ and ↓  cursor keys, and horizontal motion corresponds 
to the ← and → cursor keys. 

The basic steps for drawing walls and ducts are as follows: 

1. Activate drawing tool, 

2. Set the initial location of the object, 

3. Draw the object, 

4. Undo current drawing, 

5. Finalize drawing the object, and 

6. Deactivate drawing tool. 

� Activating a Drawing Tool  
There are four drawing tools available, two for drawing walls, one for drawing ducts and one for 
drawing control networks. To activate a drawing tool either select it from the toolbar, select it 
from the "Tools"  menu, or use the shortcut associated with the menu item. The toolbar button of 
a selected drawing tool will remain depressed as long as that tool is active. The toolbar buttons 
and associated menu shortcuts are shown here. 

 rectangle (or box) drawing tool (Ctrl+B) 

 free-form wall drawing tool (Ctrl+W) 

 duct drawing tool (Ctrl+D) 

 controls drawing tool (Ctrl+L)   
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Once you have selected the tool, the drawing cursor will be displayed. The drawing cursor is a 
pink square the size of a single SketchPad cell. Initially, the cursor appears with a transparent 
center. 

� Setting the Initial Location of the Object 
To begin drawing the object, you set the initial location by first moving the drawing cursor either 
with the mouse or the keyboard arrow keys and then you either click the LMB or press ↵  on the 
keyboard. This will anchor the beginning of the object at the nearest valid SketchPad cell for the 
type of object you are drawing. When you select a valid beginning location, the drawing cursor 
will become solid and you can begin drawing your object. 

� Drawing the Object 
After you anchor the beginning of the object, you simply use the mouse and/or keyboard arrow 
keys to draw the desired shape. While you are drawing, the cursor will be restricted to the 
SketchPad region and constrained to specific movements in order to maintain drawing within 
valid cells of the SketchPad. As you move the cursor, a dark line will appear on the SketchPad 
representing the shape of the object you are drawing.  

� Undoing the Current Drawing 
Prior to finalizing the drawing of the object, you can undo your drawing. To undo what you have 
drawn, either single-click the RMB or press the Esc key. This will erase the thick dark line, but 
you will still be in the drawing mode. To begin drawing again, set the initial location again and 
continue drawing another object. 

� Finalizing the Drawing Object 
Once you are satisfied with your drawing, you finalize the object by either single-clicking the 
LMB or pressing the ↵  key. This will replace the cells that had the thick dark line with the icons 
appropriate for completing the type of object you are drawing. If you have attempted to draw an 
invalid object, you will be prompted with a dialog box containing a message indicating the type 
of error, and then you will be allowed to repair the drawn object. 

� Deactivating Drawing Tools 
When you are finished using a drawing tool you click the RMB or press Esc until your system 
cursor reappears. Also, selecting a different drawing tool will automatically deactivate the 
current tool if you do not currently have an object anchored. 

3.1.2 Drawing Building Component Icons 
A set of icons is used to represent various building components such as airflow paths 
(representing doors, windows, cracks, etc.), contaminant sources and sinks, occupants and air-
handling systems. You place icons on the SketchPad using the Right Mouse Button to display 
a pop-up menu and then selecting the desired building component from the menu.  

This icon placement menu is context-sensitive. The menu selections that you can choose from 
the icon placement menu will depend on the contents of the cell occupied by the caret and 
whether the SketchPad is currently displaying simulation results. When results are being 
displayed, you will not be allowed to place additional icons on or delete icons from the 
SketchPad. This is done to prevent the display of misleading results on the SketchPad due to a 
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mismatch in the number of icons on the SketchPad and the number of icons for which results are 
available from the last simulations. The icon placement menu will also prevent you from placing 
icons on invalid SketchPad locations. For example, you cannot place a supply or return of a 
simple air-handling system within the ambient zone. 

The following figure shows the pop-up icon placement menu. 

 
 

The following table is a list of the icons that you will see on the CONTAMW SketchPad. This 
list shows the icons by categories of building components. Some of these icons are placed on the 

Icon Category Component Icons 

Walls   

Zones   

Duct Segments   

Duct Junctions   

Duct Terminals   

Simple AHS   

Airflow Paths   

Source/Sinks   

Occupants   

Controls  
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SketchPad using the drawing tools, and others are placed using the pop-up icon placement menu. 

3.1.3 Defining Building Component Icons 
When a new building component icon is drawn upon the SketchPad, it appears as a red icon. The 
color red indicates that the parameters of the component must still be defined. To define a 
building component, you double-click (LMB) on the icon or move the caret (represented by a 
black square) to the icon and press the Enter key. This will activate the associated dialog box or 
property sheet for the selected component, into which you enter the parameters that define the 
component. After you have entered the parameters of the component, click the OK button to 
accept the parameters or the Cancel button not to accept the parameters. The detailed properties 
of each component icon will be presented throughout the "Using CONTAMW" section of this 
manual. You can also access detailed descriptions of the component properties by pressing the 
F1 key (Help) while running the CONTAMW application. 

3.1.4 Deleting Building Component Icons 
To delete undefined building component icons, you highlight the icon then delete it. You 
highlight the icon by either clicking (LMB) on the icon or moving the caret (represented by a 
black square) to the icon using the arrow keys. You delete the highlighted icon by either pressing 
the Delete key or using the menu command: Edit → Delete. 

3.1.5 Viewing Results on the SketchPad 
CONTAMW provides some graphical displays of simulation results upon the SketchPad. You 
can display airflow rates and pressure differences across airflow paths on the SketchPad if a 
simulation has been performed and results of the simulation are available (see Viewing Results 
in the Working with Results section of the manual).  

3.1.6 Viewing Envelope Wind Pressure Differentials 
CONTAMW provides a feature that allows you to visualize the effects of wind upon a building 
envelope. A graphical display of wind pressures at each of the flow paths that are adjacent to the 
ambient zone can be viewed on the SketchPad (see Checking Wind Pressure Data in the 
Defining Steady State Weather and Wind section). This feature enables you to verify input of 
wind speed and direction data with respect to the orientation of the building envelope to the 
wind. 
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3.2 Working with Project Files 
All information related to the layout, building components, and occupant information of your 
CONTAMW project are stored in a "project" file. When you save the project file, it will be 
stored with the ".PRJ" extension. CONTAMW project file names must conform to the file 
naming conventions of the Windows operating system. This project name is displayed in the 
Title bar of the CONTAMW application window. 

All project file operations are contained under the File menu. These operations include: New 
Project, Open Project…, Save Project, and Save Project As… Note that some of these file 
operations have keyboard short-cuts and/or tool bar buttons associated with them. 

� Creating a New Project 
Menu Command: File → New Project 
Keyboard Shortcut:  None 
Toolbar Button:   

Use this command if you are currently working on a project and you wish to create a new one. 
This command will clear the SketchPad and all data related to the current project from 
CONTAMW's program memory. If your current project has been not been saved prior to 
executing this command, you will be asked whether or not you wish to save it prior to clearing it. 

� Opening an Existing Project 
Menu Command: File → Open Project… 
Keyboard Shortcut: Ctrl+O 
Toolbar Button:    

Use the menu item to open and existing CONTAMW project file. This command will display the 
File Open dialog box typical of Windows applications. This dialog box is set to display only 
those files having the ".PRJ" extension in order to simplify your search for CONTAMW project 
files. Follow the typical procedure for opening a file using the Windows operating system.  

� Converting projects from CONTAMW 1.0 to CONTAMW 2.0 
Menu Command:  File → Open Project… 
Keyboard Shortcut:  Ctrl+O 

This is the same as opening an existing project. However, after you open a 1.0 formatted project 
it will be untitled, so you must give the project a name when saving it. Once you save a project 
with the 2.0 format, you will no longer be able to open it using 1.0. 

� Saving a Project 
Menu Command:  File → Save Project 
Keyboard Shortcut:  Ctrl+S 
Toolbar Button:   

This option saves the building description to the project file under its current name. Whenever 
the project file is saved, the current version of the file is copied to CONTAM.BKP before a 
revised project file is written. You may be able to use this file to restore a project file in the event 
that it becomes corrupted. 
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� Renaming a Project 
Menu Command:  File → Save Project As… 
Keyboard Shortcut:  None 
Toolbar Button:  None 

Use this command to save a copy of the current project file under a new name. This will display 
the Windows "Save As" dialog box and allow you to specify both a storage location and a file 
name for the project file. CONTAMW will automatically append the ".prj" extension to the 
filename, so you do not have to give the file an extension. If you do give the file an extension, 
".prj" will be appended as well as the extension you provide. If you specify the name of an 
existing file, you will be warned that saving the file will overwrite the existing file. If you try to 
save an untitled or new project file prior to giving it a name, the "Save As" dialog box will be 
displayed. 

� Exiting CONTAMW 
Menu Command:  File → Exit 
Keyboard Shortcut: None 
Toolbar Button:  None 

You can also exit the program using the standard window-closing button located in the upper 
right-hand corner of the program window. 

 

 

3.3 Configuring CONTAMW 
The project configuration settings of CONTAMW are available from the Options… selection of 
the View menu. This set of configuration properties will allow you to select the overall size of 
the SketchPad (i.e. the number cells that make up the height and width), the size of a single 
SketchPad cell, the default system of units (SI or IP), the default units of mass flow and the 
default zone temperature. All of these settings are saved with the CONTAMW project with the 
exception of the cell size that resets back to the default size whenever you exit CONTAMW. 
You can also save the default units and values and the available cell sizes to a configuration file, 
CONTAM.CFG. CONTAMW looks for this file when starting and loads the saved settings if the 
file exists. This way you can set CONTAMW to start with the same default settings each time 
you run the program. 

The following sections provide detailed descriptions of the specific configuration properties. 
They are the context-sensitive help topics that you can access by pressing F1 when working with 
property pages of the "Project Configuration Properties" property sheet. 

3.3.1 Default Units 
The following parameters define the units and selected values that will be used by default 
throughout the project when you are providing input to the program. You do not have to use 
these units throughout the project; however, you should select the primary set of units for 
convenience when entering data throughout a project. You can change these defaults at any time 
while working with a project, and you can select different units for individual parameters as you 
enter them. 
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Default System of Units: You can select the appropriate radio button to set the system of units 
that you would like the program to use. You can either select the International System of Units 
(SI) or the Inch-Pound (IP) system of units. 

Default Units of Flow: You can select the appropriate radio button for the most commonly used 
units of flow in the current project. These are the units in which airflow simulation results will be 
displayed within the status bar. CONTAMW converts all airflow rates to and performs all 
calculations in mass flow units of kg/s. Note that all volumetric airflow rate units are at standard 
temperature and pressure. 

Default Zone Temperature: This value will be the default temperature used whenever you 
create a new zone within the current project.  

3.3.2 SketchPad Size 
Sketchpad Size (cells): This is the height and width of the SketchPad. The units (cells) represent 
each space where an icon may be placed upon the SketchPad. The default (and minimum) values 
are 66 cells wide and 58 cells high. 

Shift Drawing (cells): If you need more space on one side of a drawing you can shift the entire 
project on the SketchPad. You may need to increase the size of the SketchPad to make room for 
the project before shifting it. Entering a positive number in the "Horizontally" edit box will shift 
the project to the right relative to the SketchPad, and entering a positive number in the 
"Vertically" edit box will move the project down relative to the SketchPad. A negative number 
will have the opposite effect. 

3.3.3 Cell/Icon Size 
Current Cell/Icon Size: There are seven options for displaying icons on the SketchPad (1x1, 
2x2, 3x3, 4x4, 5x5, 8x8, and 16x16). The default option is 8x8. This is a "zooming" feature that 
provides a visual aid to enable you to view sketches in more detail or to fit larger sketches within 
the program window. The cell size has no effect on the project simulation. There are two 
"zooming" buttons provided on the toolbar to quickly increase and decrease the cell size 
according to the available cell sizes below.  

Available Cell Sizes: Use these check boxes to select which sizes you want available. The 1x1 
size causes problems with some versions of the Window 98 operating system. If this is the case 
for you, then deselect the 1x1 check box and click the "Save Configuration" button. 
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3.4 Working with Walls 
In CONTAMW, walls separate regions of uniform air temperature and contaminant 
concentration on a given level. Walls include the building envelope and internal partitions with a 
significant resistance to airflow. The enclosed regions you create within walls are known as 
zones. You will note when drawing on the SketchPad that you can only draw walls in odd 
numbered rows and columns. This is done to avoid conflicts with ducts that can only be drawn 
on the even rows and columns of the SketchPad.  

It is important to realize that CONTAMW is not meant to provide drawing capabilities similar to 
that of a Computer Aided Drawing (CAD) program. The SketchPad drawing functions were 
designed to provide a strict environment for creating the input to the underlying multizone model 
upon which the CONTAMW simulation engine is based. 

3.4.1 Drawing Walls 
You can draw walls using either of the two wall drawing tools previously described in the 
"Working with the SketchPad" section. Use the box drawing tool to quickly draw a rectangular 
region and the wall drawing tool to draw a free form wall. Use the wall drawing tool to draw 
almost any shape wall. Walls must always form complete enclosures. Therefore, a wall cannot 
have an open or dangling end. It also may not be drawn across building component icons. You 
will receive a warning message if you attempt to draw an invalid wall. 

3.4.2 Deleting Walls 
You can delete a wall by moving the caret to any portion of the wall and selecting Delete from 
the Edit menu or using the keyboard shortcut Del key. CONTAMW will highlight the section of 
wall to be deleted and request confirmation to delete the indicated section. If the caret is on the 
intersection of three or more walls, you will be given multiple options of wall segments to delete. 
If you select "No" when asked to confirm deletion, the next option for deletion will become 
highlighted until you either delete a section or all of the options are exhausted. 
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3.4.3 Modifying Walls 
You modify the positions or shapes of walls by adding and deleting wall sections. For example 
in the following figures, if you want to modify the zone in figure (a) to obtain the zone in figure 
(d), you would first add the dark line in figure (b) then delete the dark line in figure (c). 

  

When modifying walls you may need to move or delete other icons. For example in the 
following figures, to create drawing (c) from drawing (a), you would delete the lighter line and 
the lighter zone icon from figure (b). You must delete one of the two zone icons, or you will end 
up with two zone icons within the same enclosed wall area. This is not permitted, and you will 
receive a message indicating a zone definition error. 
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3.5 Working with Levels 
CONTAMW projects are organized by levels. Each level of a CONTAMW project contains a 
plan view drawing. Typically, each level of a CONTAMW project corresponds to a floor of a 
building. Depending on the detail required for your modeling purposes, you could represent a 
building floor using multiple CONTAMW layers. For example, a level could be used to 
represent a ceiling or floor plenum. 

3.5.1 Creating Levels 
When you first start CONTAMW, a default level is created so that you can begin working on a 
drawing right away without having to create a new level. There are three commands in the Level 
menu that you use when creating new levels. These are the Copy Level, Paste Level, and Insert 
Blank Level commands. Whenever you create a new level, whether it is blank or a copy of 
another level, CONTAMW will give it a default name that will consist of a number enclosed 
within the "<" and ">" characters. You can modify this name later by editing the data associated 
with a level. 

You must be careful when copying levels within CONTAMW. For example, you might have an 
air handler defined within a duct system on a level and then copy it to another level. This would 
create another air handler on the new level. If the ductwork is connected between the two levels, 
the two air handlers may act against each other. You must be careful to make connections 
between building levels in a manner that makes sense for your purposes. 

� Creating Blank Levels 
Menu Command: Level → Insert Blank Level (Above/Below Current Level) 
Keyboard Shortcut:  None 
Toolbar Button:  None  

Use these commands to create a blank level. When you create a blank level, you must select 
whether you want it created above or below the current level. 

� Copying and Pasting levels 
Menu Command: Level → Copy Level along with 
   Level → Paste Level (Above/Below Current Level) 
Keyboard Shortcut:  None 
Toolbar Button:  None  

With CONTAMW you can copy an entire level and insert it as an entire level anywhere within 
the current project. Use the Copy Level command to copy the level currently displayed on the 
SketchPad; move to either the level above or below where you wish to insert the copied level and 
use one of the Paste Level commands to insert the copied level. 

3.5.2 Viewing Levels 
If a project has more than one level, you can specify the level that you want to view or modify on 
the SketchPad by using the level commands. All level-related commands are located under the 
Level menu. There are also some shortcut keys and toolbar buttons provided for your 
convenience. 
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� Changing the Currently Active Level 
Menu Command: Level → Go to (Level Above/Below) 
Keyboard Shortcut:  Page Up, Page Down 
Toolbar Button:    

Use this command to change which level you want the SketchPad to display. 

� Displaying Multiple Levels 
Menu Command: Level → Reveal Level Below 
Keyboard Shortcut:  Ctrl+Shift+B 
Toolbar Button:  None 

Use this command to see both the current level and the level below the current level at the same 
time. CONTAMW will displays the walls and building component icons of the level below in 
gray. This feature is useful for aligning building features between adjacent levels. 

3.5.3 Deleting Levels 
Menu Command: Level → Delete Level 
Keyboard Shortcut:  None 
Toolbar Button:   None  

Use this command to delete an entire level. Once you have deleted a level, you cannot undo the 
deletion. You may want to save a copy of the file prior to deleting a level; this is the only way to 
prevent losing your work. 

3.5.4 Modifying Levels 
To modify level data, you access the Level Data dialog box using the Edit Level Data… 
command of the Level menu. You can also use the keyboard shortcut F8 to display the dialog 
box. The following section shows the information contained on the "Level Data" dialog box. 

3.5.5 Level Data 
This is the information associated with each level that you create. CONTAMW will provide 
default values for this data, but you can modify it as required for your particular building. 

Name: Name to identify the level. All level names must be unique. 

Elevation of this level: The elevation of the base of the level above ground. 

Distance to level above: This is the height of the level from floor to ceiling. CONTAMW will 
use this value to calculate zone volumes based on the floor area of each zone. 

3.5.6 Checking Levels 
Menu Command: Level → Check Current Level 
Keyboard Shortcut:  None 
Toolbar Button:  None  

Use this feature to check the data for the currently displayed level and make sure the building 
components are defined. Errors will be highlighted in red. 
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3.6 Working with Zones 
A zone is a volume of air with uniform temperature and contaminant concentration. There are 
three different types of zones: normal, phantom and ambient. A normal zone icon represents a 
zone that is separated by a floor from the zone below. A phantom zone is used to indicate that 
there is no floor below the enclosed region on a given level. That is, the region on this level is 
actually part of the zone below and has the same temperature and contaminant concentration. An 
ambient zone icon represents the outdoor air. The ambient zone, which surrounds the building, is 
already identified by default by the icon at the upper-left corner of the SketchPad. 

You create zones on the SketchPad by first drawing walls that enclose a region, placing a single 
zone icon within the enclosed region, and then defining the zone icon. Eventually, every zone 
must be connected to either the ambient zone or a constant pressure zone either directly or 
indirectly via any set of paths that prevents the zone from being isolated from a zone of "known" 
pressure.  

3.6.1 Creating Zones 
You create zones by drawing walls upon the SketchPad. The wall drawing operations are 
described in the Drawing Walls section of this manual. The shape and size of zones as drawn 
upon the SketchPad do not provide the underlying model with any scaling information. 
However, the manner in which the enclosed regions border each other is significant. Any zones 
between which you wish to provide a direct connection (via an airflow path) must share a 
common wall. Therefore, when drawing a building floor plan, you should try to maintain the 
general topology of the actual floor plan. While scale is not significant, CONTAMW does 
provide you with the SketchPad coordinates that may help you when laying out your project. 

The dimensions of your zones are determined when you define them. If you change the shape or 
size of a region on the SketchPad that contains a zone icon, the dimensions do not change 
according to the model unless you actually modify the properties of the associated zone icon. 

3.6.2 Deleting Zones 
You delete a zone by first deleting the zone icon. After you delete the zone icon, delete the wall 
or walls necessary to eliminate the enclosed region that is left behind. You must avoid the 
existence of an enclosed region without a zone icon; CONTAMW will not perform a simulation 
with an undefined zone icon in a project. 

3.6.3 Modifying Zones 
You modify the SketchPad representation of a zone by adding and removing walls. This 
procedure is described in the Modifying Walls section of this manual. To modify the parameters 
of a zone, you use the icon definition procedure (See Defining Building Component Icons) to 
display its properties and make the desired changes. 

Once you define a zone, you can move the zone icon anywhere within the zone using the Cut 
and Paste functions of the Edit menu. These commands will only allow you to paste the icon 
into the zone in which it is currently located. 
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3.6.4 Defining Zones 
After you draw the enclosed region of a zone, you must define the zone. To define a zone you 
must first draw a zone icon within the enclosed region (See Drawing Building Component Icons) 
and then use the icon definition procedure (See Defining Building Component Icons) to display 
and edit the properties of the zone. 

The properties of each zone include a name, temperature (constant or scheduled), pressure, 
volume and information describing contaminant behavior within the zone. You must provide 
each zone with a name that is unique to each level of a project. For this reason, you cannot copy 
zone data within a level. However, you can copy entire levels of data, including zone data, from 
one level to another (See Creating Levels). Detailed descriptions of zone properties are given 
under Zone Properties below. 

Only normal zones require definition. Ambient and phantom zone icons appear as defined icons 
as soon as you place them onto the SketchPad. However, you must include the volume of 
phantom zones in the volume of the associated normal zone below it. 

3.6.4.1 Zone Properties 
This section provides detailed descriptions of the specific zone properties. The following 
sections are the context-sensitive help topics that you can access by pressing F1 when working 
with property pages of the "Zone Properties" property sheet. 

Zone – Zone Data Properties 
These are the basic properties that describe a zone. 

Zone Name: This is the symbolic name of the zone. Enter a name up to 15 characters in length. 
Zone names must be unique within each level of a building. 

Dimensions 
Volume: Zone volume is used in the dynamic contaminant calculations. For phantom zones, 
the zone volume is set at the standard zone icon on the lowest level for the entire height of 
the zone and includes the volume of the phantom zones on the levels above. 

Floor Area: Instead of the volume, you may enter a floor area. Floor area is then multiplied 
by the height of the current building level to compute a volume. This area is not used for any 
other purpose by CONTAMW.  

Temperature 

Constant or Scheduled: Select to either maintain zone temperatures at a constant value or 
to change according to a user-defined schedule. If you select Scheduled, then you must 
associate a temperature schedule with the zone. Selecting Scheduled will also set the 
simulation run control to vary the density within building zones during simulation (See 
Airflow Numerics Properties in the Working with Simulations section). 

Temperature: Set the value you want CONTAMW to use as the constant temperature of the 
zone when you select the "Constant" radio button. Whenever you create a new zone, 
CONTAMW use the default value which you can override by entering another value. You 
can set the default zone temperature via the Options… command of the View menu. 
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Temperature Schedule: Select the temperature schedule you want to associate with this 
zone when you select the "Scheduled" radio button. (See Working with Schedules). 

Pressure: The zone air pressure relative to ambient can be specified as either variable or 
constant. Typically you would set the zone pressure to be variable and let CONTAMW 
determine it. However, you might set the pressure to be constant if you want to simulate a fan 
pressurization (blower door) test of a building (see Building Pressurization Test in the 
Applications section of the manual) or to perform analytic test cases of CONTAMW.    

Zone – Contaminant Properties 
These are the contaminant-related properties of a zone. Contaminants must be defined prior to 
defining contaminant data for a zone. To define contaminants, select Data then Contaminants… 
from the main program menu. 

Zone Name: This is the symbolic name of the zone as entered on the Zone Data property page. 

Contaminant Concentrations: Select variable or constant. Typically you would set this to 
variable and allow CONTAMW to calculate the contaminant concentration within the zone. 
However, you may wish to set this to constant as a simple means of creating a simple 
contaminant source within a zone. If you set this to constant, the contaminant concentrations in 
this zone will begin and remain at the values you set for the initial concentrations. 

Initial Concentration: Select a contaminant from the list and enter the initial contaminant 
concentrations for dynamic (transient) simulations. Note that only those species you’ve selected 
to be contaminants (use in simulation) appear in the list. If a species for which you wish to set an 
initial concentration does not appear in the list you must set "Use in simulation" property of the 
corresponding species to be true (See Creating Species and Contaminants). You can reset these 
initial values through the Run Control Properties of the Simulation Parameters. 

IMPORTANT: Changing the number of contaminants, i.e. those species used in the simulation, 
will reset the initial concentrations of all zones to the default contaminant concentrations. You 
can reset all of these concentrations via the Run Control Properties as indicated above or 
individually here. 

Kinetic Reactions: If there are previously defined kinetic reactions within the current project, 
you may select one from the list of names. Click the "New Reaction" button to define a new 
kinetic reaction. To view or modify existing kinetic reaction data click the "Edit Reaction" 
button. Setting this field to <none> indicates no reactions in the zone. You can also import 
kinetic reactions from a contaminant-related library file (See Working with Data and Libraries). 
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3.7 Working with Airflow Paths 
An airflow path is a CONTAMW building component through which air can move between two 
adjacent zones. These components can be cracks in the building envelope, open doorways, 
exhaust fans, etc. The air pressures in the adjacent zones and the flow characteristics of the flow 
path itself determine the flow through most of these paths. The location of the SketchPad icon 
that represents a flow path determines the two zones that are connected by a flow path. If the 
path icon is placed on a wall, it connects the zones on opposite sides of the wall. If it is placed in 
a blank cell of a zone (i.e. on the floor), it connects the zone containing the flow path icon to the 
zone located directly below the flow path icon. 

You can place airflow paths on the SketchPad, define their flow characteristics, move, copy, and 
delete them. You must provide each airflow path with specific information that describes its flow 
characteristics. Much of the information that describes the flow characteristics of airflow paths is 
contained in airflow elements that you must create when defining the airflow paths. The details 
of drawing, defining and modifying airflow paths are described in the following sections. 

3.7.1 Airflow Elements 
Each airflow path must refer to an airflow element. Airflow elements describe the mathematical 
relationship between the flow through an airflow path and the pressure drop across the path. 
CONTAMW provides you with several mathematical models or types to choose from. Each of 
these airflow element types is described in detail in the Airflow Path Properties section. While 
every airflow path must refer to a single airflow element, multiple paths can refer to the same 
airflow element. Airflow elements can also be stored within a CONTAMW library file and shared 
between different CONTAMW project files (See Working with Data and Libraries). 

3.7.2 Creating Airflow Paths 
You create airflow paths by placing an airflow path icon on the SketchPad (See Drawing 
Building Component Icons). Because flow paths connect only two adjacent zones, there are 
several restrictions on the placement of flow paths. You may not place airflow path icons on the 
corner of a zone or on the blank cell of a level that does not have a zone located directly below it. 
Note that you can place an airflow path icon on the "roof" of a building that connects a zone 
below to the ambient. In this case, the roof level would be a level that does not contain walls but 
contains airflow path icons located in the floor of the roof level (above zones on the level below). 
The context-sensitive feature of the pop-up icon placement menu enforces these restrictions. The 
"Flow Path" menu selection will be disabled (grayed out) if you pop-up on a location where 
CONTAMW does not allow the icon to be placed. 

This list shows the various flow path icons and provides a brief description of each. 

 

Icons Description 

  Small and large one-way flow paths 

  Small and large two-way flow paths 

  Directional fan flow paths 
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3.7.3 Deleting Airflow Paths 
You delete airflow path icons using the icon deletion procedure (See Deleting Building 
Component Icons). Deleting airflow path icons from the SketchPad does not delete any airflow 
elements that you may have defined. These flow elements can only be deleted using the 
CONTAMW Library Manager, accessible through the Data menu for each type of data element. 

3.7.4 Modifying Airflow Paths 
To modify the parameters of an airflow path, you use the icon definition procedure (See Defining 
Building Component Icons) to display its properties and make the desired changes. You can also 
move and copy airflow paths. 

� Moving Airflow Path Icons 
Once you define an airflow path, you can move the path icon using the Cut and Paste functions 
of the Edit menu. CONTAMW will constrain the movement of path icons according to the 
following rules. You can only move a flow path through a wall onto a wall, not onto the floor of 
a zone. You can only move a flow path through a floor to another location on the floor, not onto 
a wall. You can only move a path icon within the same level upon which it is located. 

� Copying Airflow Path Icons 
Once you define an airflow path, you can copy the path icon using the Copy and Paste functions 
of the Edit menu. CONTAMW will constrain the copying of path icons according to the 
following rules. You can only copy a flow path through a wall onto a wall, not onto the floor of a 
zone. You can only copy a flow path through a floor to another location on the floor, not onto a 
wall. You may copy a path icon from one level to another. 

3.7.5 Defining Airflow Paths 
After you draw a Flow Path icon on the SketchPad you must define it using the icon definition 
procedure (See Defining Building Component Icons) to display and edit the properties of the 
airflow path. This will display the "Airflow Path Properties" property sheet. Detailed 
descriptions of all airflow path properties are given in the Airflow Path Properties section of this 
manual. Once you have defined the properties of an airflow path, the icon will be displayed in 
black. The icon representing the defined airflow path may be slightly different from the original 
undefined icon depending on the type of airflow element you associate with the path (See the list 
below). From now on, you use this icon to access the properties of the airflow path. 

Some of the properties associated with an airflow path are optional: contaminant filtration, 
schedule, wind pressure and pressure limit. You can associate contaminant filters with any flow 
path, and you can define a filter for each contaminant contained in your CONTAMW project. A 
filter could be used, for example, to simulate the penetration of particles through a wall cavity. 
You can use a schedule to vary the flow through a path as a function of time. For example, you 
could use a schedule to open and close a path that represents a window. CONTAMW allows you 
to account for the direct effects of wind pressure on the envelope of a building. The envelope is 
considered to be any wall that is adjacent to the ambient zone. If an airflow path is directly 
connected to the ambient zone, a "Wind Pressure" property page will be displayed to allow you 
to account for the effects of wind pressure on the path through the building envelope. Pressure 
limits are useful when you are using CONTAMW to design a smoke control system. For 
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example, you could set pressure limits (maximum and minimum) for stairwell doors so that those 
doorways for which the pressure limits are violated will be highlighted upon the SketchPad when 
you view simulation results. 

3.7.5.1 Airflow Path Properties 
This section provides detailed descriptions of the specific airflow path properties. Each of the 
following subsections are the context-sensitive help topics that you can access by pressing F1 
when working with property pages of the "Airflow Path Properties" property sheet. 

Airflow Path – Airflow Element Properties 
Path Number: This is the number that appears in the status bar when you highlight a path icon. 
CONTAMW automatically assigns this number to each airflow path once they are defined. This 
number could change as you add and remove paths to or from a project. Each time you save a 
project, the path numbers are reassigned. Numbers are assigned beginning on the top level, 
starting from the upper-left corner of the SketchPad, moving left-to-right and top-to-bottom of 
the SketchPad. Paths include supplies and returns of simple air handling systems. 

Airflow Element Name: <required> You may select a previously defined airflow element from 
those contained in the Name list. Click the "New Element" button to define a new airflow 
element. To view or modify airflow element data click the "Edit Element" button. You can also 
access the CONTAMW Library Manager to import airflow elements from library files by 
clicking the "Library" button (See Working with Data and Libraries). Every airflow path must 
have an airflow element associated with it. This field may not be left blank. 

Model Summary: This summarizes the information associated with the airflow element whose 
name is currently displayed in the Name field. 

Airflow Path – Filters and Schedules 
Filter: You may select a previously defined filter from those contained in the associated Name 
list. Click the "New Filter" button to define a new filter. Click the "Edit Filter" button to view or 
modify existing filter data. Setting this field to <none> indicates no filter for this airflow path. 
(See Contaminant Filters under Working with Contaminants) 

Schedule:  If there are previously defined schedules within the current project, you may select 
one from the Name list. Click the "New Schedule" button to define a new schedule. To view or 
modify an existing schedule click the "Edit Schedule" button. Setting this field to <none> 
indicates no schedule. (See Working with Schedules) 

Airflow Path – Flow Path Properties 
Relative Elevation: The elevation of the path will determine how it responds to, and influences, 
the building stack effect. Enter the elevation of the mid-height of the flow path minus the 
elevation of the current building level, i.e., the level named in the lower left corner of the screen. 
For example, the relative elevation for a path in the floor is typically zero. 

Multiplier:  The multiplier is a constant value allowing you, for example, to use a flow element 
description of one window and a multiplier of 5 to describe 5 windows in a particular wall. If 
you have specified a "leakage area" flow element, complete the description here by giving the 
reference area, length, or number of units. 
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Positive Flow Direction: In the cases of fans and flow/pressure limits (see below) it is necessary 
to know which direction is defined as positive. The arrows indicate the positive direction for 
flow of fans (forced flow element types) and flow and pressure drop for flow/pressure limits.  

Limits:  In the design of smoke control systems there are often limits on the maximum and 
minimum pressure or flow on a path.  For example, a stairwell door can require a minimum 
pressure drop from the stairwell to the zone to prevent smoke entering the evacuation route, but 
there is also a maximum pressure drop above which some people may not be able to open the 
door. You may specify either type of limits (default: no limits) and set the values. When you 
display the results of a simulation, those paths with pressures or flows outside the limits will be 
highlighted. 

Airflow Path Wind Properties 
Wind Pressure Option: There are three wind pressure options for openings in the building 
envelope:  

1. No wind pressure 

2. Constant pressure 

3. Pressure dependent on wind speed and direction 

When you select one of the above options, the following data entry options that correspond to the 
wind pressure option that you selected will be made available for your input. 

Constant Pressure Data: Enter a constant wind pressure (wind speed and direction 
independent). 

Variable Pressure Data: Variable wind pressures are computed from the product of the 
following three parameters: 

1. The dynamic pressure of the wind at some reference height. CONTAMW will determine 
this pressure based on either the steady state wind data (See Wind Properties) or the 
transient wind data from a weather file (See Defining Transient Weather and Wind). 

2. A coefficient accounting for local terrain effects (Wind Pressure Modifier). 

3. A pressure coefficient accounting for relative wind direction (Wind Pressure Profile). 

Wind Pressure Modifier: CONTAMW uses this value to account for differences between 
wind velocity profiles at the building site and that at a measurement location, e.g. an airport 
weather station (See Working with Weather and Wind). CONTAMW only requires this value 
if you are implementing Variable Wind Pressure for an airflow path. CONTAMW will 
provide a default value for this based on the data entered via the Weather and Wind 
Parameters Property Page or you can override the default value for a particular airflow path.  

Wall Azimuth Angle: Enter the direction the wall faces (clockwise from north).  

Profile: The wind pressure profile accounts for the wind direction effects. You may select a 
previously defined wind pressure profile from those contained in the Name list. Click the 
"New Profile" button to define a new wind pressure profile. To view or modify wind pressure 
profile data, click the "Edit Profile" button. After you press the "New Profile" or "Edit 
Profile" button, the Wind Pressure Profile page will be displayed with a graphical 
representation of the profile. 
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Wind Pressure Profile 
Wind Pressure Profiles are used to account for the wind direction effects in flow elements. 
CONTAMW refers to the function relating the average wind pressure coefficient for the face of a 
building to the angle of incidence of the wind on the face of the building as the wind pressure 
profile or f(θ). A more detailed explanation of this function is given in the Working with 
Weather and Wind section. The profile is displayed graphically at the bottom of the screen for a 
visual review of the data. 

Name: This is the name you give to the wind pressure profile. Wind profile names must be 
unique within a project. 

Description: Field for entering a more detailed description of the specific wind pressure profile. 

Data Points: You may enter up to 16 angle/pressure coefficient pairs. Pressure coefficients are 
in the range -1 to 1. The first value must be at a wind direction of zero degrees. The angle zero 
indicates a wind blowing directly toward the surface in which the opening lies. An identical 
value at angle 360 degrees is automatically assumed. 90 degrees indicates a wind blowing 
parallel to the wall from the right, and 270 degrees is from the left. By making these angles 
relative to the wall, the same profile might be used on different walls around the building without 
modification depending on building geometry. 

To update entered data points on the graph press the "Redraw" button in the curve fit frame. 
Pressing this button will re-plot the data on the graph and will sort the data points by angle. 

Select Curve Fit: 

Curve Fit 1: This curve fit simply connects the data points and linearly interpolates the points 
between.  

Curve Fit 2: This curve fit will connect all the user data points and will use a nonlinear curve 
fit between the points. 

Curve Fit 3: This curve fit will attempt to fit a trend line to all the data points, and may not 
actually go through all the user provided data. 
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Airflow Element Types 
This screen provides you with the option to choose which airflow model you want to associate 
with the airflow element that you are about to create. For an explanation of the various types of 
airflow models that CONTAMW implements, see Airflow Analysis in the Theoretical 
Background section of the manual. 

� One-way Flow using Powerlaw Models 
These one way flow models permit flow in the direction of the pressure drop. CONTAMW 
provides you with the following powerlaw flow models. 

1. Q = C(∆P)^n: This is the general form of the powerlaw model in volumetric flow form 
that allows you to directly input the coefficient, C, and exponent, n. 

2. F = C(∆P)^n: This is the general form of the powerlaw model in mass flow form that 
allows you to directly input the coefficient, C, and exponent, n. 

3. Leakage Area Data: This model refers to effective leakage areas as described in Chapter 
25 of the 1997 ASHRAE Handbook of Fundamentals.  

4. Connection (ASCOS) Data: Refers to the airflow description used in the ASCOS 
program [Klote 1982]. 

5. Orifice Area Data: Relates the opening description to the orifice area data.  
6. Crack Description: A narrow opening described by its length and width. 
7. Test Data (1-point): Uses a single flow rate and pressure drop along with an estimate for 

the pressure exponent, n. 
8. Test Data (2-points): Uses two flow rates with their corresponding pressure drops to 

define the flow using the powerlaw model. 
9. Stairwell: Data corresponding to a stairwell is fit to the powerlaw model. 
10. Shaft: Describes the flow in a large shaft. 

� One-way Flow using Quadratic Models 
These models permit flow in only one direction through the path based on the pressure drop.  

1. ∆P = aQ + bQ^2 and ∆P = aF + bF^2: These models allow you to directly input the "a" 
and "b" coefficients for the Quadratic models. 

2. Crack Description: This model describes a narrow opening in greater detail than the 
powerlaw version of the crack model. 

3. Test Data (2- point): This model uses two flow rates and their corresponding pressure 
drops to define the flow using the quadratic model. 

� Two-way Flow Models 
These models are used to represent tall openings where temperature differences across the 
opening may cause two-way flow across the opening, e.g., doorways.  

1. Single Opening Model: This models the flow through a path as a single large opening. 
2. Two-opening Model: This model divides an opening vertically and models the flow 

using two powerlaw models, one for each opening. Results are obtained in the form of 
the net flow rate in each direction. 
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� Backdraft Damper Flow Models 
The models allow you to model a feature that has different resistances depending on the direction 
of the pressure drop, e.g., a smoke control damper. CONTAMW implements both a volume flow 
and a mass flow version of the backdraft damper model, both of which are based on the 
powerlaw model. 

1. F = C(∆P)^n: This is the volumetric flow form of the Backdraft Damper model. You 
input separate values of C and n depending on the sign of the pressure drop across the 
damper. 

2. Q = C(∆P)^n: This is the mass flow form of the Backdraft Damper model. You input 
separate values of C and n depending on the sign of the pressure drop across the damper. 

� Fan and Forced Flow Models 
These models allow you to create airflow paths that represent fans or other paths for which you 
want to designate a flow rate. 

1. Constant Mass Flow Fan: This model provides for a constant mass flow rate.  
2. Constant Volume Flow Fan: This model provides for a constant volumetric flow rate, 

but the mass flow will vary based on the actual density. 
3. Cubic Polynomial Fan Model: This model implements a user-defined fan performance 

curve to relate pressure vs. flow rate. 

� User-defined Flow Models 
Not implemented in this version of CONTAMW 
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One-way flow using Powerlaw Models 
CONTAMW performs airflow calculations using the mass flow powerlaw formula, F = C(∆P)^n, 
for the following types of airflow elements. Where F is the mass flow rate, ∆P is the pressure 
difference across a flow path, C is the flow coefficient and n is the flow exponent. However, for 
some of the powerlaw models, CONTAMW enables you to input parameters that describe an 
opening in terms other than the coefficient C and exponent n. These parameters are then 
converted internally by CONTAMW to determine the C and n for the mass flow version of the 
powerlaw model. 

Powerlaw Model: Q = C(∆P)^n 
This model allows you to directly enter the coefficient C and exponent n for the volume flow 
version of the powerlaw model. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Flow Coefficient (C): The coefficients may only be expressed in SI units due to the conversion 
method used. Use the following conversion to convert from IP units to SI units. 
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Flow Exponent (n): Flow exponents vary from 0.5 for large openings where the flow is 
dominated by dynamic effects, and 1.0 for narrow openings dominated by viscous effects. 
Measurements usually indicate a flow exponent of 0.6 to 0.7 for typical infiltration openings. 

Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations, the choice is provided for organizational purposes. There are two 
icon options for this Powerlaw model, one for a large opening and one for a small opening. 

Powerlaw Model: F = C(∆P)^n 
This model allows you to directly enter the coefficient C and exponent n for the mass flow 
version of the powerlaw model. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Flow Coefficient (C): The coefficients may only be expressed in SI units due to the conversion 
method used. Use the following conversion to convert from IP units to SI units. 
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Flow Exponent (n): Flow exponents vary from 0.5 for large openings where the flow is 
dominated by dynamic effects, and 1.0 for narrow openings dominated by viscous effects. 
Measurements usually indicate a flow exponent of 0.6 to 0.7 for typical infiltration openings. 

Description: Field for entering a more detailed description of the specific airflow element. 
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Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 

Powerlaw Model: Leakage Area 
Leakage area refers to a description of airflow features given in Chapter 25 of the 1997 
ASHRAE Handbook of Fundamentals. This reference provides a large table of typical leakage 
areas for residential buildings. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Leakage Area: There are three possible ways to enter the leakage area: per item, per unit length, 
and per area. Select the radio button for the type of leakage area to be described, then enter the 
appropriate value for the type of leakage selected. 

Per Item: Enter a total leakage value for an item, this is usually used for a doorway or 
window -  something that can be classified as an item. 

Per Unit Length: This is usually used to describe an interface such as a wall/ceiling 
junction. 

Per Unit Area: Used to describe an area such as a wall or floor. 

Reference Conditions: Be sure to check the reference condition for the reported leakage areas. 
Two sets of reference conditions are common: 
 Discharge coefficient of 1.00 at a reference pressure of 4.0 Pa and 
 Discharge coefficient of 0.61 at a reference pressure of 10  Pa. 

Discharge Coefficient: Enter the discharge coefficient for the leakage area at the 
reference pressure. 

Flow Exponent: Enter the flow coefficient for the leakage area at the reference pressure. 
The flow exponent is not reported and therefore must be estimated. For openings 
associated with infiltration, measurements usually indicate an exponent between 0.6 and 
0.7. 

Pressure Drop: Enter the reference pressure drop. 

Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations, the choice is provided for organizational purposes. There are two 
icon options for this Powerlaw model, one for a large opening and one for a small opening. 

Powerlaw Model: Connection (ASCOS) 
The ASCOS connection element is provided for compatibility with the ASCOS program [Klote 
1982]. It is an implementation of the more general orifice flow element based upon the orifice 
equation. 

2 /oQ K A P ρ= ⋅ ⋅ ∆  
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The inputs for the ASCOS connection are the opening area, Ao,  and the dimensionless flow 
coefficient, K. Data describing a connection is reduced to the powerlaw model with an exponent 
of 0.5. The orifice flow element (see Powerlaw Model: Orifice Area) provides a more general 
implementation. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Flow Coefficient: The flow coefficient K is related to the dynamic effects and is typically close 
to 0.6 for an orifice and slightly higher for other openings in buildings. 

Flow Area: Ao, refers to the observable area of the opening. 

Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 

Powerlaw Model: Orifice Area 
This airflow element allows you to input the description of an orifice.  

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Cross-sectional Area: This refers to the observable area of the opening. 

Flow Exponent (n): Flow exponents vary from 0.5 for large openings where the flow is 
dominated by dynamic effects, and 1.0 for narrow openings dominated by viscous effects. 
Measurements usually indicate a flow exponent of 0.6 to 0.7 for typical infiltration openings. 

Discharge Coefficient: The discharge coefficient, C, is related to the dynamic effects and is 
typically close to 0.6 for an orifice and slightly higher for other openings in buildings. 

Hydraulic Diameter: The hydraulic diameter is equal to (4 ⋅ Area / Perimeter). For square 
openings this equals the square root of the area, and for long thin openings it is two times the 
width. 

Reynolds Number: The transition from laminar flow to turbulent flow occurs over a very broad 
range of Reynolds numbers with the flow being fully laminar approximately below 100. 

Note: The hydraulic diameter and Reynolds number have little impact on the calculations. 
Generally you should use the default values except for special circumstances where you need 
them to be modified. The parameters above describe the flow characteristics of an orifice in 
typical operation. At extremely low pressure drops the use of the powerlaw model leads to a 
division by zero during the network solution process. CONTAMW avoids this problem by 
changing to a linear model in this region. The model is based conceptually on the flow changing 
from turbulent to laminar at very low pressures. The Hydraulic diameter and Reynolds number 
are used to determine a point where the model changes from the powerlaw to linear. 

Description: Field for entering a more detailed description of the specific airflow element. 
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Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 

Powerlaw Model: Crack Description 
This airflow element allows you to enter the description of a crack and is based upon the 
relationships developed between flow through cracks and the powerlaw model [Clark 1985]. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Crack Length/Width: Enter the length and width of the crack. 

Description: Field for entering a more detailed description of the specific airflow element. 

Note: CONTAMW automatically uses the icon for a small opening for the powerlaw model crack 
description. 

Powerlaw Model: Test Data (1 point) 
This airflow element allows you to provide a single test data point that CONTAMW reduces to 
the powerlaw model based on the value input for the pressure exponent, n. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Pressure Drop: Enter the pressure drop of the data point. Be sure to select the proper units from 
the drop down box for the pressure drop before entering a value. 

Flow Rate: Enter the flow rate of the data point. Be sure to select the proper units from the drop 
down box for the flow rate before entering a value. 

Pressure Exponent (n): The flow exponent is a guess used to fit the single point to the 
powerlaw model. A value of 0.6 to 0.7 is typical for an infiltration element. A value of 0.5 is 
more appropriate for large openings. 

Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 

Powerlaw Model: Test Data (2 points) 
This airflow element allows you to provide two test data points that CONTAMW reduces to the 
powerlaw model. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Pressure Drop: Enter the pressure drop for each of the two data points. Be sure to select the 
proper units from the drop down box for each pressure drop before entering a value. 

Flow Rate: Enter the flow rate for each data point. Be sure to select the proper units from the 
drop down box for each flow rate before entering a value. 

 37



USING CONTAMW – WORKING WITH AIRFLOW PATHS 

Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 

Powerlaw Model: Stairwell 
This airflow element allows you to enter a description of a stairway, and CONTAMW converts 
the information to a powerlaw relationship assuming a pressure exponent of 0.5. A stairwell will 
normally be modeled as a vertical series of zones connected by low resistance openings (this 
stairwell flow element) through the floors. The resistance is based on a fit to experimental data 
[Achakji & Tamura 1998].  

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Distance Between Levels: This is the distance between openings for the stairwell. Be sure to 
select the correct units from the drop down box provided before entering a value. 

Cross-sectional area: This is the horizontal, cross-sectional, area of the shaft. Be sure to select 
the correct units from the drop down box provided before entering a value. 

Density of People: A large number of people in the stairwell influence the flow resistance of the 
stairwell. The experiment used densities of 1, 2, and 3 people per square meter. These are the 
only units available in CONTAMW. The following conversion is provided for your convenience.  

1 m2 = 10.76 ft2 

Stair Treads: There are two options for this field: open tread and closed tread. This refers to the 
front of the tread whether or not the tread is open effects flow. 

Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 

Powerlaw Model: Shaft 
This airflow element allows you to enter a description of a shaft, and CONTAMW converts the 
information to a powerlaw relationship assuming a pressure exponent of 0.5. A shaft will 
normally be modeled as a vertical series of zones connected by low resistance openings (this 
shaft airflow element) through the floors. The resistance is based on a conduit friction model 
using the Darcy-Weisbach relation and Colebrook’s equation for the friction factor [ASHRAE 
1997, p2.8]. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Distance Between Levels: This is the distance between openings for the stairwell.  

Cross-sectional area: This is the horizontal, cross-sectional, area of the shaft, not the opening. 
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Perimeter: The perimeter of the horizontal cross-section of the shaft. This number is used in 
conjunction with the area to create the hydraulic diameter. 

Roughness: This refers to the average size of the protrusions from the shaft wall into the airflow.  

Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 

 

One-way Flow using Quadratic Models 
CONTAMW performs airflow calculations using the mass flow quadratic relationship (∆P  =  
aF  +  bF²) between mass flow rate and pressure difference across a flow path for the following 
types of airflow elements. Where F is the mass flow rate, ∆P is the pressure difference across a 
flow path, and a and b are flow coefficients. 

Quadratic Model: ∆P = aQ + bQ² 
This model allows you to directly enter the coefficients, a and b, into the volume flow version of 
the quadratic flow model. Where ∆P is the pressure drop and Q is the volumetric flow rate. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Coefficients: The coefficients must be expressed in SI units because of the way CONTAMW 
handles unit conversions. The units of the coefficients at standard conditions are as follows: 
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Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 

Quadratic Model: ∆P = aF + bF² 
This model allows you to directly enter the coefficients, a and b, into the mass flow version of 
the quadratic flow model. Where ∆P is the pressure drop and F is the mass flow rate.  

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Coefficients: The coefficients must be expressed in SI units because of the way CONTAMW 
handles unit conversions. The units of the coefficients are as follows: 
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Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 

Quadratic Model: Crack Description 
This model employs a quadratic relationship of the form ∆P = aQ + bQ² where Q is the volume 
flow rate [Baker, Sharples, and Ward 1987]. CONTAMW uses the mass flow version of that 
formula: ∆P = aF + bF²  where ∆P is the pressure drop and F is the mass flow rate. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Crack Dimensions: 
Length: The overall length of the crack 

Width: Width of the crack 

Depth: The distance along the direction of airflow 

Number of Bends: The number of bends in the flow path.  

Description: Field for entering a more detailed description of the specific airflow element. 

Quadratic Model: Test Data (2 points) 
Measured data (2 points) is reduced to the mass flow version of the quadratic model. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Data: Data consists of two sets of pressure drops and corresponding flow rates. 

Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 
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Two-way Flow Models 
This set of models enables you to model openings through which two-way airflow might occur 
(e.g. doorways and open windows). When viewing results of these models, the bidirectional flow 
will be indicated on the SketchPad if it occurs. You can also use CONTAMW’s airflow plotting 
feature to plot both airflows or to simply plot the net airflow. There must be a temperature 
difference across the associated airflow path in order for bidirectional flow to occur across the 
airflow paths associated with this type of airflow element. 

Two-way Flow Model: Single Opening 
This is a model for flow through large openings such as doorways through which air can flow in 
two directions simultaneously throughout the opening. See Doorways (Large Openings) in the 
Theory section for a more detailed explanation. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Height: The overall height of the opening, not to be confused with the opening’s position. 
Before entering the dimension be sure to select the proper units from the drop down menu. 

Width: The width of the opening. Again, before entering the dimension make sure to select the 
proper units from the drop down menu. 

Flow Coefficient: An experimentally determined value. Experiments by Weber and Kearney 
have shown the default value of 0.78 to work well for most applications. 

Minimum Temperature Difference for Two-Way Flow: A two-way flow is driven by the 
temperature (actually air density) difference between the two zones. When this temperature 
difference approaches zero the algorithm used for solving the flow tends towards a division by 
zero problem. To avoid this undefined situation the two-way model reverts to a one-way power 
law model at this "minimum temperature difference" using the opening size to define the orifice 
at ∆T set in this field. CONTAMW uses a default value of 0.01 °C. 

Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 

Two-way Flow Model: Two-opening 
This model accounts for two-way flow due to the stack effect acting over the height of a tall 
opening. It uses two power law flow models at different heights to approximate a single tall 
opening. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Height: The overall height of the opening, not to be confused with the opening’s position. 

Width: The width of the opening. 

Flow Coefficient:  This is an experimentally determined value. Experiments by Weber and 
Kearney have shown the default value of 0.78 to work well for most applications. 
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Minimum Temperature Difference for Two-Way Flow: A two-way flow is driven by the 
temperature (actually air density) difference between the two zones. When this temperature 
difference approaches zero the algorithm used for solving the flow tends towards a division by 
zero problem. To avoid this undefined situation the two-way model reverts to a one-way power 
law model at this "minimum temperature difference" using the opening size to define the orifice 
at ∆T set in this field. CONTAMW uses a default value of 0.01 °C. 

Description: Field for entering a more detailed description of the specific airflow element. 

Icon: Choose the style icon appropriate for the specific airflow element. Note that the icon has 
no effect on the simulations; the choice is based on user preference. There are two icon options 
for this Powerlaw model, one for a large opening and one for a small opening. 
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Backdraft Damper Flow Models 
The Backdraft Damper models make it possible to model a feature that has different flow 
resistances depending on the direction of the pressure drop, with greatly reduced (or zero) flow 
in one direction. Note that there are similar models available for duct flow elements. 

Backdraft Damper Model: Q = C(∆P)^n 
This is the volumetric flow form of the backdraft damper airflow model.  

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Pressure Difference ∆P>0 or ∆P<0: This indicates the direction of predominant flow for the 
model. 

Flow Coefficients: The coefficients may only be expressed in SI units due to the conversion 
method used. Use the following conversion to convert from IP units to SI units. 
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Flow Exponents: Flow exponents vary from 0.5 for large openings where the flow is dominated 
by dynamic effects, and 1.0 for narrow openings dominated by viscous effects. Measurements 
usually indicate a flow exponent of 0.6 to 0.7 for typical infiltration openings. 

Description: Field for entering a more detailed description of the specific airflow element. 

Backdraft Damper Model: F = C(∆P)^n 
This is the mass flow form of the backdraft damper airflow model. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Pressure Difference ∆P>0 or ∆P<0: This indicates the direction of predominant flow for the 
model. 

Flow Coefficients: The coefficients may only be expressed in SI units due to the conversion 
method used. Use the following conversion to convert from the IP units to SI units. 
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Flow Exponents: Flow exponents vary from 0.5 for large openings where the flow is dominated 
by dynamic effects, and 1.0 for narrow openings dominated by viscous effects. Measurements 
usually indicate a flow exponent of 0.6 to 0.7 for typical infiltration openings. 

Description: Field for entering a more detailed description of the specific airflow element. 
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Fan and Forced-Flow Models 
These airflow element models enable you to easily create forced airflow elements as airflow 
paths between two zones, as opposed to implementing a duct model or simple air handling 
system. You can either specify a constant mass flow rate, constant volumetric flow rate, or to 
create a fan based on fan performance data. 

Fan Model: Constant Mass Flow Fan 
This model describes an airflow element having a constant mass flow rate. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Design (maximum) Flow: Enter the maximum mass flow rate. This value can be modified by 
the path schedule. 

Description: Field for entering a more detailed description of the specific airflow element. 

Fan Model: Constant Volume Flow Fan  
This model describes an airflow element having a constant volume flow rate that can vary with 
density. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Design (maximum) Flow: Enter the maximum volume flow rate. This value can be modified by 
the path schedule. 

Description: Field for entering a more detailed description of the specific airflow element. 

Fan Performance Curve 
This airflow element allows you to create a fan based on a fan performance curve. You provide 
CONTAMW with a set of pressure rise and airflow rate data points, and CONTAMW performs a 
polynomial curve fit to the data. 

Name: Enter the name you want to use to identify the airflow element. The airflow element will 
be saved within the current project and can be associated with multiple airflow paths. 

Fan off conditions: These values specify how the fan is modeled when the speed of the fan is 
insufficient to provide a flow.  

Control Value: The actual speed of the fan divided by the rated speed of the fan. When 
this ratio is below the specified limit the fan is modeled as a simple orifice based on the 
"equivalent orifice" defined below. During a simulation, CONTAM will calculate the 
actual ratio based on fan laws (ASHRAE 2000) and pressure drop across the fan and 
compare it to the control value. 

Equivalent Orifice: The size of the orifice used to model the fan opening when the 
control value drops below the specified limit. 

Description: Field for entering a more detailed description of the specific airflow element. 
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Fan Performance Data: Click the "Edit Fan Curve Data" to input/modify the fan curve for this 
airflow element. A detailed explanation of this data is given in the next section, Fan Performance 
Data. 

Fan Performance Data 
Between four and ten data points are required for CONTAMW to fit a cubic polynomial to create 
a performance curve for the fan. The fitted curve may not contain a point of contraflecture; if it 
does an error message will be displayed. If this error message is displayed the pressure rise data 
must then be modified to eliminate the point of contraflecture. 

� Entering Fan Curve Data Points 
You only need to fill in the "Flow rate" and "Pressure rise" data entry when entering fan curve 
data. When adding a new data point, the flow rate must be entered in the "Flow rate" edit box 
and the pressure rise must be entered in the "Pressure rise" edit box. Use the "Revised dP" box 
when making changes to a pressure rise that has already been entered. This will preserve the 
original data point but use the revised value when performing the curve fit. After entering the 
flow rate and the pressure rise into the appropriate edit boxes, the next step is to press the "<< 
Insert <<" button. Once you have entered four data points a cubic fit will automatically be 
generated and displayed as a line on the graph.  

� Revising Fan Curve Data Points 
To edit existing data points, highlight the line of data to revise in the list of Fan Curve Data to 
the left of the Insert, Replace and Delete buttons. The values from that data set will then appear 
in the edit boxes to the right of the buttons. 

If you need to modify the flow rate, enter the new flow rate in the "Flow rate" edit box and then 
press the "<< Replace <<" button. The new data will now replace the old data. 

If the Pressure Rise needs to be modified there are two available options: 

1. Replace the data point completely. To overwrite an existing pressure rise and refit the fan 
curve, select the data set to be modified by highlighting it in the data list and then type 
the new pressure rise in the "Pressure rise" edit box then press the "<< Replace <<" 
button.  

2. Change the point used to fit the cubic polynomial but leave the marker for the original 
data point intact. With this option you may "tweak" the curve in the event there is some 
issue with the originally entered fan curve, such as a point of contraflecture. 
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3.8 Working with Simple Air Handling Systems 
The simple air-handling system (AHS) provides a convenient means of incorporating an air-
handling system into a building without having to draw and define an entire duct system. Each 
simple air-handling system consists of two implicit airflow nodes (supply and return), three 
implicit flow paths (recirculation, outdoor, and exhaust), and multiple inlets to zones (supply) 
and outlets from zones (return) that you can place within zones throughout the building. You 
specify the airflow rates of each supply and return point. Simple air-handling systems do not 
require you to associate both supplies and returns with them. You may use the simple air-
handling system to only supply ambient air to a building or to only exhaust air from the building. 
The following figure shows a schematic representation of a simple air-handling system. 

 

� Determination of System Airflows 
CONTAMW determines the airflows rates associated with each air-handling system according to 
the following algorithm. More detailed explanations for the values that you must input for this 
algorithm are explained in the Defining Air-handling Systems section that follows. 

First, all of the user-defined supply (supply air to the zones) and return (return air from the 
zones) airflow (mass) rates are summed. 

ΣWs ≡ the sum of all supplies 

ΣWret ≡ the sum of all returns 

The amount of outdoor air that the system requires is then determined by 

W'o = max( fo·ΣWs, min(ΣWs, Wo_min) ),  

where, fo ≡ the fraction outdoor air parameter that you input, and 

Wo_min ≡ the "minimum outdoor airflow" parameter that you input. 
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The rate at which air is recirculated via the implicit recirculation flow path, Wrec, is determined 
by  

Wrec  = min(ΣWret, ΣWs - W'o ). 

The rate at which outdoor air is brought in by the system via the implicit outdoor airflow path, 
Wo, is determined by 

Wo = ΣWs - Wrec. 

And the rate at which exhaust airflows to the ambient via the implicit exhaust flow path, Wex,  is 
determined by 

Wex = ΣWret - Wrec. 

This algorithm means the amount of outdoor air the system will provide, Wo, will be between 
Wo_min and fo·ΣWs as long as the demand for supply air, ΣWs, is sufficient enough to provide this 
value. Otherwise the system will provide ΣWs. When the sum of the supply flows, ΣWs, exceeds 
the sum of the return flows, ΣWret, the balance is made up from outdoor air. Any excess return 
air is exhausted via the implicit exhaust flow path.  

3.8.1 Creating Simple Air-handling Systems 
You create simple air-handling systems by placing an Air-handling System (AHS) icon on the 
SketchPad along with some combination of supply and/or return icons (See Drawing Building 
Component Icons). You may place an AHS icon on any blank cell of the SketchPad on any level. 
You do not have to place it within a zone. However, you must place Supply icons and Return 
icons within a zone. The pop-up menu selections will be disabled (grayed out) if you pop-up on a 
location where CONTAMW does not allow these icons to be placed. 

3.8.2 Deleting Air-handling Systems 
You delete icons related to simple air-handling systems using the icon deletion procedure (See 
Deleting Building Component Icons). If you delete an AHS icon, , all of the supplies and 
returns associated with that system will be deleted. You will be warned of this when you attempt 
to delete the icon. However, you can delete individual supplies and returns without affecting any 
other icons. Deleting any AHS-related icons from the SketchPad does not delete any filter, 
schedule, or kinetic reaction elements that you may have defined for the AHS. These flow 
elements can only be deleted using the CONTAMW Library Manager, accessible through the 
Data menu for each type of data element. 

3.8.3 Modifying Air-handling Systems 
To modify the parameters of a simple air-handling system, you use the icon definition procedure 
(See Defining Building Component Icons) to display its properties and make the desired 
changes. You can move air-handling system icons and move and copy supply and return icons; 
however, you cannot copy air-handling system icons. 

� Moving Air-handling System Icons 
You can move AHS icons using the Cut and Paste functions of the Edit menu. CONTAMW 
will only allow you to move an AHS icon within the same level upon which it is located. 
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� Moving Supply and Return Icons 
Once you define a supply or return icon, you can move them using the Cut and Paste functions 
of the Edit menu. CONTAMW will only allow you to move a supply or return icon within the 
same zone in which it is currently located. 

� Copying Supply and Return Icons 
Once you define a supply or return icon using the Copy and Paste functions of the Edit menu. 
You can copy supply and return icons into any zone on any level. 

3.8.4 Defining Air Handling Systems 
After you place an AHS-related icon (AHS, Supply and Return) onto the SketchPad you must 
define them using the icon definition procedure (See Defining Building Component Icons) to 
display and edit the properties of the icon. This will display the property sheet associated with 
the icon. Detailed descriptions of all AHS properties are given in the Air-handling System 
Properties section of this manual. 

This list shows the various AHS-related icons and provides a brief description of each. 

Icon Description 

 Air-handling system 

 Room air supply (inlet) of an air-handling system 

 Room air return (outlet) of an air-handling system 

 

� Air-handling System Icon 
The properties associated with each AHS include outdoor air intake data, supply and return 
contaminant information, and system filters. Outdoor air intake data consists of a minimum 
outdoor air intake rate, Woa_min and a schedule for varying the outdoor air intake rate as a 
percentage of the supply airflow rate. The schedule will set the value of fo in the algorithm 
above. The default value of fo is 1.0 (i.e., 100% outdoor air) if you don't use a schedule. Supply 
and return system data refers to the implicit zones that are created for each AHS. Just as for any 
zone you create, you can provide a zone volume, initial zone concentration and a kinetic reaction 
for each contaminant defined for the project. You can also associate contaminant filters with the 
implicit outdoor and recirculation flow paths. 

� Supply and Return Icons 
The properties associated with each AHS include airflow rate and contaminant filtration 
information. You must enter a design airflow rate for each supply and return icon that you create. 
Enter the design maximum value that you anticipate requiring. You can also provide a schedule 
to the design airflow rate to adjust down the design flow rate. As with other airflow paths, you 
can provide a contaminant filter to these items. Be careful not to place filters in both the 
individual returns and the recirculation path of the air handling system unless this is what you 
really intend to do. 

 48



 USING CONTAMW – WORKING WITH SIMPLE AIR HANDLING SYSTEMS 

3.8.4.1 Air Handling System Properties 
This section provides detailed descriptions of the specific properties of simple air-handling 
systems. Each of the following subsections are the context-sensitive help topics that you can 
access by pressing F1 when working with property pages of the "Simple Air-handling System 
Properties," "Supply Point Properties," and "Return Point Properties" property sheets. 

Air-handling System – AHS Properties 
System Name: The name used to identify the Air-handling System. Air-handling system names 
must be unique from one another. 

Minimum OA Flow: This is the minimum outside air introduced into the AHS supply flow. If 
the sum of the return flows plus the minimum outside airflow exceeds the supply flow then the 
excess return air is vented outside. Similarly if the return flow plus the minimum outside airflow 
do not sum to the supply flow then outside air is added to make up the difference.  

Outside Air Schedule:  A new Outside Air schedule is defined by pressing the "New Schedule" 
button and following the directions for editing a Week Schedule.  

Description: Field that shows a more detailed description of the selected outdoor air 
schedule. This description can be modified by pressing the edit schedule button next to the 
description field and then changing the description field for the schedule. 

Name: This drop down box contains the names of all previously created schedules. The 
schedule selected from this box will then define the particular schedule for the exposure 
being viewed. 

Air-handling System – Supply System Properties 
System Volume: System Volume is used in the dynamic contaminant concentration calculations. 
Enter a value for the entire supply system. 

Contaminant Data: All of the defined contaminants in the project will be displayed in this list 
box. 

Initial Concentration: This box provides the user with the ability to set the initial concentration 
of the selected contaminant. 

Kinetic Reaction: You define a new kinetic reaction by pressing the "New Reaction" button and 
then completing the kinetic reaction matrix. You can edit an existing matrix by selecting the 
proper matrix from the drop down box and pressing the "Edit Reaction" button. You must have 
previously defined contaminants in order to implement a kinetic reaction. 

Description: Field that shows a more detailed description of the specific reaction if entered 
by the user. This description can be modified by pressing the "Edit Reaction" button next to 
the description field and then changing the description field for the reaction. 

Name: This contains a list of names of all previously created reactions. The reaction selected 
from this box will define the behavior of the specific supply system being modified. 
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Air-handling System – Return System Properties 
System Volume: System Volume is used in the dynamic contaminant concentration calculations. 
Enter a value for the entire return system. 

Contaminant Data: All of the defined contaminants in the project will be displayed in this list 
box. 

Initial Concentration: This box provides the user with the ability to set the initial concentration 
of the selected contaminant. 

Kinetic Reaction: You define a new kinetic reaction by pressing the "New Reaction" button and 
then completing the kinetic reaction matrix. You can edit an existing matrix by selecting the 
proper matrix from the drop down box and pressing the "Edit Reaction" button. You must have 
previously defined contaminants in order to implement a kinetic reaction. 

Description: Field that shows a more detailed description of the specific reaction if entered 
by the user. This description can be modified by pressing the "Edit Reaction" button next to 
the description field and then changing the description field for the reaction. 

Name: This contains a list of names of all previously created reactions. The reaction selected 
from this box will define the behavior of the specific supply system being modified. 

Air-handling System – Filter Properties 
As the names suggest, outdoor air filters affect the air brought in by the simple air-handling 
system from outside the building, while recirculation air filters affect the return air being 
circulated back through the air handler. You may either select a previously defined filter from the 
drop down box provided, or you can create a new filter by pressing the "New Filter" button. 
Creating a new filter or modifying an existing one will display the Contaminant Filter Properties 
dialog box. Use this dialog box to define the filter properties. For an explanation of contaminant 
filters see Contaminant Filters in the Using CONTAMW section of the manual. 

Air-handling System – Supply/Return Point Properties 
Design Flow Rate: This value is design flow rate for the supply/return element (i.e. the 
maximum flow rate specified for a particular vent). 

AHS: You must associate each supply and return point with an existing air-handling system. 

Name: This drop down box contains the names of all previously created Air-handling 
Systems. The AHS selected from this box will define the behavior of the specific 
supply/return system being modified. Once an existing AHS is selected it may be edited by 
pressing the "Edit AHS" button. 

Description: Field that shows a more detailed description of the specific schedule if entered 
by the user. This description can be modified by pressing the "Edit AHS" button next to the 
description field and then changing the description field for the AHS. 

Schedule: You can associate a schedule with the supply/return point to control the fraction of the 
design airflow rate that flows to/from the zone in which the supply/return point is located 
according to the time of day and day of the week. 
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Description: Field that shows a more detailed description of the specific schedule if entered 
by the user. You can modify this description by pressing the "Edit Schedule" button next to 
the description field and then changing the description field for the schedule. 

Name: This drop down box contains the names of all previously created schedules. The 
schedule selected from this box will define the behavior of the specific supply/return system 
being modified. 

Filter: You can associate a filter with the supply/return point that will act upon the associated 
contaminant(s) as air flows to/from the zone in which the supply/return point is located. 

Description: Field that shows a more detailed description of the specific filter if entered by 
the user. This description can be modified by pressing the "Edit Filter" button next to the 
description field and then changing the description field for the schedule. 

Name: This drop down box contains the names of all previously created filters. The filter 
selected from this box will define the behavior of the specific supply/return system being 
modified. 
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3.9 Working with Ducts 
As an alternative to the simple air-handling system, CONTAMW allows you to model HVAC 
systems using detailed duct systems. Duct systems are made up of duct segments, junctions, 
terminal points, and forced air components. A duct segment is a section of a duct between any 
two junctions, terminal points or combination of the two. A terminal point is an endpoint of a 
duct segment, and a junction is the connection between two duct segments. Only horizontal 
segments can be displayed on the CONTAMW SketchPad, but vertical segments can be 
implemented as well. Vertical segments are connected with special junctions and terminal points 
that reveal the location of the vertical segments on the SketchPad. 

You draw the layout of the duct system, and CONTAMW will insert junctions and terminal 
points where appropriate. Once you have drawn a duct system, you must define the drawing by 
providing detailed segment, junction and terminal point information. You must provide each duct 
segment with specific information that describes the flow characteristics and physical 
dimensions of that segment. Much of this information is in the form of duct flow elements that 
you must create when defining the duct segments. The details of drawing and defining a duct 
system are described in the following sections. 

3.9.1 Duct Flow Elements 
Each duct segment must refer to a duct flow element. Duct flow elements describe the 
mathematical relationship between flow through and pressure drop along the duct, the flow 
resistance or forced flow characteristics, cross-sectional geometry, and optional leakage per unit 
length of a duct. CONTAMW provides you with several different mathematical models or 
element types to choose from. Each of these duct flow element types is described in detail in the 
Duct Segment Properties section. While every duct segment must refer to a single duct flow 
element, multiple duct segments can refer to the same duct flow element. Duct flow elements can 
also be stored within a CONTAMW library file and shared between different CONTAMW 
project files.  

3.9.2 Drawing Ducts 
You draw ducts using the duct drawing tool previously described in the Working with the 
SketchPad section. After you complete the "finalize drawing object" stage of duct drawing, the 
completed duct will appear as an undefined set of red duct icons. The color red indicates that the 
duct is not yet defined. Once you have defined the duct components, they will be displayed in 
blue. A directional duct segment icon will be displayed within each duct segment, and each 
junction and terminal point will be replaced with an icon indicating the type of junction or 
terminal point you have defined. 

� Drawing Duct Segments 
CONTAMW provides certain constraints when drawing ducts to insure that a valid duct system 
will be drawn that conforms to the underlying model of nodal equations upon which 
CONTAMW is based. When drawing a duct, you cannot cross over a line that you are currently 
drawing. Ducts can cross over walls, but you cannot draw ducts over any other building 
component icons. After each duct segment is drawn, the ends of the segment will be 
automatically replaced by either an undefined terminal point or junction icon. You can only 
begin or end a duct segment drawing in an unoccupied SketchPad cell or on an undefined duct 
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icon. For this reason, you are advised to draw the entire duct system, on a given level, before you 
define the individual duct segments. If you cross over a previously drawn duct segment, either 
defined or undefined, while drawing a new duct segment, no junction will be placed where the 
two segments cross. 

Vertical duct segments do not appear directly on the SketchPad, because the SketchPad displays 
only plan-view drawings. Vertical duct segments are associated with vertically connected 
junctions or terminal points. These vertical junction and terminal icons provide access to the 
properties of the vertical segments that are located below the level upon which the vertical 
junction or terminal appears.  

� Drawing Duct Junctions 
Undefined horizontal duct junction icons are drawn automatically at the intersections of the ducts 
after you finalize drawing a duct. Each time you begin or end drawing a duct segment upon an 
undefined duct segment, junction or terminal point, CONTAMW will automatically provide an 
undefined junction icon if there is not yet one at the junction location. 

All vertical junctions are connected to vertical duct segments that are located below the level 
upon which the vertical junction appears. You can create a vertical junction that is isolated from 
other ducts on a level that is connected either up, down or both up and down to ductwork on 
adjacent levels. To do this, finalize the drawing object immediately after setting the initial 
location of the duct object. To do this, you simple press LMB (double click) or ↵  twice at the 
desired location on the SketchPad when you have the duct drawing tool selected. This will place 
a single undefined terminal point icon within the SketchPad cell. You can later define this 
undefined terminal point icon as the specific type of junction that you need and associate it with 
a vertical duct segment. 

� Drawing Duct Terminal Points 
Undefined horizontal terminal point icons are automatically drawn by CONTAMW at the end of 
each duct segment that does not end on another previously drawn duct icon. 

You can also create terminal points that are isolated from other ducts on a level but connected 
either up or down to ductwork on an adjacent level by finalizing the drawing object immediately 
after setting the initial location of the duct object. To do this, you simply press LMB (double 
click) or ↵  twice at the desired location on the SketchPad when you have the duct drawing tool 
selected. This will place a single undefined terminal point icon within the SketchPad cell. You 
can later define this terminal point as the specific type that you need and associate it with a 
vertical duct segment. 

3.9.3 Deleting Ducts 
Deleting currently defined ducts is a two-step process. That is, if you want to delete a duct 
segment, junction or terminal, you must first undefine the item. To undefine a duct segment you 
must highlight the special duct segment icon (that indicates the positive flow direction) and press 
the Delete key or select Delete from the Edit menu. This will highlight the entire duct segment 
from its two end-points and prompt you to confirm the undefine operation by displaying a 
message box. Once you undefine a duct segment, it will again be displayed in red and the special 
duct segment icon will be converted back to a straight segment icon. To delete the duct segment 
you highlight any portion of the undefined segment or associated undefined terminal and 
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perform the deletion. The entire segment to be deleted will be highlighted, and you will be asked 
to confirm the deletion.  

There are several items you should consider when deleting ducts. You cannot delete an 
undefined junction that is still connected to a defined duct segment. If you delete a junction that 
is between two undefined segments, the junction will be removed to form a single segment. You 
cannot delete a terminal without deleting its associated segment. 

Deleting the ducts defined on the SketchPad does not delete any duct flow elements that you may 
have defined. These flow elements can only be deleted using the CONTAMW Library Manager, 
accessible through the Data menu for each type of data element. 

3.9.4 Modifying Ducts 
In order to modify the layout of a duct system, you must undefine any portions to which you 
want to connect a new duct (i.e. form a junction). To modify the parameters of a duct segment, 
junction or terminal, you use the icon definition method to display its properties and make the 
desired changes. You do not have to undefine the item to change its properties, only to change 
the physical layout.  

To remove a junction from between two segments, you should first undefine the two duct 
segments, remove the junction and then redefine the newly formed longer segment. To split a 
segment into two segments, simply double-click the LMB with the duct drawing tool on the 
segment where you wish to place the junction.  

3.9.5 Defining Ducts 
After you draw a duct, you must define each duct segment, junction, and terminal point. Each of 
these duct components is defined using the icon definition procedure (See Defining Building 
Component Icons) to display and edit the properties of the component. 

� Defining Duct Segments 
You define each duct segment by using the icon definition procedure on any portion of an 
undefined duct segment. This will display the "Duct Segment Properties" property sheet. 
Detailed descriptions of all duct segment properties are given in the Duct Segment Properties 
section of this manual. Once you have defined the properties of a duct segment, a special icon 
will be displayed indicating the positive flow direction of the duct segment (see Directional Duct 
Segment Icons). From now on, you use this icon to access the properties of the duct segment. 

When defining a duct segment, you must associate the segment with a duct flow element. 
CONTAMW combines duct flow element data with segment specific data such as length and 
dynamic losses to determine the frictional resistance, volume, and leakiness of a particular duct 
segment.  

You can also define contaminant filtering properties of duct segments. You can define a filter for 
each contaminant contained in your CONTAMW project. A duct filter could be used, for 
example, to simulate the deposition of particles on the inside surface of a duct. 

As previously mentioned, duct flow elements contain duct leakage information. The 
CONTAMW model implements all leakage at the junctions and terminals of a duct segment. 
This means that half of the leakage associated with a duct segment occurs at each end of the 
segment. The leakage between a junction and the zone in which the junction is located (as 
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determined on the SketchPad) is a function of the duct element leakage characteristics and the 
pressure difference between the junction and the zone. You should consider this leakage model 
when accounting for leakage of a duct that passes through multiple zones. You should put a least 
one junction (or terminal) in each zone within which you want to account for duct leakage. 

� Directional Duct Segment Icons 
These are the icons that indicate a defined duct segment. The direction that the small arrow 
points indicates the positive flow direction of the duct segment. 

 

� Defining Duct Junctions and Terminals 
You define each duct junction and terminal by using the icon definition procedure on a duct 
junction or terminal icon. This will display the "Duct Junction Properties" property sheet. If a 
terminal icon is located in the ambient zone, a Wind Pressure property page will be displayed to 
allow you to account for the effects of wind pressure on the exterior terminal. All junctions and 
interior terminal icon will not produce the Wind Pressure property page. Detailed descriptions of 
duct junction properties are given in the Duct Junction and Terminal Properties section of this 
manual. Once you have defined the properties of a duct junction, a special icon will be displayed 
indicating the specific type of junction you have selected (see the following list). From now on, 
you use this icon to access the properties of the duct junction. 

� Junction and Terminal Icons 
 

Icon Description 

  Junction connected to ducts on the same level 

 Junction connected to the vertical duct of a junction on the 
level above 

 Junction and downward vertical duct connected to a 
junction on the level below 

 Junction and downward vertical duct connected to a 
junction on the level below and connected to the vertical 
duct of a junction on the level above 

  Terminal connected to a duct on the same level 

  Terminal connected to the vertical duct of a junction on the 
level above 

  Terminal and downward vertical duct connected to a 
junction on the level below 
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3.9.5.1 Duct Segment Properties 
This section provides detailed descriptions of the specific duct segment properties. Each of the 
following subsections are the context-sensitive help topics that you can access by pressing F1 
when working with property pages of the "Duct Segment Properties" property sheet. 

Duct Segment – Flow Element Properties 
Duct Segment Number: This is the number that appears in the status bar when you highlight a 
duct segment icon. CONTAMW automatically assigns this number to each duct segment once 
they are defined. This number could change as you add and remove duct segments to or from a 
project. Each time you save a project, the duct segment numbers are reassigned. Numbers are 
assigned beginning on the top level, starting from the upper-left corner of the SketchPad, moving 
left-to-right and top-to-bottom of the SketchPad. 

Duct Flow Element Name: You may select a previously defined airflow element from those 
contained in the Name list. Click the "New Element" button to define a new airflow element. To 
view or modify airflow element data click the "Edit Element" button. Every duct segment must 
have an airflow element associated with it. This field may not be left blank. 

Model Summary: This summarizes the information associated with the duct flow element 
currently displayed in the Name field. 

Duct Segment – Segment Properties 
Segment Data:  

Duct Segment length: Enter the length of the duct segment. This will be used along with 
the cross-sectional area to determine the volume of the duct segment. 

Sum of loss coefficients: This is the sum of all dynamic loss coefficients due to junction 
losses and all fittings in the segment. This term only applies to the Darcy-Colebrook duct 
flow element model (See Ducts in the Airflow Analysis section). 

Positive Flow Direction: In the case of fans it is necessary to know which direction is 
defined as positive. The arrows represent the positive direction for pressure drop and 
airflow. 

Segment Summary Information: This field displays information about the selected duct flow 
element. 

Duct Segment – Filter & Schedule Properties 
Filter: You may select a previously defined filter from those contained in the associated Name 
list. Click the "New Filter" button to define a new filter. Click the "Edit Filter" button to view or 
modify existing filter data. Setting this field to <none> indicates no filter for this airflow path. 
(See Contaminant Filters under Working with Contaminants) 

Schedule: If there are previously defined schedules within the current project, you may select 
one from the Name list. Click the "New Schedule" button to define a new schedule. To view or 
modify an existing schedule click the "Edit Schedule" button. Setting this field to <none> 
indicates no schedule. (See Working with Schedules) 
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Duct Flow Elements 
Duct Flow Element – Shape, Size and Leakage 
Duct Shape: You can implement several different shapes of ducts including: round, rectangular, 
oval or other. Select the shape you want and the appropriate dimensions will be made available 
for you to enter under the Duct Dimension parameters. 

Duct Dimensions: The data entered here is dependent on the duct shape. For circular ducts, the 
diameter is the only parameter needed. Rectangular ducts require you to enter the width and 
height, and oval ducts require you to input the major and minor dimensions. The other option 
allows you to enter a perimeter and a flow area to define the dimensions for a duct of any other 
shape. 

Leakage: Leakage of air between the duct and the surrounding zone may be described in terms 
of a leakage rate at a given pressure or by use of the leakage classification. If you enter a leakage 
rate and a pressure difference, the value for the leakage class is automatically calculated by 
CONTAMW and placed in the "Leakage Class" field. Similarly, if you input a leakage class, a 
default value of 250 Pa is used for the pressure difference, and a leakage rate will be calculated 
based on the pressure difference and the leakage class you entered. See [ASHRAE 1997, Chapter 
32] 

Duct Flow Element Types 
You select the type of duct flow element from this page that you want CONTAMW to utilize to 
model airflow through this particular duct segment. 

The most common model is the Darcy-Weisbach relation and Colebrook’s natural roughness 
function. 

Darcy-Colebrook Model  

Three versions of the powerlaw model are included: 

Orifice resistance model 

Resistance: F = C(∆P)^n (mass flow) 

Resistance: Q = C(∆P)^n (volume flow) 

Three types of forced flow models are included: 

Fan - performance curve 

Constant mass flow 

Constant volume flow 

The backdraft damper elements allow you to model a flow that has different flow resistances 
depending on the direction of the pressure drop. 

Backdraft Damper: F = C(∆P)^n (mass flow) 

Backdraft Damper: Q = C(∆P)^n (volume flow) 
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Darcy-Colebrook Model 
This model uses the Darcy-Weisbach relation and Colebrook’s natural roughness function 
[ASHRAE 2001 pp 2.8 and 34.7]. 

Name: Enter a unique name you want to use to identify the duct flow element. The element will 
be saved within the current project and can be associated with multiple duct segments. 

Description: Field for entering a more detailed description of the specific duct flow element. 

Roughness: The flow resistance due to friction is calculated from Colebrook’s function and the 
roughness factor [ASHRAE 2001 p 34.7]. Some typical values are given here. 

Smooth 0.03 mm 0.0001 ft 
Medium Smooth 0.09 mm 0.0003 ft 
Average 0.15 mm 0.0005 ft 
Medium Rough 0.90 mm 0.0030 ft 
Rough 3.00 mm 0.0100 ft 

 

 

Shape Size and Leakage: You must enter data to physically describe each duct airflow element. 
You input these values on the Shape Size and Leakage property page associated with each duct 
airflow element. 

Powerlaw Model: Orifice Area 
This airflow element allows you to describe the airflow through an orifice, and CONTAMW 
converts it to a powerlaw relationship. 

Name: Enter a unique name you want to use to identify the duct flow element. The element will 
be saved within the current project and can be associated with multiple duct segments. 

Description: Field for entering a more detailed description of the specific duct flow element. 

Flow Exponent (n): Flow exponents vary from 0.5 for large openings where the flow is 
dominated by dynamic effects, and 1.0 for narrow openings dominated by viscous effects.  
Measurements usually indicate a flow exponent of 0.6 to 0.7 for typical infiltration openings. 

Discharge Coefficient (C): The discharge coefficient is related to the dynamic effects and is 
typically close to 0.6 for an orifice and slightly higher for other openings in buildings. 

Hydraulic Diameter: The hydraulic diameter is equal to (4 ⋅ Area / Perimeter). For square 
openings this equals the square root of the area, and for long thin openings it is two times the 
width. 

Reynolds Number: The transition from laminar flow to turbulent flow occurs over a very broad 
range of Reynolds numbers with the flow being fully laminar approximately below 100. 

Note: The hydraulic diameter and Reynolds number have little impact on the calculations. 
Generally you should use the default values except for special circumstances where they need to 
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be modified. The values above describe the flow characteristics of an orifice in typical operation. 
At extremely low pressure drops the use of the powerlaw model leads to a division by zero 
during the network solution process. CONTAMW avoids this problem by changing to a linear 
model in this region. The model is based conceptually on the flow changing from turbulent to 
laminar at very low pressures. The Hydraulic diameter and Reynolds number are used to 
determine a point where the model changes from the powerlaw to linear. 

Shape Size and Leakage: You must enter data to physically describe each duct airflow element. 
You input these values on the Shape Size and Leakage property page associated with each duct 
airflow element. 

Powerlaw Model: Q=C(∆P)^n 
This airflow element allows you to directly enter the coefficients C and n for the volumetric flow 
version of the powerlaw model. 

Name: This is the name you give to this airflow element. This name must be unique within a 
project. 

Description: Field for entering a more detailed description of the specific duct flow element. 

Flow Coefficient (C): The coefficients may only be expressed in SI units due to the conversion 
method used. Use the following conversion to convert from IP units to SI units. 
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Flow Exponent (n): Flow exponents vary from 0.5 for large openings where the flow is 
dominated by dynamic effects, and 1.0 for narrow openings dominated by viscous effects.  
Measurements usually indicate a flow exponent of 0.6 to 0.7 for typical infiltration openings. 

Shape Size and Leakage: You must enter data to physically describe each duct airflow element. 
You input these values on the Shape Size and Leakage property page associated with each duct 
airflow element. 

Powerlaw Model: F=C(∆P)^n 
This airflow element allows you to directly enter the coefficients C and n for the mass flow 
version of the powerlaw model. 

Name: Enter a unique name you want to use to identify the duct flow element. The element will 
be saved within the current project and can be associated with multiple duct segments. 

Description: Field for entering a more detailed description of the specific duct flow element. 

Flow Coefficient (C): The coefficients may only be expressed in SI units due to the conversion 
method used. Use the following conversion to convert from IP units to SI units. 
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Flow Exponent (n): Flow exponents vary from 0.5 for large openings where the flow is 
dominated by dynamic effects, and 1.0 for narrow openings dominated by viscous effects.  
Measurements usually indicate a flow exponent of 0.6 to 0.7 for typical infiltration openings. 
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Shape Size and Leakage: You must enter data to physically describe each duct airflow element. 
You input these values on the Shape Size and Leakage property page associated with each duct 
airflow element. 

Fan Model: Performance Curve 
This airflow element allows you to create a fan based on a fan performance curve. You provide 
CONTAMW with a set of pressure rise and airflow rate data points, and CONTAMW performs a 
polynomial curve fit to the data point. 

Name: Enter a unique name you want to use to identify the duct flow element. The element will 
be saved within the current project and can be associated with multiple duct segments. 

Fan off conditions: These values specifies how the fan is modeled when the speed of the fan is 
insufficient to provide a flow. 

Control Value: The actual speed of the fan divided by the rated speed of the fan. When 
this ratio is below the specified limit the fan is modeled as a simple orifice. 

Equivalent Orifice: The size of the orifice used to model the fan opening when the 
control value drops below the specified limit. 

Description: Field for entering a more detailed description of the specific airflow element. 

Fan Performance Data: Click the "Edit Fan Curve Data" to input/modify the fan curve for this 
duct flow element. A detailed explanation of this data is given in the Fan Performance Data 
section under Working with Airflow Paths. 

Shape Size and Leakage: You must enter data to physically describe each duct airflow element. 
You input these values on the Shape Size and Leakage property page associated with each duct 
airflow element. 

Fan Model: Constant Mass Flow 
This airflow element allows you to describe the airflow through a duct as a constant mass airflow 
rate. 

Name: Enter a unique name you want to use to identify the duct flow element. The element will 
be saved within the current project and can be associated with multiple duct segments. 

Description: Field for entering a more detailed description of the specific duct flow element. 

Design (max) Flow: Enter the maximum mass flow rate. You can use the duct segment schedule 
to modify this value. 

Shape Size and Leakage: You must enter data to physically describe each duct airflow element. 
You input these values on the Shape Size and Leakage property page associated with each duct 
airflow element. 

Fan Model: Constant Volume Flow 
This airflow element allows you to describe the airflow through a duct as a constant volumetric 
airflow rate. 

Name: Enter a unique name you want to use to identify the duct flow element. The element will 
be saved within the current project and can be associated with multiple duct segments. 
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Description: Field for entering a more detailed description of the specific duct flow element. 

Design (max) Flow: Enter the maximum volume flow rate. You can use the duct segment 
schedule to modify this value. 

Shape Size and Leakage: You must enter data to physically describe each duct airflow element. 
You input these values on the Shape Size and Leakage property page associated with each duct 
airflow element. 

Backdraft Damper: Q=C(∆P)^n 
This is the volumetric flow version of the Backdraft Damper duct flow element. The Backdraft 
Damper models make it possible to model a feature (e.g. a smoke control damper) that has 
different flow resistances depending on the direction of the pressure drop, with greatly reduced 
(or zero) flow in one direction. 

Name: Enter a unique name you want to use to identify the duct flow element. The element will 
be saved within the current project and can be associated with multiple duct segments. 

Description: Field for entering a more detailed description of the specific duct flow element. 

Pressure Difference ∆P>0 or ∆P<0: This indicates the direction of flow for the model. 

Flow Coefficients: The coefficients may only be expressed in SI units due to the conversion 
method used. Use the following conversion to convert from IP units to SI units. 
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Flow Exponents: Flow exponents vary from 0.5 for large openings where the flow is dominated 
by dynamic effects, and 1.0 for narrow openings dominated by viscous effects.  Measurements 
usually indicate a flow exponent of 0.6 to 0.7 for typical infiltration openings. 

Shape Size and Leakage: You must enter data to physically describe each duct airflow element. 
You input these values on the Shape Size and Leakage property page associated with each duct 
airflow element. 

Backdraft Damper: F=C(∆P)^n 
This is the mass flow version of the Backdraft Damper duct flow element. The Backdraft 
Damper models make it possible to model a feature (e.g. a smoke control damper) that has 
different flow resistances depending on the direction of the pressure drop, with greatly reduced 
(or zero) flow in one direction.  

Name: Enter a unique name you want to use to identify the duct flow element. The element will 
be saved within the current project and can be associated with multiple duct segments. 

Description: Field for entering a more detailed description of the specific duct flow element. 

Pressure Difference ∆P>0 or ∆P<0: This indicates the direction of flow for the model. 

Flow Coefficients: The coefficients may only be expressed in SI units due to the conversion 
method used. Use the following conversion to convert from the IP units to SI units. 
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Flow Exponents: Flow exponents vary from 0.5 for large openings where the flow is dominated 
by dynamic effects, and 1.0 for narrow openings dominated by viscous effects.  Measurements 
usually indicate a flow exponent of 0.6 to 0.7 for typical infiltration openings. 

Shape Size and Leakage: You must enter data to physically describe each duct airflow element. 
You input these values on the Shape Size and Leakage property page associated with each duct 
airflow element. 

3.9.5.2 Duct Junction and Terminal Properties 
This section provides detailed descriptions of the specific duct junction and terminal properties. 
The following sections are the context-sensitive help topics that you can access by pressing F1 
when working with property pages of the "Duct Junction Properties" property sheet. 

Duct Junction and Terminal – Junction Properties 
Junction Number: This number is automatically generated by CONTAMW for identification 
purposes and is unique to each junction. CONTAMW will renumber junctions and terminals 
when saving a project if you have added or removed any junctions or terminals. These icons are 
numbered starting at the top level in the upper left hand corner of the SketchPad moving left to 
right and down the SketchPad then proceeding down through each level in the same manner. 

Elevation & Temperature: The elevation and temperature of the junction are used to determine 
how the duct flow responds to and influences the building stack effect. Enter the height of the 
midpoint of the junction/terminal point relative to the current building level. 

Define Downward Duct: You define vertical duct segments as downward running ducts 
accessed via the duct junction at the top of the downward segment. Press the "Define Downward 
Duct" button to define vertical segments. The SketchPad duct icons that are connected to the 
defined vertical duct will change to indicate the type of vertical connections associated with the 
junction, i.e., connected downward, upward or both (see Junction and Terminal Icons). 

Duct Junction and Terminal – Wind Pressure Properties 
This set of properties is only available for those junctions or terminals that are located in the 
ambient zone and thus potentially subject to wind effects. 

Wind Pressure Option: There are three wind pressure options for duct terminals located in an 
ambient zone:  

1.  No wind pressure 

2. Constant pressure 

3. Pressure dependent on wind speed and direction 

When you select one of the above options, the following data entry options that correspond to the 
wind pressure option that you selected will be made available for your input. 

Constant Pressure Data: Enter a constant wind pressure (wind speed and direction 
independent). 
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Variable Pressure Data: Variable wind pressures are computed from the product of the 
following three parameters: 

1. The dynamic pressure of the wind at some reference height. CONTAMW will determine 
this pressure based on either the steady state wind data (See Wind Properties) or the 
transient wind data from a weather file (See Defining Transient Weather and Wind). 

2. A coefficient accounting for local terrain effects (Wind Pressure Modifier). 

3. A pressure coefficient accounting for relative wind direction (Wind Pressure Profile). 

Wind Pressure Modifier: CONTAMW uses this value to account for differences between 
wind velocity profiles at the building site and that at a measurement location, e.g. an airport 
weather station (See Working with Weather and Wind). CONTAMW only requires this value 
if you are implementing Variable Wind Pressure for an airflow path. CONTAMW will 
provide a default value for this based on the data entered via the Weather and Wind 
Parameters Property Page or you can override the default value for a particular airflow path.  

Wall Azimuth Angle: Enter the direction the wall faces (clockwise from north).  

Profile: The wind pressure profile accounts for the wind direction effects. You may select a 
previously defined wind pressure profile from those contained in the Name list. Click the 
"New Profile" button to define a new wind pressure profile. To view or modify wind pressure 
profile data, click the "Edit Profile" button. After you press the "New Profile" or "Edit 
Profile" button, the Wind Pressure Profile page will be displayed with a graphical 
representation of the profile. 
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3.10 Working with Controls 
Controls allow the characteristics of one building element to be modified during transient 
simulations in response to a change in characteristics of another building element. You can also 
use controls to simply monitor building performance by polling building elements for values and 
logging them to a control log file during a simulation.  

Controls include sensors, links, modifiers and actuators. Sensors are control elements that are 
used to obtain a value, calculated during simulation, of a building component and then provide it 
to a control network. You can use sensors to obtain zone contaminant concentrations and 
temperatures as well as pressure drops and airflow rates of airflow paths. You can use actuators 
to control of schedulable items such as airflow paths. Note that actuator input to a controlled 
building element overrides any schedule values associated with the element. 

The connection between sensors and other nodes in a control network are made up of control 
links. Control modifiers are nodes within the control network that are used to change or modify 
their input signals. Control actuators are used to modify various characteristics of building 
components based on control signals obtained from sensors and even modified by signal 
modifiers. For example, a sensor can be used to obtain a contaminant concentration within a 
zone, and a proportional control actuator can be used to adjust supply airflow through a supply 
airflow path into the zone based on the sensed concentration. 

3.10.1 Control Elements 
A control network can consist of many different control nodes, each of which is defined by a 
control element. There are several different types of control element types provided such as a 
report element that can be used to convert dimensionless sensor values to engineering units; 
mathematical elements to perform simple mathematical and logical operations on input signals; 
and classical control elements such as proportional/integral, band and limit controls. There is a 
phantom control element that can be used to reference an existing control node, which is 
convenient for linking nodes that may be on different levels of a building or simply too far apart 
to conveniently draw a physical link. Each of these element types is described in detail in the 
Control Element Types section. While every node in the control network must refer to a single 
control element, multiple nodes can refer to the same control element using the phantom 
node/control element.  
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3.10.2 Drawing Controls 
You draw controls using the links drawing tools previously described in the "Working with the 
SketchPad" section. When you finalize the drawing of a set of control links, the appropriate icons 
will be placed upon the SketchPad depending on where the link originates and where it 
terminates. For example, if you begin drawing a control link directly on a zone icon, a sensor 
icon will be placed adjacent to the zone icon, and if you terminate a control link on an airflow 
path, an actuator icon will be placed adjacent to the airflow path icon (See Figure below).  

 
Figure – Control link icons 

If you terminate a control link on a blank cell, a control node icon will be placed within that cell. 
You may not originate and terminate a link on a non-control node icon (e.g. zone, flow path or 
occupant) without an intermediate control node icon (See Figure below). This is due to the 
requirement that the input from an actuator to a non-control node icon must be in the form of a 
multiplier ranging from 0.0 to 1.0.  

 
Figure – Invalid control link 

Control node icons can have up to four links into or out of them depending on the type of control 
node you are defining. If a control node icon is not yet defined, CONTAMW will only allow you 
to draw at most two inputs (one vertical and one horizontal) into the node and at most four 
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outlets from the node. However, if the control node icon is already defined, CONTAMW will 
only allow the correct set of links to be defined into the icon depending on the control element 
type (See Control Element Types) of the control node. This is due to the input signal convention 
of control nodes that distinguishes two different inputs signals for certain element types, e.g. 
limit controls, or to establish the order of operators for non-commutative mathematical 
operations, e.g. subtraction and division. As shown in the Figure below, Input Signal 1 enters 
either from the left or right and Input Signal 2 enters from either the top or bottom of the node. 
Details on input signals are provided for each element type where required in the description of 
the specific elements. 

 
Figure – Control node input signal convention 

3.10.3 Deleting Controls 
Deleting currently defined controls is a two-step process and can only be performed when 
CONTAMW is in the normal mode, i.e., not viewing SketchPad results. That is, if you want to 
delete a control link, sensor, actuator or node, you must first undefine the item. To undefine a 
control you must highlight a control node or link and press the Delete key or select Delete from 
the Edit menu. This will highlight either a single node (if no output signals) or a link segment 
and prompt you to confirm the undefine operation by displaying a message box. Once you 
undefine a control node or link segment, it will again be displayed in red. To delete the control 
node or link you highlight any portion of the undefined node or link segment and perform the 
deletion. The entire portion to be deleted will be highlighted, and you will be asked to confirm 
the deletion. If you try to delete a node that is referenced by a phantom control element, you will 
be warned. Deleting such elements prior to deleting those phantom nodes that reference them can 
cause problems.  

3.10.4 Modifying Controls 
To modify the parameters of a defined control node, you use the icon definition procedure (See 
Defining Building Component Icons) to display its properties and make the desired changes. You 
can not move and copy controls. To do this you must delete and redraw your control network, 
therefore careful planning is advised in laying out your control networks. 

3.10.5 Defining Controls 
You must define all control nodes and sensor icons in order to perform a simulation. Control 
links will be defined automatically upon definition of the node or sensor from which they 
emanate. Generally, you should define control nodes in the direction of information flow 
indicated by the link arrows. Define control nodes and sensors using the icon definition 
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procedure (See Defining Building Component Icons) to display and edit their properties.  

3.10.6 Hiding Controls 
If there are controls in your project, you can hide them on the SketchPad. Use the View → 
Control Links menu command to toggle the display of the control network on and off. 

3.10.7 Sensors 
When you double-click an undefined sensor icon, the Control Sensor definition dialog box will 
appear. The parameters will either be those for a zone or airflow/duct flow path depending on the 
building component with which the sensor is associated. For a zone sensor you can select to 
sense either the zone temperature or the mass fraction of any of the project contaminants. For a 
flow path you can select to sense either the flow rate or pressure drop across the path. Sensor 
output defaults to the base units of CONTAM, but you can modify this by changing the Gain and 
Offset values provided. However, the "Report a value" control element (described below) 
automatically provides values to convert from the base units to the default units of your project 
or of the particular contaminant which you are sensing. 

A Description field is also provided that you can use to describe the sensor in detail. This 
description will be displayed in the status bar when you highlight the sensor icon. The 
description defaults to either "zone sensor" or "path sensor." 

3.10.8 Control Nodes 
Double-clicking on an undefined control node icon will display the Control Element Types 
dialog box from which you select the type of control element you wish to define. Control 
elements can be categorized by the number of inputs that can be associated with them: unary, 
binary and multiple. Therefore, when the Control Element Types dialog is displayed, various 
types will be enabled/disabled for selection depending on the number of inputs that you have 
drawn into the currently selected node. 

Once you select the type of element you want to create, you assign values to the parameters of 
the control elements. All control elements have an optional Name parameter with the exception 
of the phantom for which the Name parameter will be used to reference the name of another 
existing element. The name parameter is only required if you want to reference the element with 
a phantom node.  

Each element also has an optional Description parameter, which is filled in with a default value 
when you create an element, but you may change the description. The description will be 
displayed in the status bar when you highlight the control node on the SketchPad. Many of the 
elements do not have any parameters other than the Name and Description, because they simply 
perform a predetermined operation on the input(s) to the node, e.g., the "+ Add" element simply 
takes two inputs, adds them and provides the results as an output signal. Other control elements 
have additional parameters required to define their behavior, e.g., the "Constant" element has a 
value parameter use to specify the constant value of the output signal from the control node. 
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3.10.9 Control Element Types 
There are a number of control element types that you can associate with an undefined control 
node. Detailed descriptions and properties of these control elements are provided in the 
following sections.  

� Phantom control 
Use this control element to reference a named control element that already exists elsewhere 
within your project. Phantom nodes are useful when you need a control signal from a node 
that is located remotely upon the SketchPad or when you are implementing one of the 
multiple-input elements. This is useful in referencing a node on another level of a building, 
because CONTAMW does not allow you to draw links between building levels. This can 
also be used to "cascade" inputs into the multiple-input sum and average controls when you 
want to sum or average more than three inputs or remotely located, named inputs. 

� Schedule 
Use this control element to apply a schedule via the control network. A schedule can be 
applied to airflow paths, simple air handling systems, inlets and outlets of simple air handling 
systems and source/sinks. Control schedules will override schedules that are defined as a 
parameter of an element. You can select an existing schedule or create a new one (See 
Creating Schedules).  

� Constant 
Use this control element to define a simple constant. The constant is useful as input to other 
control elements such as the mathematical, limit and switch controls. 

� Modifier 
Use this control element to modify an input signal by providing a Gain and Offset parameter. 
The input signal will be modified according to the following equation. 

 output = (input – Offset) / Gain 

The parameters for the Modifier control are: 

 Gain – a proportional value used to convert the input signal 

 Offset – an offset value used to convert the input signal 

� Hysteresis 
Use this control element to simulate hysteresis of a control actuator. Hysteresis is 
characterized by the Slack parameter where Slack is the fraction of the input signal’s range 
over which the output signal remains constant when the input signal changes direction. The 
relationship of the output signal to the input signal is shown in the following figure. This plot 
shows the signal increasing from 0 to 1 and back down to 0 again. The increasing and 
decreasing signals are characterized by the following equations respectively. 

Increasing:  output = maximum( 0.0, input * Slope + Int ) 

Decreasing: output = minimum( 1.0, input * Slope ) 
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Where 

 Slope = 1 / (1.0 – Slack) 
 Int = output – Slope * input 

 
Figure – Plot showing hysteresis curve of Hysteresis control element 

� Report a value 
Use this control element to report values to a file created by CONTAMW for the specific 
purpose of logging these reported values for each listing time step of a transient simulation 
(See Output Properties). If you perform a transient simulation and implement report control 
elements, CONTAMW will create a file in the same directory as your project file with the 
name of your project file and the .LOG extension appended. For example if your project is 
MyProj.PRJ, CONTAMW will create the file MyProj.LOG. You can also use the Report 
control element to provide automatic unit conversions of sensor data from the dimensionless 
units of a sensor (e.g. K or kg/kg) to engineering units associated with the type of sensed data 
(e.g. ºC or ppm(v)). 

The value output from the report element will be determined according to the following 
equation: 

 output = ( input – Offset ) * Scale 

The parameters for the Report control are: 

 Scale – a scale value used to convert the input signal 
 Offset – an offset value used to convert the input signal 
 Header – the header that will appear in the log file for this control element 
 Units – units that will appear below the header in the log file for this control element 
The report control will also provide the default conversion values, Scale, Offset and Units if 
CONTAMW finds a sensor "down-link" in the control network that has not yet been 
converted from its dimensionless form.  
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� Signal split 
Use this to split a signal, so the same signal can be directly linked to multiple nodes in the 
control network. 

� Logical 
Use these controls to provide logical operations including: 

Binary – convert input signal to binary 0 or 1, 

NOT – negate single input value and provide binary output 0 or 1, 

AND – perform AND operation on two input values and provide binary output 0 or 1. 

 output = 1  IF (input_1 > 0) AND (input_2 > 0) 

 output = 0  otherwise 

OR – perform OR operation on two input values and provide binary output 0 or 1. 

 output = 1  IF (input_1 > 0) OR (input_2 > 0) 

 output = 0  otherwise 

XOR – perform XOR operation on two input values and provide binary output 0 or 1. 

 output = 1  IF (input_1 > 0) AND (input_2 <= 0) 

 output = 1  IF (input_2 > 0) AND (input_1 <= 0) 

 output = 0  otherwise 

� Mathematical  
Use these controls to provide mathematical operations including: 

Absolute value – provide absolute value of input signal, 

Add, Subtract, Multiply, and Divide – perform operation on two input signals and provide 
result as output.  

Note the order of operation is important for Subtract and Divide. 

Subtract:  output = input_1 – input_2 

Divide: output = input_1 / input_2 

Sum and Average – Sum or average multiple input signals and provide result as output 
signal. Three signals can be directly input to using links drawn into the control node icon, 
and more can be cascaded through the use of phantom nodes. 

� Limit switches 
Limit switches provide the ability to set an output signal to either on or off (0 or 1) based 
upon the difference between the two input signals.  

Lower limit switch 
output = 1  IF ( input_1 < Limit )     [Limit = input_2] 

 output = 0  otherwise. 
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Upper limit switch 
output = 1  IF ( input_1 > Limit )     [Limit = input_2] 

 output = 0  otherwise 

The band switches incorporate the control parameter, Band width, to provide a dead band 
for the on/off control. 

Lower band switch 
output = 1 when input_1 rises above input_2 + Band width 

 output = 0 when input_1 < input_2 

 input_2 is the lower limit of the band 

Upper band switch 
output = 1 when input_1 falls below input_2 – Band width 

 output = 0 when input_1 > input_2 

  input_2 is the upper limit of the band 

� Limit controls 
Limit controls provide the ability to set an output signal to a value ranging from 0.0 to 1.0 
based upon the difference between the two input signals. These would typically be used to 
provide an error signal to a proportional controller. 

Lower limit control  
output = input_2 - input_1  

Upper limit control 
output = input_1 - input_2 

The upper and lower limit controls can be used to prepare an error signal for the proportional 
controls.  If the input signal to an upper limit control is greater than the limit value, a positive 
output results;  e.g., if a contaminant concentration is too high, the positive signal could 
activate an airflow device.  If the input signal to a lower limit control is lower than the limit 
value, a positive output results;  e.g., if the air flow through an opening is too low, a positive 
signal could activate a fan to provide the required flow.   

� Proportional and Proportional–Integral 
Proportional control – This is a model of a simple proportional controller where the input 
signal is an error signal that is typically a sensed value minus a set-point value which is 
obtained by using other control functions, e.g. the constant control. The input signal is 
multiplied by the proportionality constant parameter of the control, Kp. The output signal is 
limited to values between 0 and 1, so you should set the proportionality constant accordingly. 
The output signal could then be modified as required using other control elements. 

 output = input ⋅ Kp  

Proportional-Integral control – This is a model of a simple P-I controller where the input 
signal is an error signal. The output signal is limited to values between 0 and 1 and is 
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modified by the control parameters Kp and Ki according to the following equation. 

 output = output* + Kp ⋅ (input - input*) + Ki ⋅ (input + input*) 

where output* and input* are the values of output and input at the previous time step. The Kp 
and Ki factors must be tuned for the specific problem and time step. This is similar to an 
"incremental" P-I algorithm described in equations (17-37) and (18-3) of [Stoecker and 
Stoecker 1989]. 
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3.11 Working with Species and Contaminants 
Airborne contaminants are dispersed throughout buildings due to several different transport 
mechanisms. These include air movements into, out of, and within a building system; heating, 
ventilating, and air-conditioning (HVAC) systems; removal by filtration, deposition, and 
sorption; generation; chemical reaction; and radio-chemical decay. CONTAMW provides you 
with the ability to simulate these methods of dispersal of airborne contaminants within built 
structures.   

Species is a general term used (by CONTAMW) to identify substances that can be used as 
contaminants during a simulation, i.e., contaminants are those species you designate to be used in 
a simulation. You can include as many species/contaminants as you need within a project. 

CONTAMW handles both trace and non-trace contaminants. Trace contaminants are those that 
exist at concentrations that do not cause a "significant" change in the density of air.  Non-trace 
contaminants are those that can affect the density of the air. The mass fractions of non-trace 
contaminants will always sum to 1 kg/kg, i.e., they are the constituents of the air. 

Another important underlying assumption of the model implemented by CONTAMW is that 
each zone is considered to have a single concentration value at any given time. This assumption 
is sometimes referred to as the "well-mixed" zone assumption. With respect to contaminant 
analysis, this means that there are no spatial concentration gradients within a given zone. 

You can use CONTAMW to perform steady state, transient, and cyclical contaminant analysis. 
Steady state analysis refers to the determination of contaminant concentrations under steady flow 
conditions. Transient analysis refers to the determination of the time history of contaminant 
concentrations within each zone for a set of discrete time-steps. With a transient analysis you can 
implement the effects of varying ambient contaminants using a contaminant file (See 
Contaminant Files). A cyclic analysis determines the time history of contaminant concentrations 
for a 24 h period such that the concentrations at the beginning and end of the 24 h period are the 
same for each zone. 

With CONTAMW you must define contaminants in order to utilize the features that 
CONTAMW provides to simulate the generation of contaminants by sources, the removal by 
sinks (including filters and kinetic reactions), and to determine occupant exposures. 
Contaminants must be created/defined prior to implementing any of these contaminant-
dependant features of CONTAMW. Prior to implementing contaminants within a project, you 
can first define the building layout on the SketchPad, define all airflow paths (including ducts) 
and test your building model by performing a steady state airflow simulation. 

3.11.1 Non-trace Contaminants and Water Vapor 
CONTAMW handles non-trace contaminants, which are those contaminants that you define to 
be the constituents of air. Typically, you might want to treat water vapor as a non-trace 
contaminant. CONTAMW will treat a contaminant with the name "H20" as water vapor. The 
concentration will be affected by the humidity ratio contained in weather files that you use 
during simulations (See Defining Transient Weather and Wind). CONTAMW will calculate the 
concentration of H2O within each zone, as the mass fraction of water to air in units of kg_H2O 
/kg_air, where kg_air = kg_dry_air + kg_H2O. Whereas the humidity ratio is typically given as 
the ratio of the mass of water vapor to that of dry air. You can convert between the two using the 
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following relationship. 

 Humidity ratio = mass fraction of H2O / (1 – mass fraction of H2O) 

For example, to create air from its typical constituents you might define the following set of non-
trace contaminants (See Creating Species and Contaminants): 

 

Name Molecular 
Weight 

[kg/kmol] 

Default 
Concentration 

[kg_cont/kg_air]

Trace 
Contaminant 

Use in 
Simulation 

N2 28 0.7808 Non-trace Use 

O2 32 0.2095 Non-trace Use 

Ar 40 0.0093 Non-trace Use 

CO2 44 0.0003 Non-trace Use 

H20 18 0.0000 Non-trace Use 

 

Note in the above example, the ∑Default Concentration = 1.0 kg/kg. 

As a simpler example, you might create a dry air contaminant, Air, and a water vapor 
contaminant, H20, as follows. 

Name Molecular 
Weight 

[kg/kmol] 

Default 
Concentration

[kg_cont/kg_air]

Trace 
Contaminant

Use in 
Simulation 

Air 28.965 1.000 Non-trace Use 

H2O 18.015 0.000 Non-trace Use 

 

3.11.2 Creating Species and Contaminants 
You can create species by either activating the Project Species dialog box via the Data → 
Contaminants… menu or using the CONTAMW Data and Library Manager: Species dialog box 
accessed via the Data → Species… menu. The Project Species dialog box will enable you to 
create and modify species for the current project. The Library Manager will enable you to import 
species from species-related libraries. A detailed description of each of the contaminant 
properties is given in the Species Properties section of this manual. Each species has a default 
concentration associated with it that you define (or leave zero). You can use this default 
concentration to set the initial concentrations within a building without having to utilize a source 
element. 

3.11.3 Deleting Species and Contaminants 
You can delete species using the Delete button of the Project Species dialog box or of the 
CONTAMW Data and Library Manager: Species dialog box. Species can not be deleted if they  
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are associated with a source/sink, filter or kinetic reaction. For those species for which an 
association exists, the Delete buttons will be deactivated. You can also disable the use of a 
contaminant within a simulation by deselecting the "Use in Simulation" box for a given species 
from within the Species Properties dialog box.  

3.11.4 Modifying Species and Contaminants 
Once you have created species for a project, you can modify any of the related parameters. This 
is done by using the Edit button from within the Species Properties dialog box that is accessed 
via the Data → Contaminants… menu item. CONTAMW will allow you to change the name of 
an existing contaminant without affecting any of the currently associated sources, sinks, filters or 
kinetic reactions as they reference contaminants by an internal index created by CONTAMW. 

3.11.5 Project Species 
Species must be defined before any related elements (e.g. source/sinks, filters and kinetic 
reactions) can be defined. From the Project Species page any previously defined species may be 
viewed, edited, or deleted and new species may be defined. The following describes the 
information that appears on the Project Species dialog box. 

Species: This is a list of the species that are currently defined within the current project. 

Species Properties: These are the properties of the currently highlighted species. 

Contaminants: This is a list of the project species for which the "Use in Simulation" property is 
set to "Use," i.e., these are selected to be contaminants in the simulation. 

Contaminant Summary: This is a summary of contaminant-related information including the 
number of non-trace contaminants and the summation of the default concentrations of the non-
trace contaminants which must be 1.0. 

New, Edit and Delete: Click the "New" button to create a new species. To modify the properties 
of an existing species, highlight the species in the species list and click the "Edit" button. Click 
the "Delete" button to delete the selected species. 

IMPORTANT: Changing the number of contaminants, i.e. those species used in the simulation, 
will reset the initial concentrations of all zones to the default contaminant concentrations. You 
can reset all of these concentrations via the Run Control Properties of the simulation parameters 
or via the Contaminant Data properties of the individual zones. 

3.11.6 Species Properties 
This section provides detailed descriptions of the specific species properties.  

Name: You will use this name to refer to the species throughout the program. You must give 
each species a name that is unique to the current project. 

Molecular Weight: The molecular weight in g/mol or kg/kmol. CONTAMW uses this value to 
convert volumetric concentrations to mass fractions and to calculate the gas constant of the air 
mixture made up by non-trace contaminants. You must enter a value of at least 1.0. 

Default Concentration: CONTAMW will apply this value as the default initial concentration 
for each zone that you create as well as for the ambient zone for a steady state simulation. You 
can revise this value for individual zones as per your requirements. 
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Decay Rate: This is an exponential decay constant based upon the half-life of the radioactive 
species calculated using the following equation: 

Decay Rate = ln(2) / τ1/2, 

where τ1/2 is the half-life of the radioactive species in seconds. 

CONTAMW will use this value to perform unit conversions for radioactive contaminants. 
Radioactive species are only distinguished from other species by the units associated with them, 
not by modeling the radioactive decay process. To model a radioactive decay, use a kinetic 
reaction (See Kinetic Reaction Data). 

Non-Trace Contaminant: Non-trace contaminants are those that can affect the density of the 
air, i.e., are considered components of the air. 

Use in Simulation: This determines whether or not a species will be a contaminant. Checking 
"Use in Simulation" indicates that a species will be a contaminant and used in the simulation. 

Description: Use this to provide a more detailed description of the species. 

Specific Heat: Currently not implemented. 

Guideline Value: Currently not implemented. 

Guideline Description: Currently not implemented. 

3.11.7 Contaminant Files 
You can account for changes in the ambient contaminant concentrations when performing 
transient contaminant simulations using ambient contaminant (.CTM) files. If you associate a 
contaminant file with your project (See Run Control Properties) CONTAMW will compare those 
contaminants defined within your project file with those contained in the contaminant file. If 
they match, CONTAMW will use the ambient concentrations in the contaminant file within the 
simulation, otherwise they will be ignored. 

You create the contaminant files external to CONTAMW. You can use a utility program 
provided by NIST, Weather 2.0, to convert existing CONTAMW 1.0 weather (which previously 
contained ambient contaminant concentrations) files to CONTAMW 2.0 weather and 
contaminant files. 

� Contaminant (.CTM) File Format 
The CONTAMW contaminant (species) file is a tab-delimited ASCII text file. These files are 
easily created, imported and modified using common spreadsheet applications. They can be 
saved as tab-delimited text files for use with CONTAMW 2.0. In the listing below I1 indicates a 
character string, I2 indicates a short integer and R4 indicates a four-byte real number. Individual 
lines of data are separated by dashes (these dashes are only shown here for format presentation 
purposes and should not be included in the actual files). Each day must begin with time 00:00:00 
and end with time 24:00:00. The time interval between 00:00:00 and 24:00:00 can be either 
regular or irregular – CONTAMX will interpolate as necessary. Comments are allowed and are 
indicated by an "!" (exclamation point). Anything that appears on a line following a comment 
indicator is ignored by the contaminant file reader. 
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SpeciesFile ContamW 2.0  ! file and version identification 
----- 
I1 Descr[]          ! species file description 
----- 
I1 StartDate        ! day of year (1/1 – 12/31)  
I1 EndDate          ! day of year (1/1 – 12/31)  
I2 NumCont          ! number of species 
----- 
I1 Name[1]          ! name of species 1 (16 characters max) 
I1 Name[2]          ! name of species 2 
... 
I2 Name[NumCont]    ! name of species NumCont 
----- 
!Date  Time Name[1] Name[2] ... Name[NumCont] 
----- 
! for each day:  start_date – end_date 
! for each time: 00:00:00 - 24:00:00 increment may be variable 
   I1 Date          ! date (1/1 – 12/31) 
   I1 Time          ! time of day 00:00:00 – 24:00:00 
   R4 Conc[1]       ! concentration of species 1 
   R4 Conc[2]       ! concentration of species 2 
   ... 
   R4 Conc[NumCont] ! concentration of species nc  
                    ! [kg_species/kg_air] 
----- 

� Editing Contaminant Files 
You can import ambient files into a spreadsheet program for editing. However you must make 
sure that the date format is compatible with CONTAMW when you save the file. One well-
known spreadsheet program will convert the CONTAMW date format of mm/dd into the mmm-
dd form. For example the CONTAMW date format for January 1 is "1/1", but the spreadsheet 
program will convert it to "Jan-01" unless you "force" it to import the first column of data – the 
one that contains date information – as text. Another option is to accept the default importing 
option then change the cell format for each date to the CONTAMW format mm/dd prior to 
saving the file as tab-delimited. 

� Contaminant unit conversions 
To convert from ppm to: 

kg/kg = (ppm x MW) / (1,000,000 x Vs x ρ) 

mg/L  = (ppm x MW) / (1,000 x Vs) 

mg/m3 = (ppm x MW) / Vs  

mg/ft3 = (ppm x MW) / (35.3147 x Vs) 

CONTAMW uses the following values in the conversions: 

Vs = 24.05 m3, the volume of one mole of air at T = 20ºC and P = 101,325 Pa (1 atm) 

ρ (density of air) = 1.204 kg/m3 at T = 20ºC 
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3.11.8 Species Filters 
CONTAMW provides some building components with the ability to act as contaminant removal 
devices or filters. You define filters that you can associate with one or more building components 
within a project. You can access the Filter Properties dialog box via any of the building 
component property sheets that provide a Filter definition page or via the CONTAMW Library 
Manager. 

The following building components provide for contaminant species filtering: 

1. Airflow paths 

2. Implicit outdoor air and recirculation air paths of simple air-handling systems 

3. Supply and return air paths of simple air-handling systems 

4. Duct segments 

When you are defining each of these types of building components, you will be able to select a 
currently defined filter to associate with it, define new filters, or modify existing filters. All 
filters are defined and modified using the Filter Properties dialog box as described in the 
following section. 

You can use the CONTAMW Library Manager: Filters dialog box to share filters between 
projects using library files. Access the filter library manager via Data → Filters… menu item or 
via the "Library" button of the property pages for the three building components mentioned 
above. 

3.11.9 Filter Properties 
These are the properties that describe a filter element. Species filter elements are made up of a 
set of species and associated efficiencies. Each filter element is made up of from one to the 
number of species that exist within the project, but you can define any number of filters.  

Only those species that you have selected to be contaminants will be accounted for when you 
perform simulations.  

Name: Enter a unique name you want to use to identify the filter.  

Description: Use this field to provide a more detailed description of the filter. 

Filtered Species: This is a list of the species and filter efficiencies for the particular filter being 
edited. 

Edit Filter Data: Use this section to edit the highlighted Filtered Species or create new ones. 
Use the Add, Replace and Delete buttons accordingly.  

Efficiency: Use this edit field to set the filter efficiency for the currently highlighted species. 
Filter efficiencies must be between 0.0 and 1.0.  

Species: This is a list of all the species in either the current project or library file depending 
on whether you are editing project data or library data. Select the species for which you want 
to set a filter efficiency. 
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3.11.10 Kinetic Reactions 
CONTAMW provides the ability to model chemical reactions among project contaminants 
within zones of a building including the implicit supply and return nodes of a simple air-handling 
system (See Air Handling System). Kinetic reactions in CONTAMW are modeled as first-order 
exponential functions between species that contain the paired first-order reaction rate coefficients 
between the reactant and product contaminants. See Axley [1988] and Axley [1995] for a 
detailed presentations of the kinetic reaction simulation method employed by CONTAMW. The 
production or destruction of a contaminant α is given by 

( )∑ ⋅=
β

ββαα CKR ,

 
where 

Rα   rate of production or destruction of contaminant α 
Kα,β  reaction rate coefficients between contaminants α and β, in units of 1/s 
Cβ   concentration of a reactant 

CONTAMW uses the convention that positive reaction coefficients produce an increase in 
species concentration and negative coefficients decrease species concentrations. The units of 
concentration are kg_species / kg_air (See Concentration Conversions). 

Kinetic reactions can occur within zones of a building. To use kinetic reactions, you must have at 
least one species for the project. Kinetic reactions can be associated with one or more zones 
within a project. You can access the kinetic reaction data dialog box via the property sheets of 
the zones that provide a kinetic reaction definition section (i.e. zones and simple air-handling 
systems).  

You can also access the Kinetic Reaction Data dialog box using the CONTAMW Data and 
Library Manager: Kinetic Reactions to create and edit local project data or to share kinetic 
reactions between CONTAMW projects using contaminant libraries. 

When you are defining building zones, you will be able to select a currently defined kinetic 
reaction to associate with it, define new, modify existing or import kinetic reactions from 
species-related CONTAMW library files (i.e. LB0 library files). All kinetic reactions are defined 
and modified using the Kinetic Reaction Data dialog box as described in the following section. 

3.11.11 Kinetic Reaction Data 
Kinetic reaction elements are made up of source/product species pairs. You can define any 
number of pairs per element you desire. Only those species that you have selected to be 
contaminants will be accounted for when you perform simulations. These are the properties that 
describe a kinetic reaction. 

Name: Enter a unique name you want to use to identify the reaction matrix. You will use this 
name to associate this element with zones within the project. 

Description: Use this to provide a more detailed description of the kinetic reaction. 

Reactant→Product Pairs: This is a list of the reactant/product pairs and their associated 
reaction coefficients that are currently defined for the current kinetic reaction element.  

Edit Reactant→Product Pair: Use this section to edit the highlighted Reactant→Product pair 
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or create new ones. Use the Add, Replace and Delete buttons accordingly.  

Reactant Species: This is a list of all the species in either the current project or library file 
depending on how this dialog box was accessed. Select a species to be the reactant in the 
R→P Pair. 

Product Species: This is a list of all the species in either the current project or library file 
depending on how this dialog box was accessed. Select a species to be the product in the 
R→P Pair. 

Reaction Coefficient: Use this edit field to set the reaction coefficient for the currently 
highlighted R→P Pair. The units of the coefficient are s-1. 

Examples 
The following are examples of kinetic reactions as implemented within CONTAMW. 

� Kinetic Reaction Example 1 
To simulate the first-order decay of a species, you would set the coefficient of the 
Reactant→Product Pair to the negative of the reaction rate in units of 1/s. 

 
This figure shows kinetic reaction coefficients for two species reactions that will yield 
exponential decays of each species according to the following equation: 

( ) (0) jiK t
j iC t C e=   

Where, 

Cj(t) = concentration of product contaminant j at time t 
Ci(0) = initial concentration of reactant contaminant i at time 0 
Kji  = reaction rate coefficient between product j and reactant i (time constant)  

In the above example, the reaction rate coefficients are as follows: 

K11 =  -0.0001388/s 
K22 =  -0.0000347/s  
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If the reaction is the only means of species removal, i.e., there is no dilution due to airflow, then 
species C1 would decay at a rate of  

0.0001388 * 3600 = 0.5/h,  

and C2 would decay at a rate of 

0.000034722 * 3600 = 0.125/h. 

� Kinetic Reaction Example 2 
This example illustrates the first-order decay of species C1 (reactant and product) and the first 
order build-up of another species C2 (product) based on C1(reactant). 

 
This figure above shows the parameters for the "kr1" kinetic reaction element. This element 
provides for two reactions that will yield an exponential decay of contaminant C1 according to 
the equation 

11
1 1( ) (0) K tC t C e= ,  

and the build-up of contaminant C2 according to  
21

2 1( ) (0)(1 )K tC t C e= −  
In the above example, the reaction rate coefficients are as follows: 

K11 =  -0.0001388/s   
K21 =   0.0001388/s  

Note that both the decay and build-up are dependant on the species of C1. 

� Kinetic Reaction Example 3 
You can also use the kinetic reaction to simulate a consecutive first-order reaction series. (The 
radioactive decay chain of Radon gas is an example of such a reaction.) 

A two-step consecutive reaction series involving a single reactant at each step is indicated as 

C1 → C2 
C2 → products  
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You would model this reaction chain by inputting coefficients based on the half-life of the 
radioactive reactants. Convert half-life τ1/2 to a first-order reaction coefficient, K21, using the 
following equation: 

1/ 2ln(0.5) /K τ=  
In CONTAMW, you would require two species C1 and C2 (if interested in contaminant C2) and 
three reactant/product pairs have the following reaction coefficients characteristics: 

K11 would have negative non-zero values (decay of C1) 

K21 would have a non-zero positive value (build-up of C2 from C1) 

K22 would have negative non-zero values (decay of C2) 
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3.12 Working with Sources and Sinks 
Sources and sinks are used to generate contaminants within and remove contaminants from 
zones. Sources can be used to simulate building materials such as carpet, pieces of furniture, and 
episodic events such as the use of cleaning products. You can define an almost unlimited number 
of sources within a project. 

To implement a source/sink, you must first define the species with which you want the 
source/sink to be associated. You then place a source/sink icon within a zone on the SketchPad. 
Once you place source/sinks on the SketchPad, you can define their characteristics, move, copy, 
and delete them. You must associate each source/sink with a predefined species and provide 
specific information that describes its emission and/or removal characteristics.  

NOTE: It is important to note that even though you associate a species with each source/sink, 
only those species that are designated to be contaminants will actually be used when performing 
simulations (See Species Properties). 

Much of the information that describes the characteristics of a source/sink is contained in 
source/sink elements that you must create when defining source/sinks. The details of drawing, 
defining and modifying sources and sinks are described in the following sections. 

3.12.1 Source/Sink Elements 
CONTAMW uses mathematical relationships referred to as source/sink elements or models to 
implement sources and sinks when performing contaminant simulations. CONTAMW can 
implement several source/sink models to generate contaminants within or remove contaminants 
from a zone. Depending on the source/sink model, it could be used to emulate either a source, a 
sink or both. Each of these source/sink element types is described in detail in the Source/Sink 
Element Types section. Every source/sink must refer to a single source/sink element; however, 
multiple source/sinks can refer to the same source/sink element.  

Source/sink elements can also be stored within a CONTAMW library file and shared between 
different CONTAMW project files (See Working with Data and Libraries). 

3.12.2 Creating Sources and Sinks 
You create source/sinks by placing a source/sink icon on the SketchPad (See Drawing Building 
Component Icons). You must first define at least one species before CONTAMW will allow you 
to place a source/sink icon upon the SketchPad. Each source/sink must be placed within a 
building zone. You cannot place them in the ambient zone. Ambient sources are handled using 
either the initial concentration property of a contaminant (for steady state simulations) or the 
concentration contained within a weather file (for transient simulations). The "Source/sink" 
menu selection will be disabled (grayed out) if you pop-up on a location where CONTAMW 
does not allow the icon to be placed. 

3.12.3 Deleting Sources and Sinks 
You delete source/sink icons using the icon deletion procedure (See Deleting Building 
Component Icons). Deleting source/sink icons from the SketchPad does not delete any 
source/sink elements that you may have defined. These elements can only be deleted using the 
CONTAMW Library Manager, accessible through the Data → Source/Sinks... menu. 
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3.12.4 Modifying Sources and Sinks 
To modify the parameters of a source/sink, you use the icon definition procedure (See Defining 
Building Component Icons) to display its properties and make the desired changes. You can also 
move and copy source/sinks. 

� Moving Source/Sink Icons 
Once you define a source/sink, you can move the icon using the Cut and Paste functions of the 
Edit menu. You can move the source/sink icon anywhere within the zone in which it is currently 
located. 

� Copying Source/Sink Icons 
Once you define a source/sink, you can copy the icon using the Copy and Paste functions of the 
Edit menu. You can copy a source/sink to any blank cell within a zone on any level of a project. 

3.12.5 Defining Sources and Sinks 
After you draw a Source/Sink icon on the SketchPad you must define it using the icon definition 
procedure (See Defining Building Component Icons) to display and edit the properties. This will 
display the "Source/Sink Properties" property sheet. Detailed descriptions of all source/sink 
properties are given in the Source and Sink Properties section of this manual. Once you have 
defined the properties, the icon will be displayed in black. From now on, you use this icon to 
access the properties of the source/sink. 

Among the properties associated with a source/sink are optional multiplier and schedule 
information. You would use the multiplier to proportionally increase the generation or removal 
of a contaminant for a particular source/sink. For example, if you have created a source/sink 
element with a certain emission rate per square meter of surface area (such as a floor covering), 
you could use this multiplier to account for the surface area of the source/sink for each zone in 
which you place a source/sink implementing this source/sink element. You could use a schedule 
to vary the emission/removal characteristics of a source/sink with time. For example, you could 
provide a schedule for an episodic source (burst source) that would periodically cause the release 
of a contaminant when performing a transient simulation. 

3.12.5.1 Source/Sink Properties 
This section provides detailed descriptions of the specific source/sink properties. Each of the 
following subsections are the context-sensitive help topics that you can access by pressing F1 
when working with property pages of the "Source/Sink Properties" property sheet. 

Source/Sink – Source/Sink Element Properties 
Source/Sink Number: This is the number that appears in the status bar when you highlight an 
icon. CONTAMW automatically assigns this number to each source/sink once they are defined. 
This number could change as you add and remove source/sinks to or from a project. Each time 
you save a project, the source/sink numbers are reassigned. Numbers are assigned beginning on 
the top level, starting from the upper-left corner of the SketchPad, moving left-to-right and top-
to-bottom of the SketchPad. 
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Source/Sink Element: 

Description: Field that shows a more detailed description of the specific sink/source element 
if entered by the user.  This description can be modified by pressing the "Edit Element" 
button next to the description field. 

Name: <required> You may select a previously defined source/sink element from those 
contained in the Name list. Click the "New Element" button to define a new element. To 
view or modify existing element data click the "Edit Element" button. Every airflow path 
must have an airflow element associated with it. This field may not be left blank. 

You can also access the CONTAMW Library Manager to import source/sink elements from 
library files by clicking the "Library" button (See Working with Data and Libraries).  

Model Summary: This summarizes the information associated with the source/sink element 
whose name is currently displayed in the Name field. 

Source/Sink – Multiplier and Schedule Properties 
Species: This is the species associated with the source/sink. 

Multiplier: A constant value by which the source is multiplied. This allows for a contaminant 
source to be defined per unit area and then multiplied by the area of the zone.  

Schedule: You can use a schedule to modify the source/sink rate as a function of time, and two 
source types, burst and decaying, require the use of a schedule. If there are previously defined 
schedules within the current project, you may select one from the Name list. Click the "New 
Schedule" button to define a new schedule. To view or modify an existing schedule click the 
"Edit Schedule" button. Setting this field to <none> indicates no schedule. (See Working with 
Schedules) 
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Source/Sink Element Types 
These are the source/sink element types or models that you can implement with CONTAMW. 
Refer to the related information for each specific model to obtain detailed descriptions of them. 

CONTAMW Elements: 
Constant Coefficient Model: The general source/sink model allows constant 
contaminant generation and deposition rates. 

Pressure Driven Model: This model is for contaminant sources that are governed by the 
pressure differences between zones. 

Cutoff Concentration Model: This model will reduce emissions as the concentration 
within the zone in which it is implemented approaches a specified cutoff concentration. 
This model may be appropriate for some sources of Volatile Organic Compound (VOC). 

Decaying Source Model: This model provides a source that will exponentially decay 
with time according to a user-defined time constant. This model may also be appropriate 
for some VOC sources. 

Boundary Layer Diffusion Model: Used to model reversible diffusion of a contaminant 
through the air-phase boundary layer of a material surface and the sorption of the 
contaminant into a sink with a linear sorption isotherm. 

Burst Source Model: Used to model an instantaneous release of a mass of contaminant 
within a zone. 

NRCC Elements: 
Currently not implemented. 

Source/Sink Element: Constant Coefficient Model 
CDGS ⋅−=  

G  =  Generation rate [mass of contaminant / time] 
D  =  Effective removal rate [mass of air / time] 
   Determine by multiplying the first-order removal rate of the contaminant [1 / time] by  
   air density and volume of the zone in which the source is to be located. 
C  =  Current concentration [mass of contaminant / mass of air] 

Name: Enter a unique name you want to use to identify the source/sink element. The element 
will be saved within the current project and can be associated with multiple source/sinks. 

Generation Rate: The rate at which the contaminant is introduced into the zone. 

Removal Rate: The rate at which the contaminant is removed from the zone. 

Species: Select a previously defined species from the drop down box. 

Description: Field for entering a more detailed description of the specific sink/source element. 
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Source/Sink Element: Pressure Driven Model 
The pressure source/sink model is intended to model contaminant sources that are controlled by 
the pressure differences between interior and exterior zones, e.g., radon or soil gas entry.  The 
governing equation is as follows: 

nPGS ∆⋅=  
S    =  contaminant source strength 
G    =  generation rate coefficient 
∆P  =  pressure difference 
n    =  pressure exponent 

 

Name: Enter a unique name you want to use to identify the source/sink element. The element 
will be saved within the current project and can be associated with multiple source/sinks. 

Generation Rate: This coefficient describes the rate at which the contaminant is introduced into 
the zone as a function of pressure difference. 

Pressure Exponent: Used to describe the dependence on pressure of the contaminant entry. 

Species: Select a previously defined species from the drop down box. 

Description: Field for entering a more detailed description of the specific sink/source element. 

Source/Sink Element: Cutoff Concentration Model 
For volatile organic compounds the source model is sometimes expressed as: 









−=

cutC
CGS 1

 
S    = source strength 
G   = generation rate coefficient 
C   = current concentration 
Ccut  = cutoff concentration at which emission ceases 
 

Name: Enter a unique name you want to use to identify the source/sink element. The element 
will be saved within the current project and can be associated with multiple source/sinks. 

Generation Rate: This coefficient describes the rate at which the contaminant is introduced into 
the zone as a function of concentration. 

Cutoff Concentration: The concentration level where the source ceases its emission. 

Species : Select a previously defined species from the drop down box. 

Description: Field for entering a more detailed description of the specific sink/source element. 
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Source/Sink Element: Decaying Source Model 
ctt

oGtS /e)( −⋅=  
Go  = initial generation rate 
t     = time since the start of emission 
tc    = time constant 
 

Name: Enter a unique name you want to use to identify the source/sink element. The element 
will be saved within the current project and can be associated with multiple source/sinks. 

Initial Generation Rate: Contaminant generation is controlled by a schedule. Contaminant 
generation begins when the schedule changes from a zero to a non-zero value (between zero and 
one). The initial generation rate is equal to the schedule value times the initial generation rate. A 
single schedule may be used to initiate several emissions at different times. 

Time Constant: The time at which the generation rate reaches 0.37 of the original rate. 

Species: Select a previously defined species from the drop down box. 

Description: Field for entering a more detailed description of the specific sink/source element. 

Note: You must associate a schedule with this type of source. 

Source/Sink Element: Boundary Layer Diffusion Model 
The boundary layer diffusion controlled reversible sink/source model with a linear sorption 
isotherm follows the descriptions presented in [Axley 1991]. The boundary layer refers to the 
region above the surface of a material through which a concentration gradient exists between the 
near-surface concentration and the air-phase concentration. The rate at which a contaminant is 
transferred onto a surface (sink) is defined as:  







 −⋅⋅=

k
C

CAdhS S
i

 
h   = film mass transfer coefficient over the sink 
d    = film density of air 
A    = surface area of the adsorbent 
Ci   = concentration in air 
CS  = concentration in the adsorbent 
k    = Henry adsorption constant or the partition coefficient 
 

Name: Enter a unique name you want to use to identify the source/sink element. The element 
will be saved within the current project and can be associated with multiple source/sinks. 

Film Transfer Coefficient: The average mass transfer coefficient of the contaminant within the 
boundary layer (or film) above the surface of the adsorbent. 

Film Density of Air: This is the average of the bulk air density and the near-surface density. 

Surface Mass: Enter the mass for a unit surface area and use the source/sink multiplier to enter 
the total area of the adsorbent. 
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Partition Coefficient: Coefficient that relates the concentration of the contaminant in the bulk-
air to that at the surface of the adsorption material. 

Species: Select a previously defined species from the drop down box. 

Description: Field for entering a more detailed description of the specific sink/source element. 

Source/Sink Element: Burst Source Model 
The burst model simulates an instantaneous addition of contaminant mass to a zone. 

Name: Enter a unique name you want to use to identify the source/sink element. The element 
will be saved within the current project and can be associated with multiple source/sinks. 

Mass added to zone: Enter a value for the instantaneous mass release into the zone. The 
addition of mass is controlled by a schedule; when the schedule changes from zero to a non-zero 
value, mass is added to the zone in one simulation time step. The amount of mass added is equal 
to the mass added to zone value times the schedule value. A single schedule can initiate several 
events at different times. 

Species: Select a previously defined species from the drop down box. 

Description: Field for entering a more detailed description of the specific sink/source element. 

Note: You must associate a schedule with this type of source. 
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3.13 Working with Occupant Exposure 
CONTAMW provides you with the ability to simulate the existence of occupants within a 
building. You can simulate the movement of occupants throughout the building, allow the 
occupant to leave the building, determine the amount of exposure to contaminants to which the 
occupant will be susceptible. Occupants can also generate contaminants within a building, so you 
can represent a contaminant source that moves through the building using an occupant.  

To implement an occupant, you must first define at least one species. You then place an exposure 
icon (shown below) on the SketchPad. Once you place the exposure icon on the SketchPad, you 
can define its characteristics, move, copy, and delete it. You must then define an occupant 
schedule for the exposure icon. The details of drawing, defining and modifying occupants are 
described in the following sections. 

Occupant exposure icon 

3.13.1 Creating Occupants 
You create an occupant by placing an exposure icon on the SketchPad (See Drawing Building 
Component Icons). You can place them in any blank cell of the SketchPad. The "Exposure" 
menu selection will be disabled (grayed out) if you pop-up on a location where CONTAMW 
does not allow the icon to be placed. 

3.13.2 Deleting Occupants 
You delete exposure icons using the icon deletion procedure (See Deleting Building Component 
Icons). Deleting occupant exposure icons from the SketchPad deletes the occupant data 
associated with the icon, but it does not delete any occupant-related schedules that you might 
have created. These schedules can only be deleted using the CONTAMW Library Manager, 
accessible through the Data menu for each type of data element. 

3.13.3 Modifying Occupants 
To modify the parameters of an occupant, you use the icon definition procedure (See Defining 
Building Component Icons) to display its properties and make the desired changes. You can also 
move and copy occupants. 

� Moving Occupant Exposure Icons 
Once you define an occupant, you can move the icon using the Cut and Paste functions of the 
Edit menu. You can move the occupant exposure icon anywhere within the level upon which it 
is currently located. 

� Copying Occupant Exposure Icons 
Once you define an occupant, you can copy the icon using the Copy and Paste functions of the 
Edit menu. You can copy an occupant to any blank cell on any level of a project. 
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3.13.4 Defining Occupants 
After you draw an exposure icon on the SketchPad you must define it using the icon definition 
procedure (See Defining Building Component Icons) to display and edit the properties. This will 
display the "Occupant Exposure Properties" property sheet. Detailed descriptions of all occupant 
exposure properties are given in the Occupant Properties section of this manual. Once you have 
defined the properties, the icon will be displayed in black. From now on, you use this icon to 
access the properties of the occupant. 

Among the optional properties associated with an occupant are multiplier, inhalation, and 
contaminant generation information. You would use the multiplier to proportionally increase the 
contaminant generation rate associated with an individual exposure icon to represent the 
contaminant generation of multiple occupants. You would input contaminant generation 
information if you want to account for the contaminants generated by an occupant while they are 
in the building. Inhalation information is useful for determining the dose received by an occupant 
based upon their exposure to a contaminant.  CONTAMW does not currently implement the 
calculation of contaminant dose, however, you can use the exposure information to determine the 
dose of an occupant. 

3.13.4.1 Occupant Properties 
This section provides detailed descriptions of the specific occupant properties. Each of the 
following subsections are the context-sensitive help topics that you can access by pressing F1 
when working with property pages of the "Occupant Exposure Properties" property sheet. 

Occupant – Occupant Data Properties 
Occupant Number:  This is the number that appears in the status bar when you highlight an 
icon. CONTAMW automatically assigns this number to each exposure icon once it is defined. 
This number could change as you add and remove occupants to or from a project. Each time you 
save a project, the occupant numbers are reassigned. Numbers are assigned beginning on the top 
level, starting from the upper-left corner of the SketchPad, moving left-to-right and top-to-
bottom of the SketchPad. 

Body weight/Peak inhalation rate: CONTAMW uses these parameters to compute a 
contaminant dose. Inhalation is defined in terms of a peak rate and a schedule. Body weights for 
typical persons and inhalation values for different activity levels are available in the [EPA 1989]. 

NOTE: This feature and the associated Inhalation Schedule are not implemented in CONTAMW 
2.0, because contaminant dose calculation is no longer performed by CONTAMW. However, 
occupant exposure is still determined from which you can obtain your own dose calculations. 

Description: Field for entering a more detailed description of the specific exposure. 

Inhalation Schedule: Use this when you want to modify the peak inhalation rate according to a 
schedule. If there are previously defined schedules within the current project, you may select one 
from the Name list. Click the "New Schedule" button to define a new schedule. To view or 
modify an existing schedule click the "Edit Schedule" button. Setting this field to <none> 
indicates no schedule. (See Working with Schedules) 
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Edit Occupancy Schedule: Press the "Edit Occupancy Schedule" button to display the 
Occupancy Week Schedule dialog box and define the movement of this occupant within the 
building. 

Occupant – Contaminant Generation Properties 
Multiplier: Use the multiplier to modify the generation rate of an occupant. You could define 
the contaminant generation rate(s) for a single occupant and use the multiplier to represent a 
generation rate of multiple occupants.  

Generate Contaminants: This checkbox is used to turn on and off the contaminant generation 
of the occupant. If the box is checked, contaminants will be generated. This is useful for 
contaminant generation such as that of carbon dioxide due to human metabolism. 

Generation Data: A list of available contaminants is displayed in the textbox provided.  You 
can highlight these contaminants and select the generation rate for each in the edit box below the 
contaminant list.   

Generation Schedule: A new inhalation schedule is defined by pressing the "New Schedule" 
button and following the directions for editing a Week Schedule.  

Description: Field that shows a more detailed description of the specific schedule if entered 
by the user.  This description can be modified by pressing the edit schedule button next to the 
description field and then changing the description field for the schedule. 

Name: This drop down box contains the names of all previously created schedules.  The 
schedule selected from this box will then define the generation schedule for the exposure 
element being viewed. 
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3.14 Working with Data and Libraries 
CONTAMW enables you to share certain types of data between building components contained 
within a project as well as between projects. The sharing of data within a project (locally) is 
accomplished by allowing you to associate multiple building components with data elements 
defined within a project. Sharing data between projects is accomplished by exporting data 
elements from one project into CONTAMW library files and then retrieving the data elements 
into another project from the library files. The following table lists the different types of data 
elements implemented by CONTAMW. All of the data elements can be shared within a project, 
and all but occupancy schedules can be shared between projects.  

Library/Local Data Elements 
Contaminant-related (LB0)  

    Species 

    Source/Sink Elements 

    Contaminant Filters 

    Kinetic Reactions 

Wind Pressure Profiles (LB2) 

Airflow Elements (LB3) 

Duct flow Elements (LB4) 

 

Local-Only Data Elements 
Occupancy Schedules 

 

� Data Elements 
You create and modify data elements according to the procedures given throughout the "Using 
CONTAMW" section of this manual for the specific data elements. Once you have created a data 
element, you can associate it with the relevant building components as you create them. You do 
this by selecting the desired element from the local list that CONTAMW presents to you when 
you are editing the properties of a particular building component. To share data elements 
between project files, you must utilize the CONTAMW Library Manager. You must also use the 
CONTAMW Library Manager to delete data elements from either the local project or the library. 
To delete local data elements, they must not be referenced by any building components. 

� Library Files 
CONTAMW Libraries are files that contain the descriptions of sharable data elements. Each type 
of sharable data element is stored in a different library file. You can create as many of each type 
of library file that you want, and store them anywhere within the file structure of your computer. 
Each type of library file is associated with a different three-character extension as shown in the 
table above.  
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� CONTAMW Library Manager 
The CONTAMW Library Manager, shown in the following figure, is a dialog box that is 
displayed when you access data elements from the Data menu or by clicking on a "Library…" 
button when editing the properties of one of the building components that utilizes library data 
elements. This dialog box is divided into three sections: Library File, Library Elements and 
Local Project Elements sections. The Library File section displays the name of the currently 
displayed library file and allows you to save, rename and open new and existing library files. The 
Library Elements section displays the data elements contained in the library file that is currently 
listed in the Library File section. The Local Project Elements section displays the data elements 
that are contained in the current project file. 
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3.14.1 Opening Libraries 
If a library file is currently opened, the name of the file will be displayed in the "Name" field of 
the "Library File" section of the Library Manager. You can open a CONTAMW library file using 
the "Browse…" button of the Library Manager. This will activate the File Open dialog box 
typical of Windows applications. This dialog box is set to display only those files having the 
three-character file extension associated with the type of data elements that you are currently 
working with. Follow the typical procedure for opening a file using the Windows operating 
system.  

CONTAMW 2.0 library files are of a different format than the 1.0 version.  CONTAMW 2.0 will 
allow you to open a 1.0 version file and you will then be required to give the files a name when 
saving the converted file. It is suggested that you save the file under a different name from that 
of the 1.0 formatted library file. 

3.14.2 Creating Libraries 
Using the CONTAMW Library Manager, you create new libraries one of two ways. You can 
either save an existing library under a new name using the "Save As…" button, or use the "New" 
button of the Library File section of the CONTAMW Library Manager dialog box. The "Save 
As…" method makes a copy of the currently displayed library file under a new name, but 
maintains the original file. The "New" method clears the data currently displayed and allows you 
to start with an empty library file. 

3.14.3 Deleting Libraries 
You must use the file deletion commands of your operating system to delete CONTAMW library 
files. 

3.14.4 Modifying Libraries 
You modify CONTAMW library files using the CONTAMW Library Manager. The 
CONTAMW Library Manager allows you to create new data elements within the library, copy 
data elements from the local project into the library, modify library data elements, and delete 
data elements from the library. 

� Creating Library Data Elements 
You use the "New" button contained within the "Library Elements" section of the CONTAMW 
Library Manager to create a new data element. You can only create the type of data element that 
is currently being displayed by the Library Manager (e.g. airflow elements, duct flow elements, 
schedules, etc. ). The "New" button will activate the CONTAMW dialog box associated with 
creating the type of data element that you are currently working with. 

Species must be available in order to create new contaminant-related elements such as 
Sources/Sinks, Filters and Kinetic reactions. 

� Copying Library Data Elements (between the Project and Library) 
You can either copy data element from a library to the local project or from the local project to 
the library. All copying is done between the local project and the library file that is currently 
indicated in the "Name" box of the Library File section of the CONTAMW Library Manager. If 
the name box is blank, then you are dealing with a new/unnamed library file. To copy data 
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elements, you use the "Copy ->" and "<- Copy" buttons. These copy buttons indicate the 
direction of the copy operation. If an element exists in both the library file and the local project, 
then the copy buttons will be disabled to prevent you from overwriting elements with the same 
name. You may rename local data elements without affecting their associations with building 
components that refer to them in the local project. 

Some elements rely on other types of elements for proper implementation, e.g., source/sinks 
require an associated species and week schedules require day schedules. If you copy one of these 
elements that requires a sub element, CONTAMW will prompt you to replace existing elements 
of the same name if they already exist within the destination file. 

� Modifying Library Data Elements 
To modify a library data element, you must first highlight the Element Name within the list of 
elements in the Library Elements section of the CONTAMW Library Manager. You then click 
on the "Edit" button next to the list. This will activate the CONTAMW dialog box associated 
with displaying the properties of the type of data element with which you are currently working. 
You then make the desired changes and click the "OK" button to make the changes take affect. 

� Deleting Library Data Elements 
To delete a library data element, you highlight the Element Name in the Library Elements 
section of the CONTAMW Library Manager then click on the "Delete" button next to the list. 
You will be prompted to confirm the deletion, and the data element will no longer be displayed 
in the list of Library Elements. However, the deletion will not be affected until you save the 
library file. You can retrieve the previously deleted data elements by reopening the library file as 
long as you don't save the file after deleting the elements. 

Deleting data elements that have associated sub-elements will not delete the sub-elements. You 
must delete the sub-elements using a separate Library Manager operation. 

3.14.5 Modifying Local Data 
You modify local lists of data elements using the CONTAMW Library Manager. The Library 
Manager allows you to create new local data elements, copy data elements from the library into 
the local project, modify local data elements, and delete local data elements. 

� Creating Local Data Elements 
You use the "New" button contained within the "Project Elements" section of the Library 
Manager to create a new data element. You can only create the type of data element that is 
currently being displayed by the Library Manager (e.g. airflow elements, duct flow elements, 
schedules, etc. ). The "New" button will activate the CONTAMW dialog box associated with 
creating the type of data element that you are currently working with. 

Species must be available in order to create new contaminant-related elements such as 
Sources/Sinks, Filters and Kinetic reactions. 

� Copying Local Data Elements (between the Project and Library) 
See Copying Library Data Elements. 
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� Modifying Local Data Elements 
The Library Manager provides you with another means of accessing local project elements. This 
is in addition to the method of accessing building component properties presented throughout the 
Using CONTAMW section of this manual. You must first highlight the Element Name within 
the list of elements in the Project Elements section of the Library Manager. You then click on the 
"Edit" button next to the list. This will activate the CONTAMW dialog box associated with 
displaying the properties of the type of data element that you are currently working with. You 
then make the desired changes and click the "OK" button to make the changes take affect. 

� Copying Data Elements (within a Project) 
You can use the Library Manager to create elements that are similar to existing elements but 
have a different name. To do this you copy a project element to the library (you don’t have to 
have an existing library file open), give the library element a new name, make the modifications 
you desire and copy the element back into your project. 

� Deleting Local Data Elements 
You can only delete local data elements if they are not referenced by any building components 
within the project. To delete a project data element, you highlight the Element Name in the 
Project Elements section of the CONTAMW Library Manager then click on the "Delete" button 
next to the list. The "Delete" button will only be enabled if the currently highlighted element is 
not referenced within the project. You will be prompted to confirm the deletion, and the data 
element will no longer be displayed in the list of Project Elements. However, the deletion will 
not be affected until you save the project file. You can retrieve the previously deleted data 
elements by reopening the project file as long as you don't save the file after deleting the 
elements. 

Deleting data elements that have associated sub-elements will not delete the sub-elements. You 
must delete the sub-elements using a separate Library Manager operation. 
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3.15 Working with Weather and Wind 
CONTAMW enables you to incorporate the effects of weather on a building. Weather 
parameters include ambient temperature, barometric pressure, wind speed, wind direction and 
also outdoor contaminant levels. The type of weather data you require for a simulation depends 
on the type of simulation you are performing, whether you want to account for the effects of 
wind, and whether or not you are simulating contaminants. If you are performing a steady-state 
airflow simulation, you will only need steady state weather and wind data. If you are performing 
a transient airflow simulation, you can use either steady state or transient weather data. Transient 
weather data is implemented through the use of weather files. If you are performing transient 
contaminant simulations, you can use either steady-state or transient ambient contaminant data. 
Transient ambient data is implemented via the use of ambient contaminant files (See 
Contaminant Files). 

� Steady State Weather 
When you use steady state weather data, CONTAMW keeps the ambient temperature, 
barometric pressure, wind speed and direction and relative humidity constant during a 
simulation. Detailed descriptions of these parameters are given in the following sections. 

� Transient Weather 
You can use transient weather data to simulate the changing outdoor weather and wind 
conditions when performing a transient simulation. Transient weather data is stored in a weather 
file that you must create according to a special format as specified under the Weather File 
Format section that follows. Weather files contain ambient temperature, pressure, wind speed 
and direction and humidity ratio for discrete intervals of each day for at least one day and up to 
one year. If the intervals between data in the weather file don't match the simulation time step, 
CONTAMW will linearly interpolate the weather data to obtain a value at the required time step. 

� Wind 
Wind pressure can be a significant driving force for air infiltration through a building envelope. 
It is a function of wind speed, wind direction, building configuration, and local terrain effects. 
CONTAMW enables you to account for the effects of wind pressure on flow paths through the 
building envelope (external airflow paths). You define how you want to account for wind effect 
for each external flow path on a case-by-case basis. In CONTAMW, you can either choose to 
ignore the effects of wind on an envelope penetration, define wind pressure to be constant for 
each envelope penetration, or implement variable wind pressures for envelope penetrations.  

CONTAMW provides a general approach to handling the variable effects of wind on the 
building envelope. This approach requires you to provide CONTAMW with information related 
to the determination of a local wind pressure coefficient for the building surface. 

For a general introduction to the effects of wind pressure on buildings, see Chapter 16, Air flow 
Around Buildings, in the 2001 ASHRAE Fundamentals Handbook [ASHRAE 2001]. The 
following is an overview of how CONTAMW handles these effects. 

The equation for wind pressure on the building surface is 
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where  

VH   Approach wind speed at the upwind wall height (usually the height of the building) 
Cp   Wind pressure coefficient 

The wind pressure coefficient can be further generalized in terms of a local terrain effects 
coefficient and the direction of the wind relative to the wall under consideration. The following 
equation is that used by CONTAMW when calculating wind pressures on the building. 
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where 

ρ    ambient air density 
Vmet   wind speed measured at meteorological station 
Ch    wind speed modifier coefficient accounting for terrain and elevation effects 
f(θ)   coefficient that is a function of the relative wind direction. CONTAMW refers to this 

function as the wind pressure profile. 
 

The relative wind direction is given by 

 sw θθθ −≡   
where 

θw  wind azimuth angle (N = 0°, E = 90°, etc.), and 
θs   surface azimuth angle. 

 

ρV2
met / 2 in the above equation is computed by CONTAMW from the steady state or weather 

file temperature, pressure and wind speed data. 

Cp, the pressure coefficient used by ASHRAE, is equivalent to f(θ ) in the CONTAMW 
formulation. In CONTAMW, you must define the function f(θ ) in the form of wind pressure 
profiles as explained later. See page 25.8 of the 1997 ASHRAE Fundamentals Handbook 
[ASHRAE 1997] for details relating to pressure coefficient data. 

The wind pressure modifier, Ch, accounts for the difference between Vmet and VH. The value for 
Ch will typically be constant for all openings on a given building. However, CONTAMW allows 
you to define a default value that CONTAMW will use for each flow path connected to the 
ambient (See Wind Properties) or to set this value individually for each of these paths. 
CONTAMW uses the following formula to compute the value of Ch: 
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where H is the wall height and Ao and a depend on the terrain around the building [Chapter 16 of 
ASHRAE 2001 and ASHRAE 1989, p 14.3]: 
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Terrain  
Type 

Coefficient 
(Ao) 

Exponent 
(a) 

Urban 0.35 0.40 

Suburban 0.60 0.28 

Airport 1.00 0.15 

 

The wind speed, Vmet, is usually measured at an airport (open terrain) at an elevation, Hmet = 10m, 
above the ground. The wind speed, Vo, at that same elevation at the building site is given by 

  VAV oo =

The wind speed, VH, at the top of the wall, elevation H, is then given by 
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3.15.1 Defining Weather and Wind 
You define weather that you want CONTAMW to use based on the type of simulation you want 
to perform. You will either define steady state weather or transient weather. It is best to perform 
a set of steady state simulations prior to performing transient simulations. This may enable you 
to better identify any problems that may arise from working with transient weather. CONTAMW 
also provides a means to verify that you have your wind related data input correctly (See 
Checking Wind). 

3.15.1.1 Defining Steady State Weather and Wind 
To define the steady state weather and wind data you use the Edit Weather Data… selection of 
the Weather menu or the F7 keyboard shortcut. This will display the "Weather and Wind 
Parameters" property sheet. The property sheet contains four different pages of parameters 
including: Weather, Wind, Location and Wind Pressure Display. Detailed descriptions of all 
wind and weather properties are given in the Weather and Wind Properties section of this 
manual. 

You use the Weather page to define steady state weather and wind data. The Location page 
allows you to input the altitude of the building site which CONTAMW will use to determine a 
default barometric pressure if you do not know what it should be for a given building site. 
Default values of these two pages will provide conditions of no wind, 20°C and a barometric 
pressure of 1 atmosphere (approximately 101 kPa).  

The Wind page parameters allow you to enter the prevailing wind direction and other values 
used by CONTAMW to determine a wind speed modifier. The wind speed modifier is 
determined from the local terrain constant and the velocity profile exponent. Default values are 
provided for suburban terrain. 
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� Checking Wind Pressure Data 
You use the Wind Pressure Display page to input values that will be used to display wind 
pressures on the building envelope when you display the Wind Pressure Results. These values 
are not used by CONTAMW when performing a simulation. To display the wind pressure results 
use the Wind Pressure selection of the View menu. This feature is provided so that you can 
verify the wind speed and direction information visually on the SketchPad. The wind pressures 
that are displayed here are not necessarily the same as will be displayed when viewing 
simulation results on the SketchPad. 

When you choose to display wind pressure results, red lines will appear on the SketchPad 
indicating the wind pressure at certain airflow paths. Wind pressure will only be displayed for 
those airflow paths connected to the ambient zone, having the Wind Pressure Option set to 
Variable and having a wind induced pressure drop across the opening that is not equal to zero. 
The wind pressure display will reveal the relative magnitude of the pressure drop and the 
direction of airflow across the openings in the building envelope. You can move the caret to each 
of the airflow paths for which a wind pressure is being displayed to show the wind pressure, 
azimuth angle and elevation of the airflow path in the CONTAMW status bar. When reviewing 
this display, you should look to see if the direction of flow makes sense based on the information 
that you entered within the Wind Pressure Display property page. 

3.15.1.2 Defining Transient Weather and Wind 
In order to implement transient weather and wind, you must create a CONTAMW-compatible 
weather file. You must create the weather file external to CONTAMW. NIST provides a utility 
program, WEATHER 2.0, to create CONTAMW-compatible weather files.  

WEATHER 2.0 enables you to convert existing CONTAMW 1.0 weather files to the 2.0 format 
weather and ambient contaminant files. You can also convert TMY2 and EnergyPlus (.EPW) 
weather files to the CONTAMW 2.0 weather file format and create weather file templates into 
which you can place your own data (e.g., experimental data). Both weather and ambient 
contaminant files are ASCII text files that can be created and edited using spreadsheet software 
according to the formats provided within this manual. 

� Weather File Format 
The CONTAMW weather file is a tab-delimited ASCII text file. These files are easily created, 
imported and modified using typical spreadsheet applications. They can be saved as tab-
delimited text files for use with CONTAMW. It is described below because it may be necessary 
for the you to create a weather file from sources not already provided. In the listing below I1 
indicates a character string, I2 indicates a short integer and R4 indicates a four-byte real 
number. Individual lines of data are separated by dashes (these dashes are only shown here for 
format presentation purposes and should not be included in the actual files). Each day must begin 
with time 00:00:00 and end with time 24:00:00. The time interval between 00:00:00 and 
24:00:00 can be either regular or irregular – CONTAMX will interpolate as necessary. 
Comments are allowed and are indicated by an "!" (exclamation point). Anything that appears on 
a line following a comment indicator is ignored by the weather file reader. Comments are 
provided by the weather file creation software (Weather 2.0) that show header information for 
the data in the file. 
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WeatherFile ContamW 2.0  ! file and version identification 
----- 
I1 descr[]      ! weather file description 
----- 
I1 start _date   ! day of year (1/1 – 12/31) 
I1 end_date     ! day of year (1/1 – 12/31) 
----- 
!Date  DofW  Dtype  DST  Tgrnd   
----- 
! for each day: start_date – end_date 
 I1 date      ! date (1/1 – 12/31) 
   I2 dayofwk   ! day of week Sun – Sat (1 - 7) 
   I2 daytype   ! type of day for schedule reference (1 – 12) 
   I2 DST       ! daylight savings time indicator (0 or 1) 
   R4 Tground   ! ground temperature [K]  
----- 
!Date Time Ta  Pb  Ws  Wd  Hr  Ith  Idn  Ts  Rn  Sn 
----- 
! for each day: start_date – end_date 
! for each time: 00:00:00 - 24:00:00 increment may be variable 
   I1 date     ! date (1/1 – 12/31) 
   I1 time     ! time- of- day (00:00:00 – 24:00:00) 
   R4 tmpambt  ! ambient temperature [K] 
   R4 barpres  ! barom. pressure(Pa) NOT corrected to sea level 
   R4 windspd  ! wind speed [m/s] 
   R4 winddir  ! wind direction [deg]: 0=N, 90=E, 180=S, ... 
   R4 humratio ! humidity ratio [g H20/kg dry-air] 
   R4 solhtot  ! total solar flux on horizontal surface [W/m^2] 
   R4 solhdif  ! diffuse solar flux on horizontal surface [W/m^2] 
   R4 tskyeff  ! effective sky temperature [K] 
   I2 rain     ! rain indicator 0 or 1 
   I2 snow     ! snow indicator 0 or 1 
----- 

The Tground, solar, sky, rain and snow values are not used in CONTAMW. They are reserved 
for thermal analysis, if it is added to the program. 

� Editing Weather Files 
You can import weather files into a spreadsheet program for editing. However you must make 
sure that the date format is compatible with CONTAMW when you save the file. One well-
known spreadsheet program will convert the CONTAMW date format of mm/dd into the mmm-
dd form. For example the CONTAMW date format for January 1 is "1/1", but the spreadsheet 
program will convert it to "Jan-01" unless you "force" it to import the first column of data – the 
one that contains date information – as text. Another option is to accept the default importing 
option then change the cell format for each date to the CONTAMW format mm/dd prior to 
saving the file as tab-delimited. 
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3.15.1.3 Weather and Wind Properties 
This section provides detailed descriptions of the specific steady state weather properties. Each 
of the following subsections are the context-sensitive help topics that you can access by pressing 
F1 when working with property pages of the "Weather and Wind Properties" property sheet. 

Weather and Wind – Wind Properties 
The wall height, terrain and exponent are used to calculate the wind speed modifier.  

Relative North: The direction to relative north will be used relating wall angles on the 
SketchPad to true north for determining wind direction effects. Enter the clockwise angle from 
vertical on the CONTAMW SketchPad to true north. 

Roof or Wall Height: Enter the height of the upwind wall of the building. This is the value of H 
in the equations presented in the section Working with Weather and Wind. Entering a value of 
zero will reduce the wind speed modifier to zero. This will cause computed wind pressures to be 
zero no matter what the wind speed, unless you override the wind pressure coefficients of 
exterior airflow paths. Figure 5 in Chapter 14 of the 1993 ASHRAE Fundamentals Handbook 
[ASHRAE 1993] shows relative wind pressures on the face of a building based on the local wind 
pressure at the top of the wall. 

Terrain & Exponent: Enter the values that describe the wind speed profile for the type of 
region in which your building is located. Figure 4 in Chapter 14 of the 1993 ASHRAE 
Fundamentals Handbook [ASHRAE 1993] shows terrain constants and velocity profile 
exponents for representative areas. 

Modifier: This is the wind speed modifier, Ch, calculated by CONTAMW based on the Wall 
Height, Terrain and Exponent values above. This value will be the default provided for each 
envelope airflow path that you create on the SketchPad and for which you select the variable 
wind pressure option. See section Working with Weather and Wind for a more detailed 
explanation of this term. 

Weather and Wind – Weather Properties 
The following constant values are used by CONTAMW when you specify the use of steady state 
weather conditions when performing either steady state or transient airflow simulations (See 
Working with Simulations).  

Temperature: CONTAMW uses the ambient temperature when calculating outside air density 
and building stack effects. 

Absolute Pressure: Absolute barometric pressure (not corrected to sea level). If you don't know 
this value, you can enter the altitude of the building site on the Location Properties page to have 
CONTAMW calculate the barometric pressure for you. 

Relative Humidity: Relative humidity as a fraction, i.e., between 0.0 and 1.0. This value will be 
used along with Ambient Temperature and Pressure to calculate the Humidity Ratio and Mass 
Fraction of H2O. 

Humidity Ratio: The mass of water vapor per mass of air (excluding water vapor) calculated 
based on the Temperature, Pressure and Relative Humidity. 
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Humidity Ratio = Mass Fraction / (1 – Mass Fraction) 

Mass Fraction (H2O): The mass of water vapor per mass of air (including water vapor). These 
are the default units of contaminants in CONTAMW. This value is provided so you can use it as 
the default contaminant concentration of H2O. 

Wind Speed: Magnitude of the wind velocity. 

Wind Direction: Direction from which the wind blows as measured in degrees clockwise from 
true north. 

Day Type: This is the type of day you want to use when performing a simulation with steady 
airflows and no weather file. The Day Type corresponds to one of the twelve day schedules that 
you can create. 

Weather and Wind – Location Properties 
Longitude, latitude, and time zone are currently not used by CONTAMW. They have been 
included for potential use in the future if heat transfer analysis is implemented within the 
program. 

Altitude: CONTAMW uses the site altitude to determine a default absolute barometric pressure 
for the steady state weather data. 

Weather and Wind – Wind Pressure Display Properties 
The wind pressure display values are used to calculate the wind pressures displayed on the 
screen in wind pressure display mode. You activate the wind pressure display mode by selecting 
Wind Pressure from the View menu. 

NOTE: These values are not used by CONTAMW when performing a simulation. To display the 
wind pressure results use the Wind Pressure selection of the View menu. This feature is 
provided so that you can verify the wind speed and direction information visually on the 
SketchPad. (See Checking Wind Pressure Data in the Defining Steady State Weather and Wind 
section)   

Ambient Temperature: The ambient temperature is used to calculate outside air density and 
building stack effects. 

Absolute Pressure: Be sure to enter the absolute barometric pressure instead of pressure 
corrected to sea level. 

Wind Speed/Direction: Enter the wind speed for the site. The wind direction is calculated in 
degrees clockwise from true north. 

Day Type: This is the day type as defined in the Week Schedule . 
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3.16 Working with Schedules 
Schedules provide you with the ability to modify various parameters based on the time of day 
and day of the week. Schedules apply when performing both transient and steady-state 
simulations. The steady-state simulation date and time will be used to access the schedule values. 
You use schedules to provide a fractional multiplier to parameters at times which you define. 
You can schedule items such as the flow through airflow paths, the outdoor air intake of simple 
air handling systems, contaminant source/sinks, the location of an occupant within a building and 
zone temperatures.  

CONTAMW provides occupant schedules and non-occupant schedules which are split up into 
week schedules which are in turn made up of one or more day schedules. Non-occupant week 
schedules can be associated with as many schedulable items as you need, whereas occupant 
week schedules can only be applied to a single occupant. Only non-occupant schedules can be 
shared between CONTAMW project files using the CONTAMW Library Manager. Occupant 
schedules can't be shared between projects, because they are dependant on the level and zone 
names which may be different between projects. The following sections provide detailed 
information related to the creation, modification and deletion of schedules in CONTAMW. 

3.16.1 Creating Schedules 
You can create schedules using either the CONTAMW Library Manager (see Working with Data 
and Libraries) or wherever a "New Schedule" button is provided when working with various 
building component property sheets (e.g. airflow paths, ducts, source/sinks, and occupant icons).  

� Non-occupancy Schedules 
You create non-occupant schedules by first selecting to create a new week schedule as outlined 
above which will display the Week Schedule dialog box. You must then define one or more day 
schedules that you then associate with each day of the week schedule. Each week schedule 
consists of 12 days – one for each day of the week and five more days that you can use for 
special situations such as holidays. New day schedules are created from the Week Schedule 
dialog box by clicking on the "New Schedule" button. This will display the Day Schedule dialog 
box whose features are explained below. 

� Temperature Schedules 
Temperature schedules are a type of non-occupant schedule. Unlike other non-occupant 
schedules they have units associated with them. Temperature schedules are only associated with 
zones and are considered separately from other non-occupant schedules when creating and 
editing. For instance, when displaying a list of temperature schedules, only those non-occupancy 
schedules having temperature units will be displayed and not those that are unitless. 

� Occupancy Schedules 
You create occupant schedules by first creating an occupant exposure icon (see Creating 
Occupants). You then click on the "Edit Occupancy Schedule" button that is provided on the 
Occupant Data property page of the "Occupant Exposure Properties" property sheet. 
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3.16.2 Modifying Schedules 
You modify existing non-occupancy week and day schedules through the Week Schedule and 
Day Schedule dialog boxes respectively. Edit occupancy schedules by editing the properties of 
existing occupant exposure icons. The details of editing schedules are presented in the following 
sections. 

3.16.3 Deleting Schedules 
You can only delete occupancy week schedules by deleting the associated occupant exposure 
icon. Deleting all other schedules can only be accomplished using the CONTAMW Library 
Manager (see Working with Data and Libraries) which will only allow you to delete those 
schedules that are no longer associated with any occupants, zones or other building components. 

3.16.4 Week Schedule Properties 
These are the properties and methods you use to define non-occupancy week schedules. You 
must associate a day schedule with each day of a week schedule (7 days of the week plus 5 extra 
days). The extra days are provided for any day that may have a non typical schedule, such as a 
holiday. Once defined, you may display the schedule graphically by pressing the "Display 
Graphically" button. 

Name: This is the name you give to this week schedule. This name must be unique among the 
week schedules within this project. 

Units: Select the temperature units to use when defining a zone temperature schedule. This 
control will only be available if these properties are accessed from a zone property sheet, Zone 
Data or via the Data  →  Week Schedules Temperature… menu selection. 

Description: Field for entering a more detailed description of the specific schedule. 

Day Schedules: Every "Week Schedule" consists of 12 days that must be defined.  The days are 
defined by "Day Schedules".  These day schedules may or may not be unique for each of the 12 
days. If the project has no available day schedules a new day schedule must be defined. Do this 
by pressing the "New Day Schedule" button, then editing the day schedule as explained in the 
section entitled "Day Schedule."  You can edit existing day schedules by selecting them in the 
"Available Schedules" list box and then pressing the "Edit Day Schedule" button, then following 
the procedure explained in the Day Schedule section. If a day has already been associated with a 
day schedule you can change it by first highlighting the day to be changed in the Day Schedules 
list box, highlighting the day schedule to replace the existing schedule, and then pressing the "<< 
Replace <<" button. 

Only those day schedules of the same type as the week schedule will appear in the list of day 
schedules, i.e., dimensionless or temperature. 

3.16.5 Day Schedule Properties 
These are the properties and methods you use to define day schedules. You may display the 
schedule graphically by pressing the "Display Graphically" button. 

Name: This is the name you give to this day schedule. This name must be unique among the day 
schedules within this project. 
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Description: Field for entering a more detailed description of the specific schedule. 

Shape: Use this check box to set how CONTAMW interprets values between the data points you 
define. A rectangular graph will create a step function for the data points. A trapezoidal graph 
will generate a sloped line between the data points provided by interpolating a straight line 
between the data points.  

Schedule Data: These are the time/multiplier pairs that you set to define a day schedule. The 
times are entered in the hh:mm:ss format, and you must provide leading and trailing zeros; for 
example 9:30 am would be entered as 09:30:00 not as 9:30:00.  

For dimensionless schedules, the value is a multiplier between 0.0 and 1.0 used to adjust the 
entered value for the simulation feature at the associated time defined in the schedule otherwise 
enter the desired temperature and units for temperature schedules. 

To insert a new data point: 
Highlight the data point after which you want to insert a new schedule point, enter the 
new time/multiplier pair in the "Time" and "Value" edit box next to the insert button, 
press the "<< Insert <<" button to add the value to the list.  

To modify an existing data point: 
Select the data point that you wish to modify from the list, enter the revised data, and 
press the "<< Replace <<" button to overwrite the previously entered data point.  

To delete an existing data point: 
Select the data point you want to delete from the list and click the "Delete" button. You 
can not delete 00:00:00 or 24:00:00. 

3.16.6 Occupant Week Schedule Properties 
These are the properties and methods you use to define occupant week schedules.  

Description: Field for entering a more detailed description of the specific schedule. 

Day Schedules: Every "Occupancy Week Schedule" consists of 12 days that must be defined. 
The days are defined by Occupant Day Schedules. These schedules may or may not be unique 
for each of the 12 days. If the project has no available day schedules a new day schedule must be 
defined. This is done by pressing the "New Day Schedule" button then editing the day schedule 
as explained in the Occupant Day Schedule section. You may edit existing day schedules by 
selecting them in the "Available Schedules" list box and then pressing the "Edit Schedule" 
button, then following the procedure explained in the Occupant Day Schedule section. If a day 
has already been associated with a day schedule, you may changed it by first highlighting the day 
to be changed in the Day Schedules list box, then highlighting the day schedule to replace the 
existing schedule, and finally pressing the "<< Replace <<" button. 

3.16.7 Occupant Day Schedule Properties 
These are the properties and methods you use to define occupant day schedules.  

Name: This is the name you give to this occupant day schedule. This name must be unique 
among the occupant day schedules within this project. 

Description: Field for entering a more detailed description of the specific schedule. 
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Schedule Data:  These are the time/location data points that you set to define an occupancy day 
schedule. The times are entered in the hh:mm:ss format, and you must provide leading and 
trailing zero’s; for example 9:30 am would be entered as 09:30:00 not as 9:30:00. The location 
consists of a level and zone in which the occupant resides for the indicated time period. Select a 
value of "null" from the zone list to indicate the occupant is not in the building for a given time 
period.  

To insert a new data point: 
Highlight the data point after which you want to insert a new schedule point, enter the 
new time/location pair in the "Modify Data" block to the right of the insert button, press 
the "<< Insert <<" button to add the data to the list.  

To modify an existing data point: 
Select the data point that you wish to modify from the list, enter the revised data, and 
press the "<< Replace <<" button to overwrite the previously entered data point.  

To delete an existing data point: 
Select the data point you want to delete from the list and click the "Delete" button. You 
can not delete 00:00:00 or 24:00:00. 
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3.17 Working with Simulations 
CONTAMW allows you to perform several types of simulations. The type of simulation you 
wish to perform depends on the goal of your analysis. You can perform simulations to determine 
just interzonal airflows and pressure differences, or you can also have CONTAMW solve for 
contaminant concentrations within each zone of a building. CONTAMW provides the ability to 
perform several combinations of steady state, transient and cyclical simulations of both airflow 
and contaminant dispersal.  

The following table shows the different combination of simulation methods you can apply using 
CONTAMW. 

Airflow 
Simulation 

Contaminant 
Simulation 

Purpose 

Steady 
State 

None Used to obtain airflows  and pressure differentials 
under constant building system and/or weather 
conditions. 

Steady 
State 

Steady State Used to obtain equilibrium contaminant 
concentrations under conditions of steady airflow. 

Steady 
State 

Transient Used to obtain a time history of contaminant 
concentrations under conditions of steady airflow. 
This is similar to the previous table entry but will 
allow you to observe the contaminant concentrations 
for each time step leading up to the final time step. 

Steady 
State 

Cyclic Used when it's important for initial contaminant 
concentrations to match the final concentrations 
under steady airflow conditions. This provides a 
method of simulating a typical pattern of operation 
by simulating only a representative time period (e.g. 
one day). 

Transient None Used to obtain a time history of airflows and pressure 
differentials under changing building system and/or 
weather conditions. 

Transient Steady State Not allowed 

Transient Transient Used to obtain time histories of airflows, pressure 
differentials and contaminant concentrations under 
changing building system and/or weather conditions. 

Transient Cyclic Used when it's important for initial contaminant 
concentrations to match the final concentrations 
under transient airflow conditions. This provides a 
method of simulating a typical pattern of operation 
by simulating only a representative time period (e.g. 
one day). 
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To perform a simulation, you must set the simulation parameters, run the simulation, and view 
simulation results. Simulation parameters are categorized by Run Control, Numerics, and Output 
properties. Run Control properties include the simulation methods, simulation dates and times, 
type of weather to use (steady or transient), and simulation time step. Numerics properties 
include convergence criteria, maximum iterations and relaxation coefficients. Output properties 
are used to set the type and amount of data you wish to have sent to the simulation results files. 
CONTAMW provides default settings for these parameters. However, you will probably work 
quite a bit with the Run Control and Output parameters, but you are not likely to need to change 
the numerics parameters. 

� Setting Simulation Parameters 
To set simulation parameters you use the Set Simulation Parameters… selection of the 
Simulation menu or the F4 keyboard shortcut. This will display the "Simulation Parameters" 
property sheet. The property sheet contains three different pages of parameters including: Run 
Control, Numerics, and Output. Detailed descriptions of all simulation properties are given in the 
Simulation Parameters section of this manual. 

� Running Simulations 
Once you have set the simulation parameters, you can run the simulation. To run a simulation 
select Run Simulation from the Simulation menu. This will display the "CONTAMW 
Simulation" dialog box. This dialog box allows you to start a simulation, view the status of a 
simulation in progress and stop a simulation in progress. If running a simulation would result in 
replacing some results files, you will be given a warning with the option to not proceed with the 
simulation. This allows you the opportunity to save the current project file under a different 
name before proceeding with the simulation.  

While there are many factors that can affect the ability of CONTAMW to quickly and 
successfully obtain a solution (converge), there are situations that can cause the simulation to not 
converge or to converge very slowly. The relative magnitudes of the flow coefficients have some 
effect on the convergence of the nonlinear equation solver of CONTAMW [Wray and Yuill 
1993]. Airflow networks containing paths whose resistances differ by many orders of magnitude 
will typically require more iterations than networks with paths of similar resistances. Reducing 
the relaxation coefficient from its default value of 0.75 to a value nearer one-half can often help 
convergence of these more difficult cases. The maximum number of iterations can also be 
increased. However, the most effective way to improve convergence is to remove those very low 
resistance paths that are not likely to effect the computed airflow rates. For example, when 
simulating a shaft (See Shafts), represent a shaft using phantom zones as opposed to using 
airflow elements with large cross-sectional areas between zones on adjacent levels. 

� Viewing Simulation Results 
Once you have successfully run a simulation, you can use CONTAMW to view simulation 
results or to create files that can be imported into a spreadsheet. These capabilities are explained 
in the Working with Results section. 
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3.17.1 Simulation Parameters 
Simulation parameters are those used to control the type of simulation that you wish 
CONTAMW to perform and the type of results output you wish CONTAMW to provide. This 
section provides detailed descriptions of the specific simulation parameters. 

3.17.1.1 Simulation – Run Control Properties 
Simulation Method: Set the type of simulation you wish to perform for both Airflows and 
Contaminants by checking the appropriate radio buttons. Refer to the Working with Simulations 
section for a table of allowable combinations of simulation method settings. 

Airflows: You can choose to have CONTAMW perform either a steady state simulation or a 
transient simulation of airflows. A steady state simulation will utilize the weather set by 
pressing the Edit Weather Button on the Run Control property page. When performing a 
transient simulation you can use either steady state weather and contaminant data or weather 
and contaminant files that define the weather and ambient contaminant concentrations for the 
time period of the simulation. See Defining Transient Weather and Wind in the Working 
with Weather and Wind section for more details. 

Contaminants: You can choose one of the following contaminant simulation options: None, 
Steady, Transient or Cyclic. The "None" selection uses no contaminants (e.g. you only want 
to model building airflows). The steady contaminant model can only be used in conjunction 
with steady airflows and will run until the system reaches equilibrium. Contaminant sources 
are modeled as continuous sources with a constant generation rate and all schedules are 
ignored. A cyclic simulation repeats a 24-hour cycle until steady-periodic conditions are 
achieved.  

Reset initial contaminant concentrations: Use this feature to reset the initial contaminant 
concentrations of all zones, including the implicit supply and return zones of simple air 
handling systems, prior to running a simulation. You can reset initial concentrations to Zero, 
Ambient or Current Results Concentrations. If you do not check one of these boxes, 
CONTAMW uses the Initial Concentrations indicated on the Contaminant Property page for 
each zone (See Contaminant Data). Checking one of these boxes causes the Initial 
Concentration values for each zone to be overwritten. 

Zero: This option sets the initial contaminant concentrations to zero. 

Ambient Concentrations: This option sets the initial contaminant concentrations to the 
default contaminant concentrations as set when defining Project Contaminants (See 
Contaminant Properties).  

Current Results Concentrations: This option sets the initial contaminant concentrations 
to be the same as the concentrations in each zone at the time step for which CONTAMW 
is currently displaying results on the SketchPad. You must be in the results viewing mode 
to utilize this feature. The current time step is displayed in the middle pane of the 
CONTAMW Status Bar (See the Status Bar section). This option is especially useful for 
cyclic simulation, where you may continue a simulation that has been interrupted before 
convergence, continue simulation with tighter convergence criteria, or create a project 
file for archive which can be rerun as a one-day transient simulation to quickly compute 
cyclic results. 
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Simulation Dates and Times: These dates and times are used to set the date and time labels put 
on steady state simulation results and to control the duration of transient simulations by allowing 
you to set the start and stop dates and times. Depending on the simulation method chosen 
different simulation "Dates and Times" fields will be enabled or disabled.  

Enter dates and times according to the following formats. 

Date Format – MMMDD       Example -  enter January 18 as Jan18 

Time Format – HH:MM:SS   Example - enter 1:00 AM as 01:00:00 

                                                                enter 1:00 PM as 13:00:00 

Cyclic & Steady Simulations: This date field is only used to label the simulation results, 
however, the time field is used to determine any control values of scheduled items for the 
associated day type for which the simulation is set to utilize. You must set the day type of the 
steady state Weather and Wind Parameters property sheet (See the Weather Properties in the 
Working with Weather and Wind section). CONTAMW will then utilize the day type and 
time to select control values of any of the elements that have schedules associated with them. 

Transient Simulation, Start and Stop: These date and time fields are used to set the 
starting and stopping date and time of transient simulations. You should be sure to use only 
those dates available in both the weather and ambient contaminant files. The available dates 
in these files will be displayed in the Transient Weather Data and Transient Contaminant 
Data sections below. 

Use restart file: Each transient and cyclic simulation produces a restart file that contains the 
status of the simulation at midnight for each simulation day. You can have CONTAMW use 
a restart file from a previous simulation to run an abbreviated (one to two days) transient 
simulation. You can use this shorter simulation to output much more data than is practical for 
a longer simulation.  

To use this feature, you must first run a transient or cyclic simulation. If a restart file is 
available, the dates for which restart data is available will be listed as "Restart data from ___ 
to ___" below the "Use restart file" check box. Enter the date and time in the edit boxes 
labeled "Restart data beginning: ___ / _____." 

Time Steps: These are the time increments that CONTAMW uses for performing and displaying 
progress of transient and cyclic simulations. 

Enter time steps according to the following format. 

HH:MM:SS Example - enter 1 minute as 00:01:00 

Simulation Time Step: The simulation time step is that used by CONTAMW when 
performing transient airflow and contaminant calculations for the transient and cyclic 
simulations. Shorter time steps provide for greater accuracy of results but require more 
computation time. There must be an integral number of simulation time steps in an hour. See 
Output Properties to set the listing time step CONTAMW uses to write data to the results file. 

Display Time Step: CONTAMW uses the display time step to determine how often the 
simulation progress is updated on the CONTAMW Simulation Control dialog box. The 
display time step must be a multiple of the simulation time step. 
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Steady State Weather Data: This is a summary of the steady state weather data settings. You 
can change this data by pressing the "Edit Weather Data…" button which will display the 
weather and wind related property sheet (see Defining Steady State Weather and Wind). You can 
have CONTAMW use steady state weather data for both steady state and transient simulations.  

Transient Weather Data: Select the weather file to be used by pressing the associated 
"Browse…" button and then selecting a .WTH file to be used with the simulation. Once you have 
selected a weather file, the date range for the particular file will be displayed in the Weather data 
from ___ to ___ fields. You can also check the "Use steady state weather data" check box to 
reset the simulation to use the steady state data as opposed to a transient weather file. 

Transient Contaminant Data: Select an ambient contaminant file to be used by pressing the 
"Browse…" button and then selecting a .CTM file to be used with the simulation. Once you have 
selected a contaminant file, the date range for the particular file will be displayed in the 
Contaminant data from ___ to ___ fields. You can also check the "Use steady state contaminant 
data" check box to reset the simulation to use the steady state data as opposed to a transient 
contaminant file. 

3.17.1.2 Simulation – Output Properties 
When you run a simulation with CONTAMW, simulation outputs are saved to binary files (as 
opposed to human-readable text files) as the simulation proceeds. Detailed results for airflows 
and/or zone contaminant concentrations are saved to the .SIM file. These data will be used to 
display airflow results on the SketchPad or as graphs of transient values.  Output is created at 
every "listing time step" which must be an even multiple of the simulation time step shown in 
parentheses. Shorter steps allow you to see the results in more detail, but they create a larger 
simulation results file. 

Detailed Results: All of the simulation results are saved in the simulation results file or .SIM 
file (See Working with Results).  

Airflows: Check this box to have CONTAMW output airflow and pressure data which is 
necessary to display or export any results involving airflows and pressures including those 
presented as SketchPad results and graphical results. 

Contaminants: Check this box to have CONTAMW output contaminant data that is 
necessary to display results involving contaminant concentrations.  

Occupant Exposure: Check this box to have CONTAMW output occupant exposure data 
that is necessary to display occupant exposure summary information when you highlight an 
exposure icon. You can still plot transient exposure data without this summary information. 

Listing time step for detailed results: Output is created at every listing time step which 
must be an even multiple of the simulation time step. Shorter time steps allow you to see the 
results in more detail, but also create a larger .SIM file. 

Enter the listing time step according to the following format.  

HH:MM:SS Example - enter 1 minute as 00:01:00 

Current simulation time step: Listing time step must be a multiple of this value which you 
can set under Run Control Properties. 
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CONTAMX Display and Logging Options: These properties control the manner in which the 
simulation engine, CONTAMX, appears during execution and the amount of data written to the 
CONTAMX.LOG file during a simulation. 

CONTAMX Display Mode: Select whether you want to interact with CONTAMX via a 
Windows dialog box or Console window (DOS window). The dialog box method is the 
typical choice, but you might want to run it in a console window if you have trouble with 
CONTAMX executing properly.  

CONTAMX Log Mode: Select the level of detail to output to the CONTAMX.LOG file. 
This is provided mainly for diagnostic purposes (for program developers) in the event that a 
problem is occurring during simulation (See Getting Help). 

Echo .PRJ as read to .LOG: Check this box to output the project file to the 
CONTAMX.LOG file. This is mainly provided for diagnostic purposes. 

3.17.1.3 Simulation – Airflow Numerics Properties 
These are the parameters that you can use to adjust the methods used to solve the airflow 
equations. Typically, you won’t need to change these values from their defaults. However, 
certain types of problems may benefit from using different solution techniques that are available. 
For instance, large projects consisting of many zones and duct junctions could benefit from the 
use of the PCG linear equation solver.  

Non-Linear Equation Solver: Calculation of airflows requires the solution of simultaneous 
non-linear equations. Two algorithms are available: Newton-Raphson (N-R) with under-
relaxation (SUR) and N-R using a simple trust region method. The latter method is more robust 
and is the default method. The first method is retained for compatibility with earlier versions of 
CONTAM. Convergence of the N-R solution of the non-linear simultaneous flow equations is 
controlled by four parameters: 

Maximum Iterations: Use this value to prevent endless calculations if the flow iterations are 
not converging. This should not be a problem with an appropriate relaxation coefficient. 

Relaxation Coefficient: This coefficient modifies the adjustment of the pure N-R method. 
Tests have found values near 0.75 to work well. Values near 1.0 may lead to non-convergent 
solutions. Values closer to 0.5 may be more reliable but take longer to solve. This coefficient 
is not used with the simple trust region method.  

Relative Convergence Factor (e1) and Absolute Convergence Factor (e2): The flow 
iterations are determined to have converged when the sum of all flows in and out of the zone 
are less than the relative flow convergence, e1, times the sum of the absolute values of those 
flows. If the sum of the absolute values of the flows is less than the absolute flow 
convergence, e2, the zone is assumed to be converged. This is done to prevent division by 
zero. 

Linear Equation Solver: This is currently the only method implemented for solving the linear 
equations generated by the Newton-Raphson (N-R) method. CONTAMW uses the Skyline 
algorithm (also called the profile method), which is a direct solution of the equations, or the Pre-
conditioned Conjugate Gradient  algorithm (PCG), which is the iterative biconjugate gradient 
algorithm. The execution time of the skyline method is determined by the sparseness and fill 
pattern of the solution matrix. 
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Maximum Iterations: Use this value to prevent endless calculations if the flow iterations are 
not converging. 

Relative Convergence Factor (e1): The flow iterations are determined to have converged 
when the sum of all flows in and out of the zone are less than the relative flow convergence, 
e1, times the sum of the absolute values of those flows.  

Resequence Linear Equations: The default is to resequence the linear equations in order to 
speed the solution by reducing the sparseness of the solution matrix. CONTAMX determines 
whether or not the resequencing actually improves the matrix. A failure in the resequencing 
algorithm is not a serious error because it will not change the numerical results. The 
resequencing uses algorithm 582, Collected Algorithms from ACM [ACM 1982]. 

Linear Airflow Initialization: An initial estimate of the pressures and flows is needed to 
start the non-linear equation solver.  The linear initialization is usually faster than starting 
from zero. 

Adjust temperatures in flow elements: This modifies the element flow coefficients to 
account for the actual properties of the air flowing through the elements. This may change 
the computed flows by a few percent. 

Variable Zone Density Parameters: These parameters are provided to control the variation of 
zone density during simulations due to varying temperature or accumulation/reduction of mass 
within a zone due to non-flow processes (e.g. non-trace contaminant source/sinks). Allowing for 
the variation of zone density now provides "true" transient analysis as opposed to quasi-steady 
analysis that does not provide for non-flow processes to take place (See Basic Equations of the 
Theoretical Background section). 

Vary density during time-step: Check this box if you want to allow the zone density to vary 
during a transient simulation. If you have implemented a temperature schedule within a zone, 
this box will be automatically checked for you. 

Under-relaxation Factor for dM/dt: Currently not implemented. 

Max Time Step Iterations: This is the maximum number of iterations for convergence of 
the density values. 

3.17.1.4 Simulation – Contaminant Numerics Properties 
These are the parameters that you can use to adjust the methods used to solve the contaminant 
equations. Typically, you won’t need to change these values from their defaults. However, as 
discussed below, certain types of problems may benefit from using different solution techniques 
that are available. 

Trace Contaminant Solver and Non-Trace Contaminant Solver: For each zone there is an 
equation for each contaminant species that you may have selected to be either trace or non-trace 
contaminants. The mass fractions of the non-trace contaminants are solved within an iterative 
loop that also determines the airflows because the non-trace contaminants affect the zone air 
densities and pressures. The mass fractions of the trace contaminants are solved after the flows 
have been computed since they do not affect the zone air densities. These calculations require the 
solution of simultaneous, non-symmetric, linear algebraic equations. Four methods are provided 
– two direct and two iterative. The iterative algorithms are successive over- relaxation (SOR) and 
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biconjugate gradient (BCG). The direct methods are a skyline (or ‘profile’) algorithm and a 
Gaussian LU-decomposition method. These four methods have been listed in order of increasing 
memory use. The iterative methods may or may not be faster than the more reliable direct 
methods. Before doing a long transient simulation of a large project, it may be useful to test the 
different methods to determine which will give optimum performance. 

1. Skyline: The skyline algorithm is the most reliable solution, and it is very fast for small 
problems but can be slow for large problems. 

2. BCG: Try the iterative biconjugate gradient algorithm for problems having a large 
number of zones for which the SOR algorithm might not converge. 

3. SOR: The successive over-relaxation algorithm requires much less memory and is faster 
than the Skyline method unless there are convergence problems. 

4. LU: LU decomposition using a full (non-sparse) matrix and is for verifying the solutions 
of the other methods rather than general usage. 

5. DCGS: Currently not implemented 

The iterative methods use the following parameters. 

Maximum Iterations: The "maximum flow iterations" applies to the BCG and SOR 
algorithms, and is used to prevent endless calculations if the flow iterations are not 
converging. 

Convergence Factors: The SOR iterations are assumed converged when the relative 
difference between the values on successive iterations are less than the relative convergence, 
e1.  The BCG method is determined to have converged when |A·x – b| / |b| < e1. 

Relaxation Coefficient: An optimum over-relaxation coefficient, ω, speeds the convergence 
of the SOR algorithm.  Determination of an optimum will require some experimentation with 
different values (usually near the low end of the range 1.0 to 2.0). 

The Trapezoidal Integration Factor: Determines the relative portions of the explicit and 
implicit terms in the solution of the differential equations. This is the parameter γ presented 
in the Contaminant Analysis section of the Theoretical Background. 

Convergence for Cyclic Simulations: Convergence is assumed when the relative difference in 
the peak concentrations (for all contaminants in all zones) is less than the relative convergence, 
e1.  The absolute convergence, e2, is used to keep zones and contaminants with negligible mass 
fractions from dominating the solution. 
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3.18 Working with Simulation Results 
CONTAMW can provide you with several types of simulation results. The results available after 
a simulation depend on the simulation method and output parameter settings. Once the results are 
available, you can view results using CONTAMW or you can export results to a comma-
separated format file that you can then import to a spreadsheet program for further analysis. 

When CONTAMW performs a simulation, it creates a set of results files within the same 
directory that the project file is stored. These results files have the same file name as the project 
file with different extensions appended to it indicating the type of results file. The files that are 
created and the contents of files depend on the run control and output simulation parameters that 
were set prior to running the simulation. The following table lists the different file extensions and 
gives a brief description of the files. 

Extension Description 

.SIM Detailed simulation result: airflow, pressure difference and 
contaminant concentrations for each time step 

.SUM Summary results 

.EXP Occupant exposure results 

.RST Simulation restart file 
 

3.18.1 Viewing Results 
This section describes how to activate the results display mode of CONTAMW and to display 
the results at different time-steps upon the SketchPad of transient simulations. 

� Results Display Mode  
To view results using CONTAMW you activate the results display mode by checking either the 
SketchPad Results or the Results Display Window selection of the View menu. This will occur 
automatically after the successful completion of a simulation or after opening a project file that 
has simulation result files associated with it. Once the results display mode is activated, the 
status bar will display result-related information (See Status Bar) and you will be able to utilize 
all of the Results Display Methods outlined below.  

� Simulation Time Step  
If you have performed a transient simulation, results will be available for each time step. 
However, the SketchPad results (as described in the following section) can only be displayed for 
a single time-step at a time. You can change the time-step for which results are currently 
displayed upon the SketchPad  using the following menu and keyboard shortcut commands. 

Show Next Time Step 
Menu Command: View → Next Time Step 
Keyboard Shortcut:  End 
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Show Previous Time Step 
Menu Command: View → Previous Time Step 
Keyboard Shortcut:  Home 

Show Last Time Step (of the day) 
Menu Command: View → Last Time Step 
Keyboard Shortcut:  Ctrl+End 

Show First Time Step (of the day) 
Menu Command: View → First Time Step 
Keyboard Shortcut:  Ctrl+Home 

3.18.2 Results Display Methods 
This section describes the various methods that CONTAMW uses to present simulation results. 
These methods include SketchPad for airflow paths, a Results Display Window for more detailed 
information on the icon currently highlighted on the SketchPad, plotting transient results on 
graphs, shaft reports, and exporting results to various types of external files. You can also print 
copies of the graphs you view with CONTAMW or copy them to the Windows clipboard to be 
pasted into other applications (e.g. word processor applications for written reports). 

3.18.3 SketchPad Results 
CONTAMW will display color-coded bars indicating the relative airflow rates and pressure 
drops associated with each airflow path, duct terminal, or the supplies and returns of simple air-
handling systems for the current time-step on the current level of the SketchPad. Airflow rates 
are shown in blue and pressure differences in red. These result-bars will only appear if you have 
selected the Airflows option on the Outlet page of the Simulation Parameters property sheet. If 
you have set flow or pressure limits for a given airflow path (see Airflow Path Properties), and 
they have been exceeded, the icon will be highlighted in red as a warning indicator. 

3.18.4 Results Display Window 
When you activate the results display mode, it activates the CONTAMW Results Display 
window. This window will display different types of information depending on the type of 
simulation that was performed (steady state or transient) the type of output that you selected (See 
Output Properties) and the currently (or most recently) highlighted icon on the SketchPad. The 
results display window will display information associated with zone icons and exposure icons. 
Once in the results display mode, you can control the visibility of the Results Display window 
using the Results Display Window selection of the View menu. However, you can only display 
the Results Display window while the SketchPad results are displayed.  

For steady-state simulations the steady-state results will be displayed. For transient simulations, 
results will be displayed for the current time step. Select the simulation time-step for which you 
want results to be displayed using the Simulation Time Step commands outlined in the previous 
section on Viewing Results. 

� Contaminant Concentration Results 
If the currently highlighted icon is a zone icon, then contaminant results will be displayed in the 
Results Display Window. The concentration for each contaminant (species used in the 
simulation) will be displayed. 
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� Zone Airflow Results 
If the currently highlighted icon is a zone icon, then for each adjacent zone the sum of the 
airflows between the highlighted zone the adjacent zone will be displayed.  

� Exposure Results 
If the currently highlighted icon is an exposure icon, then exposure summary results will be 
displayed for the currently highlighted occupant exposure icon. 

3.18.5 Plotting Results 
CONTAMW provides you with some powerful charting features for plotting transient simulation 
results. You can plot airflow, contaminant and exposure results using these features. Charting is 
only available for transient simulation results of the currently loaded CONTAMW project. You 
can plot results for airflows and pressure differences, contaminant concentrations, and occupant 
exposure and potential dosage. You access these charting features from the Simulation menu 
when the results-display is active. 

� Plotting Airflow Results 
Menu Command: Simulation → Plot Airflow Results… 

This command will display the Chart Control dialog box that you use to select and modify the 
chart settings for plotting airflow and pressure difference results for airflow paths. With this 
charting tool you can select multiple flow paths; plot one or more days of simulations; select the 
units of display; and plot either airflow, pressure difference or both on the same plot. You can 
also plot two-way flow rates for those flow paths that implement two-way airflow elements. If 
you select not to show two-way flows, CONTAMW will plot the net flow rate for airflow paths 
that implement two-way airflow elements. 

NOTE: If you select this menu item when the CONTAMW caret is highlighting an icon having 
airflow results associated with it (airflow path icon, duct flow icon, duct junction icon, or 
supply/return icon of a simple air-handling system), it will appear in the list of paths to plot when 
the Chart Control dialog box is displayed. This feature allows you to plot results for a particular 
flow path by highlighting it on the SketchPad as opposed to finding it in the list of flow paths on 
the Chart Control dialog box. 

� Plotting Contaminant Results 
Menu Command: Simulation → Plot Contaminant Results… 

This command will display the Chart Control dialog box that you use to select and modify the 
chart settings for plotting the time-history of contaminant concentrations of zones. With this 
charting tool you can select which contaminant to plot, plot multiple zones on the same graph, 
plot one or more days of results, and select the units of display. 

NOTE: If you select this menu item when the CONTAMW caret is highlighting a zone icon, it 
will appear in the list of paths to plot when the Chart Control dialog box is displayed. This 
feature allows you to plot results for a particular zone by highlighting it on the SketchPad as 
opposed to finding it in the list of zones on the Chart Control dialog box. 
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� Plotting Exposure Results 
Menu Command: Simulation → Plot Exposure Results… 

This command will display the Chart Control dialog box that you use to select and modify the 
chart settings for plotting the time-history of occupant exposure to and potential dosage of 
contaminants. With this charting tool you can select which contaminant to plot; plot multiple 
occupants on the same graph; plot one or more days of results; select the units of display; and 
plot either exposure, potential dosage or both on the same plot. 

NOTE: If you select this menu item when the CONTAMW caret is highlighting an exposure 
icon, it will appear in the list of occupants to plot when the Chart Control dialog box is 
displayed. This feature allows you to plot results for a particular occupant by highlighting it on 
the SketchPad as opposed to finding it in the list of occupants on the Chart Control dialog box. 

3.18.6 Chart Control: Transient Airflow Results 
Use this dialog box to control how transient airflow and pressure results are plotted. 

Paths to Plot/Paths Available: The plotted data for each airflow element will appear as a 
separate trace, the "Paths to Plot" lists the airflow elements that will be graphed. To add an item 
to this list select the appropriate airflow element type (paths, ducts, or junctions), scroll through 
the list of available elements or enter the element number directly if known, then press the "← 
Add" button. To remove an item from the Paths to Plot field select the zone to be deleted and 
then press the "Remove" button. 

Date(s) to Plot: This field allows the you to select the dates of data you wish to plot on the 
graph. The available dates for the given simulation file are shown for your reference. You must 
set the dates to fall within this range of dates. Enter dates in the following format:  

MMMDD - the first 3 letters of the month and then the day of the month with or without spaces 

Data to Plot: You can plot airflow rates, pressure differences, or both. If you plot both airflow 
and pressure difference, then CONTAMW will produce a graph with two vertical axis - one for 
airflow and one for pressure difference. You can select the units of these axis using the "Airflow 
Units" and "Pressure Units" drop-down combo boxes on this dialog box. 

You can also show two-way flows for flow elements that utilize two-way flow models. If you 
leave "Show two-way flows" unchecked, then CONTAMW will plot the net flow rate for all 
flow paths. If you check "Show two-way flows," then a zero component will be plotted for all 
flow paths that do not implement two-way models. 

Comment for chart title: Enter a comment you want to appear at the top of the chart to help 
distinguish various plots from one another. 

3.18.7 Chart Control: Transient Contaminant Results 
Use this dialog box to control how transient contaminant results are plotted. 

Contaminant to Plot: This lists all the currently defined project contaminants. Select the 
contaminant for which you want results plotted. 

Moisture Units: If the contaminant to plot is "H2O," then this section will be activated to 
provide the ability to plot moisture in units of mass fraction, humidity ratio, or % relative 
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humidity. Mass fraction is the same units in which all other contaminants are reported, i.e., mass 
of contaminant per mass of air. Humidity ratio is in units of mass of water vapor per mass of dry 
air, i.e., mass of air less the mass of water vapor. %RH will utilize the equations presented in 
Chapter 6 of ASHRAE 2001 Fundamentals [ASHRAE 2001] to calculate the relative humidity 
based upon the mass fraction of H2O, temperature and absolute pressure in each of the Zones to 
Plot. If you select Mass Fraction or Humidity Ratio you can select from the set of units available 
in the Units list. When plotting humidity ratio, you should only plot in units of kg/kg, g/kg or 
lb/lb and not in volumetric units as the conversion will not be correct due to the assumed 
standard air density in CONTAM’s conversion routines. 

Zones to Plot/Zones Available: The plotted contaminant data for each zone will appear as a 
separate trace, the "Zones to Plot" lists the zones that will be graphed. To add an item to this list 
select the appropriate level and zone name from the drop down boxes in the Zones Available 
field and then press the "Å Add" button. To remove an item from the Zones to Plot field first 
select the zone to be deleted and then press the "Remove" button. 

Date(s) to Plot: This field allows the user to plot the contaminant results from a specified date 
range within the simulations results file. The available dates for the given simulation file are 
given, the user provided date range must fall between these dates. The dates are entered in the 
form: the first 3 letters of the month and then the day of the month with or without spaces. 

Comment for chart title: Enter a comment you want to appear at the top of the chart to help 
distinguish various plots from one another. 

3.18.8 Chart Control: Transient Exposure Results 
Use this dialog box to control how transient exposure results are plotted. 

Occupant to Plot: This is a list of the occupants for which you want to plot exposure results. 
Use the "Occupants Available" section to select occupants to add to this list and click the "Å 
Add" button or highlight an occupant in this list and remove it using the "Remove" button.  

Contaminant to Plot: This lists all the currently defined project contaminants. Select the 
contaminant for which you want results plotted. 

Date(s) to Plot: This field allows the user to plot the contaminant results from a specified date 
range within the simulations results file. The available dates for the given simulation file are 
given, the user provided date range must fall between these dates. The dates are entered in the 
form: the first 3 letters of the month and then the day of the month with or without spaces. 

Comment for chart title: Enter a comment you want to appear at the top of the chart to help 
distinguish various plots from one another. 
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3.18.9 Exporting Results 
CONTAMW provides you with the ability to export results to external files. You can either 
generate report files or export files. Report files are text files that are formatted for ease of 
reading. Export files are tab-delimited, so you can easily import them into a spreadsheet. This 
feature provides you with greater charting flexibility as well as the ability to perform more 
sophisticated data analysis of your simulation results. You access this feature of CONTAMW by 
selecting Export Results…  from the Simulation menu or use the F5 shortcut key when the 
results-display mode is active. This will display the "Export Data" dialog box as described in the 
following section. 

3.18.10 Export Data 
This section provides detailed descriptions of the specific properties associated with generating 
result reports and exporting results to external files.  

Transient Results:  
Results available from/to: This shows the range of dates/times for which results are 
available in the simulation results file (.SIM) of the latest simulation.  

Export transient results from/to: Select the range for the data to be exported. Enter the date 
as the first 3 letters of the month followed by the day of the month with or without spaces, 
e.g., Jan01, followed by the time in the following format HH:MM:SS. 

Airflow Data: Options for reporting/exporting airflow data. Airflow rates will be reported in the 
Default Units of Flow as selected on the Default Units page of the Project Configuration 
properties (See Configuring CONTAMW). 

Report airflows of all paths for date/time: Create a text file formatted for ease of reading 
that lists the airflows and pressure differences for all paths, zone pressures and temperatures 
at the selected date and time. 

Export airflows of all zones for date/time: Create a tab-delimited file containing a table of 
the total airflows between each zone of the building. The leftmost column lists the level and 
name of the zones from which airflows and the topmost row lists the level and names of the 
zones into which air flows. Therefore, all airflows are listed as positive values. 

Export transient flow for airflow path number: Create a tab-delimited file listing all the 
airflow data for a specific airflow path. Select the airflow path number(s) for which you want 
to output the airflow and pressure drop data for the range of time you select in the "Export 
transient results from/to" dates and times indicated above. 

Export average transient flow for each zone between export result times: Create a tab-
delimited file listing the average airflow rates between zones averaged over the range of time 
you select in the "Export transient results from/to" dates and times indicated above. 

Contaminant Concentration Data: Options for reporting and exporting contaminant results. 
Concentrations will be reported in the units associated with the default concentration of each 
species/contaminant (See Species Properties). 
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Report transient concentrations of all zones for date/time: Create a text file formatted for 
ease of reading that lists the contaminant concentrations for all zones and contaminants at the 
selected date and time. 

Report transient concentrations of all zones: Create a text file formatted for ease of 
reading that lists the contaminant concentrations for all zones at the selected date and time. 

Export transient concentrations of all zones: Create a tab-delimited file listing the 
transient contaminant concentrations for all zones and contaminants for the range of time you 
select in the "Export transient results from/to" dates and times indicated above. 

Export transient concentrations for zone: Create a tab-delimited file listing the transient 
contaminant concentrations for each contaminant in the selected zone for the range of time 
you select in the "Export transient results from/to" dates and times indicated above. 

3.18.11 Shaft Report 
CONTAMW is well suited for the analysis of smoke control systems. Because of the importance 
of shafts for some smoke control systems [Klote and Milke 2002], CONTAMW provides a 
special reporting feature for shafts.  

� Defining Shafts 
You define shafts during the drawing phase of project development by placing zone icons 
directly below one another (in the same column and row) on adjacent levels of a building. If 
there is a zone icon in the same position on the level above or below the current level, those 
zones are part of the shaft when CONTAMW generates a shaft report. The shaft consists of 
zones that exist on contiguous levels having a zone icon in the same location on the SketchPad. 

You create the shaft report by selecting Generate Shaft Report from the Simulation menu. 
This will display a dialog box prompting you to execute the following three steps to define the 
shaft zone icon and primary and secondary flow paths associated with the shaft across which you 
want CONTAMW to report the airflows and pressure drops. The zone icon would typically 
represent a stairwell, and the primary flow path would typically represent a stairwell door. 

Steps to select a shaft for a shaft report: 
1)  Left-click on the zone icon that defines the shaft 
2)  Left-click on the primary airflow path icon  
3)  Left-click on the secondary airflow path icon 
NOTE: Click the right mouse button to cancel the shaft report generation process. 

Once you have completed the above steps, the shaft report will be displayed in a dialog box. The 
report will display pressure drop, airflow rates and direction of airflow on every level of the shaft 
where there are airflow path icons in the same location on the SketchPad as that of the primary 
and secondary airflow paths. You can use the Shaft Report dialog box to select the units in which 
the airflow rate and pressure drops are reported, and you can save a copy of the report to a text 
file. 
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3.18.12 TRNSYS Input Files 
You can use CONTAMW to generate input data for the TRNSYS airflow module TYPE96.  Use 
the Create TRNSYS Input File selection of the Simulation menu. The data will be written to a 
file having the same name as the current project but the .PRJ extension will be replaced and .AIR 
extension. The following CONTAMW airflow elements are currently supported when creating 
TRNSYS input files. If any other elements exist within the current project, you will receive a 
warning message from CONTAMW that unsupported airflow elements exist within the project. 

Powerlaw Models:     
Q = C(∆P)n  
F = C(∆P)n 
Leakage Area Data 
Connection (ASCOS) Data 
Orifice Area Data 
Crack Description 
Test Data (1-point) 
Test Data (2-points) 
Stairwell 
Shaft 

Two-way flow model:  
Two-opening Model 

In addition, the supply and return paths associated with the simple air handling system model are 
also included. The AHS implicit paths - recirculation, exhaust, and outside air - are not 
included. All the CONTAMW building zones, AHS supply and return nodes, and the ambient 
zone are included. A complete list of the inputs to and the outputs from the TYPE96 subroutine 
are listed at the end of the .AIR file. 

The inputs from TRNSYS to TYPE96 are: 

Temperatures for all zones including ambient [C] 
Absolute barometric pressure [Pa] 
Wind speed at the building reference elevation [m/s] 
Wind direction [degrees clockwise from north] 
All AHS supply and return flows [kg/s] 
Any other specified mass flow rates [kg/s] 
The relative areas of any variable openings 
 

All flow and relative area inputs must be greater than zero. 

The outputs from the TYPE96 subroutine to TRNSYS are the interzone air flows including flows 
to and from ambient.  There are a maximum of two flows reported between any two zones - the 
sum of all flows from zone 1 to zone 2 and the sum of all flows from 2 to 1. There may be 
multiple paths between any two zones. 

 124



 USING CONTAMW – WORKING WITH SIMULATION RESULTS 

� TRNSYS Input File Format: 
I indicates an integer value and R indicates a four-byte real number 
HEADER DATA: 
Line 1:    debug control 
  I  LIST    - non-zero value initiates data dumps. 
Line 2:    counts 
  I  NWPP    -  number of wind pressure profiles. 
  I  NZONE   -  number of zones/simultaneous equations. 
  I  NPATH   -  number of airflow paths. 
  I  NELMT   -  number of airflow elements. 
Line 3:    run control 
  I  ITMAX   - maximum number of iterations. 
  R  RELAX   - under- relaxation coefficient. 
  R  ACNVG1  - relative airflow convergence factor. 
  R  ACNVG2  - absolute airflow convergence factor. 
  I  TADJ    - non-zero to do temperature adjustment. 
Line 4:    weather data 
  R  PBAR    -  absolute barometric pressure [Pa]. 
  R  WSPD    -  wind speed [m/s]. 
  R  WDIR    -  wind direction [deg clockwise from north]. 
Line 5:    end of section indicator 
  I  J       - should equal -999 
 
WIND PRESSURE PROFILES: 
One line for each wind pressure profile consisting of 
  I  NR      - profile number, starting at 1. 
  I  TYPE    - profile type. 
  I  NPTS    - number of data points. 
  followed by one line with 5 real values for each data point. 
Last line: end of section indicator 
  I  J       - should equal -999 
 
AIR FLOW ELEMENTS: 
One line with 3 real values for each flow element. 
Last line: end of section indicator 
  I  J       - should equal -999 
 
ZONE DATA: 
One line for each zone consisting of 
  I  NR      - zone number, starting at 1. 
  I  CP      - 1 indicates constant pressure zone. 
  R  TZ      - initial zone temperature [K]. 
  R  PZ      - initial zone pressure [Pa]. 
  R  VOL     - zone volume [m^3]. 
  R  HT      - zone elevation [m]. 
Last line: end of section indicator 
  I  J       - should equal -999 
 
PATH DATA: 
One line for each airflow path consisting of 
  I  NR      - path number, starting at 1. 
  I  NZ      - number of zone air flows from (to be positive). 
  I  MZ      - number of zone air flow to. 
  R  HT      - path elevation [m]. 
  I  TYPE    - path type: 0=flow, 1 = PLR, 2=QCN, 3=FCN. 
  I  NE      - number of the air flow element. 
  R  MULT    - path multiplier. 
  I  XIN     - index (>0) of XIN input value (type 0). 
  I  PWP     - index (>0) of the wind pressure profile. 
  R  WIND    - wind pressure modifier. 
  R  AZM     - surface azimuth angle. 
  R  CTRL    - flow or control value depending on type. 
Last line: end of section indicator 
  I  J       - should equal -999 
 
INPUT & OUTPUT DATA: 
First line: 
  I  NIN     -  number of input variables. 
  I  NOUT    -  number of output variables. 
One line for each output variable consisting of 
  I  NR      - output number (index to XOUT). 
  I  NZ      - number of zone the air flows from. 
  I  MZ      - number of zone the air flows to. 
Last line: end of section indicator 
  I  J       - should equal –999 

 125



USING CONTAMW – WORKING WITH PROJECT ANNOTATIONS 

3.18.13 CONTAMX Input Files 
This version of CONTAMW now utilizes the CONTAMX stand-alone simulation engine, 
CONTAMX2.EXE. CONTAMX utilizes the same .PRJ file that you create using CONTAMW. 
With the CONTAMX program, you can perform batch mode operations to process multiple 
project files. Or you can create your own file processor to modify project files in order to 
perform sensitivity analysis by performing multiple runs while varying desired building 
parameters. If you wish to modify the .PRJ file in such a manner, you should become familiar 
with the .PRJ file format that is now annotated with comment lines to improve the legibility of 
the file. 

You can simply save project files in the usual manner using CONTAMW or use the Create 
CONTAMX Input File selection of the Simulation menu. The recommended course of action 
would be to perform a simulation from within CONTAMW before implementing the batch 
process. This will provide some building check routines that insure your project is "well 
formed." At the very least, using the "Create CONTAMX Input File" option will perform this 
building check prior to saving the .PRJ file. 

 

 

3.19 Working with Project Annotations 
Project annotations provide you with a simple project documentation feature. You simply place 
an annotation icon onto the SketchPad (see Drawing Building Component Icons) and then use 
the icon definition procedure (see Defining Building Component Icons) to edit the text for the 
annotation. Once you have defined the text associated with the annotation icon, the text will 
appear in the status bar whenever you highlight the icon with the caret. You can edit, delete, and 
move the icon as you would any other building component icon.  
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3.20 Getting Help 
This help manual is available in both printed form and accompanying the CONTAMW program 
as "on-line" help. There are several ways to access the on-line help system. You can either use 
the Help Contents… selection of the Help menu to display the contents of the help manual or 
use the context-sensitive feature to access help. 

� Help Contents 
You can browse the contents or index of the help system to view the topic of your choice and use 
the search feature to display a list of help topics that contain the keyword in which you are 
interested. 

� Context-Sensitive Help 
The context-sensitive help feature is designed to provide you with specific information related to 
the currently active CONTAMW window or dialog box. To activate the context-sensitive help 
system, press the F1 key. 

� Help Index and Search 
Be sure to use the on-line help index and search features if you are having trouble locating a 
specific topic. 

� Obtaining Technical Support 
If you need to contact the CONTAMW developers for guidance on using the program or to 
report a technical problem with the program you can do so via email at the addresses below. If 
you encounter an error while working with CONTAMW, and you require assistance solving the 
problem, you should immediately (before running CONTAMW again) make copies of the 
CONTAMW.LOG, PROJECT.BKP and WEATHER.BKP files located in the CONTAMW 
program directory. You can email these files to NIST so that we may be better equipped to 
address your particular problem. 

 

NIST Contact Information 

1. George Walton gwalton@nist.gov 301-975-6421 

2. W. Stuart Dols wsdols@nist.gov 301-975-5860 

3. IAQ and Ventilation Group  301-975-6431
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4 Special Applications of CONTAMW 
This section includes instructions, or considerations, for using CONTAMW to simulate several 
different building features (e.g. atria, stairwells and chimneys) and perform special building 
analysis such as fan pressurization. There are also available, several references that address the 
application of CONTAM in general [Emmerich and Persily 1996, 1998; Emmerich and Nabinger 
2000; Fang and Persily 1994; Musser and Yuill 1999; Musser 2000; Persily 1998; Persily and 
Martin 2000; Persily and Ivy 2001]. 

4.1 Building Pressurization Test 
The building pressurization test (sometimes referred to as a "blower door test") is a common way 
of determining the airtightness of a building's envelope. Fan pressurization is relatively quick 
and inexpensive and it characterizes building envelope airtightness independent of weather 
conditions. In this procedure, a large fan or blower is mounted in a door or window and induces a 
large and roughly uniform pressure difference across the building shell. [ASHRAE 1997, p 
25.15; ASTM 1999] A common airtightness rating is the airflow rate at 50 Pa divided by the 
building volume to give units of air changes per hour.   

You may wish to do a simulated pressurization test to determine the airtightness rating of your 
idealized building. This is easily done by setting one of the zones on the zero elevation level to a 
constant pressure of 50 Pa, running the simulation, and then observing the total airflow out of 
that zone. (Don't forget flows to other building levels.) You could also define an airflow path 
using a constant volume airflow element through which you can vary the airflow until you 
achieve the desired level(s) of pressurization. Use standard m3/h flow units and divide by the 
building volume to get the air change rate at 50 Pa. Alternatively, the flow rate at 4 Pa can be 
converted to an effective leakage area (ELA) using equations in Chapter 25 of the 1997 
ASHRAE Fundamentals Handbook [ASHRAE 1997]. Use the CONTAMW results display to 
check that the building has been properly pressurized by moving the cursor to each path on the 
envelope to get the pressure drop reported in the status bar. You can use the report of all flows to 
get a listing of all flow and pressure drops. The pressure drop on every path to the ambient zone 
should be close to -50 Pa. The value is negative because of the default direction assigned for 
positive flow. 

The reported pressure drop across various flow paths will not be exactly 50 Pa because of density 
effects. Minimize these differences by running all zones and ambient at the same (standard) 
temperature and no wind. Differences in pressure due to elevation make it critical that the 
constant pressure zone be on the level with zero elevation.     

In a multizone building the effects of partitioning (internal walls and floors) usually are 
significant.  There are two solutions depending on the goal of the simulation. If the goal is only 
to achieve a uniform pressure difference across the entire building shell, add a very large opening 
across each partition. If the goal is to reproduce a field test, simulate the internal doors as being 
open to get a relatively uniform pressure inside the building.  

Prior to performing these tests, you should make a copy of the project file, so you do not have to 
reverse the changes to restore the original project file. 
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4.2 Smoke Control Systems 
For a stairwell pressurization system, you may want to record the pressurization flows by 
creating a simple AHS model with supply points in the shaft. Make these supply points the 
secondary path. You may use supply point icons aligned on every level with some or most of the 
flows set to zero, or you may use icons only on those levels with a pressurization flow. 
Alternatively, for shafts on an exterior wall of the building, you may wish to use the constant 
flow rate path elements through the exterior wall to provide the pressurization air. This type of 
flow path will also report the pressure difference between the shaft and ambient. You may want 
to align these constant flow paths above the open doorway on the first level. For details on 
viewing shaft reports see Working with Simulation Results in the Using CONTAMW section of 
the manual. 

4.3 Shafts 
Buildings contain several architectural features which offer very low resistance to airflow 
between building levels. These features include atria, elevator shafts, and stairwells. 
CONTAMW provides two ways of modeling such a low resistance path:  the phantom zone and 
the low-resistance (or large) opening. Select the most appropriate model based on how this path 
interacts with the rest of the model. 

This interaction can be understood by using three flow resistances in series to model a shaft 
between two levels. There is a resistance to flow through the shaft and resistances representing 
the paths (doors) connecting the shaft to the two different levels.  Using the powerlaw 
relationship, Q = C(∆P)1/2, and assuming C = 3.10 for the shaft, 1.55 for an open door, and 0.01 
for a closed door, the following equivalent flow coefficients, Ce = ( Σ 1/Ci2 )-1/2, are computed 
for four different assumptions: 

(1)  both doors closed, ignore shaft resistance:  Ce = 0.007070 

(2)  both doors closed, include shaft resistance:  Ce = 0.007066 

(3)  both doors open, ignore shaft resistance:  Ce = 1.096 

(4)  both doors open, include shaft resistance:  Ce = 0.984 
 

Cases (1) and (2) show that when flow resistance is dominated by the closed doors, it is not 
necessary to include the shaft flow resistance. Cases (3) and (4) show that when the resistances at 
the (open) doors is of the same order as the shaft resistance, it is important to include the shaft 
resistance in the model. For a quick estimate of relative flow coefficients, remember that the 
flow coefficient is usually roughly proportional to the opening area. 

4.3.1 Atria 
If an atrium were modeled as individual zones on each level, the inter-level flow resistances 
would be very low. A cursory comparison of the inter-level opening areas to the sum of all 
openings from the atrium to other zones will usually indicate that an atrium should be modeled 
using phantom zones. This is done by placing a standard zone icon at the atrium's lowest level. 
You use this zone icon to define the atrium temperature and total volume.  You should ignore the 
floor area of the normal zone icon that is used to define the atrium zone.  Place a phantom zone 
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icon at all higher levels which contain parts of the atrium.  A phantom zone icon indicates that 
the region within the walls on this level are actually part of the zone on the level below the icon.  
If it is necessary to have different temperature or contaminant concentrations at the different 
levels in an atrium, then those levels must be modeled as normal zones connected by flow paths 
with very large openings. 

4.3.2 Stairwells 
Data to describe the airflow characteristics of a stairwell in terms of an equivalent orifice is 
provided in [Achakji and Tamura 1988]. This representation is very well suited to being 
implemented by CONTAMW, which allows you to create a powerlaw flow element from the 
physical characteristics of the stairwell. Stairwell characteristics include the cross-sectional 
(horizontal) area of the stairwell shaft, whether the fronts of the stair treads are open or closed, 
and the number of people on the stairs.  This last item might be important in an evacuation 
scenario.  Since the equivalent orifice area of the shaft is on the same order as it's cross-sectional 
area, and this area is likely to be smaller than the sum of the areas of the doors entering the 
stairwell, it is generally best to model a stairwell as individual zones on each level connected by 
openings which have been defined using the CONTAMW stairwell airflow element that 
implements the Achakji/Tamura model. 

4.3.3 Elevator Shafts 
Elevator shafts (hoistways) will generally lie in some modeling regime that falls between 
stairwells and atria.  Measured data for the flow resistance of an elevator shaft have not yet been 
identified. CONTAMW provides a powerlaw flow element based on flow resistance from the 
Darcy/ Colebrook model of a conduit or duct. A significant difference between an elevator shaft 
and a stairwell is that the door between the shaft and the building is never fully open because, 
when it is open, air must flow through openings in the elevator car to pass between the building 
and the shaft.  Table 6.1 of [Klote and Milke 2002] presents orifice areas for closed elevator 
doors which tend to be fairly small compared to the cross-sectional area of the shaft, especially 
for hoistways with multiple cars, so it is likely that the airflow in most elevator shafts can be 
modeled with sufficient accuracy by phantom zones. However, it may be necessary to split the 
shaft into several sections to achieve sufficient accuracy in modeling contaminant transport. 

4.3.4 Chimneys 
You can use a duct to create a simple chimney model. At its simplest this will involve only a 
single duct connecting the inside of the building to the outside with the Darcy-Colebrook duct 
element used to model the flow resistance of the chimney. The height of the duct terminal points 
must reflect the height of the chimney and a special high temperature zone must be created 
around the inside terminal point so that the proper stack effect will result. Be sure to allow an 
appropriate low resistance path from this special zone to the rest of the building. 
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5 Theoretical Background 
This section provides theoretical background of the CONTAMW program. There are basically 
three subsections: the first provides a summary of underlying assumptions of the model and the 
others address the contaminant and airflow analysis respectively. 

5.1 Model Assumptions 
CONTAMW is a powerful tool that models airflow and contaminant dispersal in buildings. It is 
important to realize that this tool implements mathematical relationships to model airflow and 
contaminant related phenomenon and therefore incorporates assumptions that simplify the model 
from that of the modeled phenomenon. The following is a brief description of these modeling 
assumptions. 

Well-mixed zones – This assumption refers to the treatment of each zone as a single node, 
wherein the air has uniform (well-mixed) conditions throughout. These conditions include 
temperature, pressure and contaminant concentrations. Therefore, localized effects within a 
given zone cannot be accounted for using CONTAMW. For example, if you utilize a 
contaminant source that introduces a mass of contaminant into a zone at a certain time (burst 
source), the contaminant will be diluted to the entire volume of the zone within a single time 
step. 

Conservation of mass – When performing a steady-state simulation, the mass of air within each 
zone is conserved by the model. This implies that air can neither be created nor destroyed within 
a zone. However, when performing a transient simulation, CONTAMW now provides the option 
of allowing the accumulation or reduction of mass within a zone due to the variation of zone 
density/pressure and the implementation of non-trace contaminants within a simulation. This is 
further addressed in this Theory section (See Airflow Analysis and Contaminant Analysis), as 
well as in a previous section addressing simulation settings (See Airflow Numerics Properties).  

Trace contaminants – Trace contaminants are those that are found in low enough levels that they 
do not affect the density of air within a zone. You must be careful not to rely on the model to 
handle contaminant concentrations that would cause a change in the density of air. The program 
will allow for contaminants to reach levels that would, in actuality, affect the density, but the 
program will still treat them as if they were trace contaminants.  

Non-trace contaminants – Non-trace contaminants are those that are present in such quantities 
that they can influence the air density, e.g., water vapor. In CONTAMW you define those 
contaminants that are components of the air within the building. CONTAMW will treat them as a 
mixture of ideal gases. 

Thermal effects – The model does not handle heat transfer phenomenon per se, but does provide 
for the scheduling of zone temperatures. Zone temperatures can be either constant or allowed to 
change during transient simulations according to user-defined temperature schedules. 
CONTAMW will determine airflows and non-trace contaminant mass fractions induced by 
temperature differences between zones including ambient (e.g., as caused by the stack effect). 
You can also vary the outdoor temperature for transient simulations using weather files. 

Airflow paths – Airflow through various airflow elements provided by CONTAMW is modeled 
using either a powerlaw or quadratic relationship between airflow and pressure difference across 
the flow path. These relationships are models themselves, and care should be taken when 
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implementing them to represent building features within your idealized buildings. See Airflow 
Elements for detailed explanations of these models. 

Source/sink models – CONTAMW provides several different source/sink elements or 
representations of contaminant generation/removal processes. These elements are based upon 
models found throughout the literature. You should be sure to utilize models that are appropriate 
for the contaminant source/sink that you want to represent. See Contaminant Source/Sink 
Elements  for detailed explanations of these models. 

The previous assumptions relate to the mathematical representations utilized by CONTAMW in 
performing analysis. These assumptions should be distinguished from assumptions made by you, 
the user, when creating a model of a building referred to as a building idealization (See User 
Tasks in the Getting Started section). Engineering judgment is required on your part to insure 
that your building representation is adequate for the purposes of your analysis. 

5.2 Contaminant Analysis 
The CONTAMW contaminant dispersal model is an implementation of Axley's methods [Axley 
1987 and 1988]. He states: “The central concern of indoor air quality analysis is the prediction of 
airborne contaminant dispersal in buildings. Airborne contaminants disperse throughout 
buildings in a complex manner that depends on the nature of air movements in-to, out-of, and 
within the building system; the influence of the heating, ventilating, and air-conditioning 
(HVAC) systems; the possibility of removal, by filtration, or contribution, by generation, of 
contaminants; and the possibility of chemical reaction, radio-chemical decay, settling, or sorption 
of contaminants. In indoor air quality analysis we seek to comprehensively model all of these 
phenomena.” 

The mass of contaminant α in zone i is 

iii Cmm ,, αα ⋅=
 ( 1 ) 

where mi is the mass of air in zone i and Cα,i is the concentration mass fraction of α. A zone is a 
region of uniform contaminant concentration which may correspond to a single room, a portion 
of a room, or several well-coupled rooms. Selection of the zones is a matter of engineering 
judgment. In CONTAMW the contaminant concentration must be low enough so as not to 
significantly change the density of the air-contaminant mixture. 

5.2.1 Solution of Contaminant Equations 
Contaminant is removed from the zone i by: 

1. outward airflows from the zone at a rate of Σj Fi,j⋅C   
where Fi,j  is the rate of air flow from zone i to zone j, 

α,j

2. removal at the rate Cα,i⋅Rα,i where Rα,i is a removal coefficient, and 

3. first-order chemical reactions with other contaminants Cβ,i at the rate mi⋅Σβ κα,β⋅Cβ,i   
where κα,β is the kinetic reaction coefficient in zone i between species α and β. (Sign 
convention:  positive κ for generation and negative κ for removal) 

Contaminant is added to the zone by: 
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1. inward airflows at the rate Σj (1-ηα,j,i) Fj,i⋅Cα,j where ηα,j,i  is the filter efficiency in the 
path from zone j to zone i, 

2. generation at the rate Gα,i , and  

3. reactions of other contaminants. 

Conservation of contaminant mass for each species (and assuming trace dispersal, i.e., mα,i << 
mi) produces the following basic equation for contaminant dispersal in a building: 

( ),
, , , , , , , , , ,1i
i i i j i j i j i j i

j j

dm
iR C F C F C m K G

dt
α

α α α α α α β α
β

η= − − + − + +∑ ∑ ∑
 ( 2 ) 

This differential equation is approximated by a difference equation: 

*
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j j
m m t F n C m C G R F Cα α α α α β β α α α
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 
≈ + ∆ − + + − + 

 
∑ ∑ ∑ ,

i tα

,n

 ( 3 ) 

where the * indicates a value at time t+∆t.  

CONTAMW implements the generalized trapezoidal method used by Axley, but defaults to 
using a fully implicit numerical approximation to solve equation (3) as presented below. 
However, the user can adjust the trapezoidal integration factor, γ, from 0.0 to 1.0 to vary the 
method from explicit to implicit. 

* * *
, , , , , , , , , , ,( ) (1 )i i i j i j i j i j i i i i

j j
m t R F C t F C m t C m C Gα α α α α β β α

β
η κ

 
+ ∆ + −∆ − − ∆ ≈ + ∆ 

 
∑ ∑ ∑

 ( 4 ) 
mi is considered to be constant. Some special cases are handled by variants of the above 
equation. If zone i is specified as having no mass (e.g. in the ductwork), equation (4) becomes: 

* *
, , , , , , ,( ) (1 )i i j i j i j i j

j j

R F C F C Gα α α αη+ − − ≈∑ ∑ α

,i

 ( 5 ) 

Note that the kinetic reactions cannot be considered in this case. If a steady state solution is 
desired, equation (4) becomes: 

, , , , , , , , ,( ) (1 )n i j i j i j i j i i
j j

R F C F C m C Gα α α α α β β αβ
η κ+ − − − ≈∑ ∑ ∑

 ( 6 ) 

If the mass flows and Rα,i should happen to be zero in equations (5) or (6), they cannot be solved. 
This case is handled by the simple expedient of letting Cα,i remain at its default value. These 
equations must be solved simultaneously for all zones and contaminants.  

A major limitation in the equations presented above is the use of linear analysis which limits the 
kinds of kinetic reactions which can be modeled. Only first-order linear kinetic reactions are 
currently handled. 
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5.2.2 Solving the Differential Equations 
The transient evolution of the node air mass fractions is expressed in terms of the vector {Q} 
where 

{Q } = [C ] {X  }  ( 7 ) 

{Q} may be the vector of masses of all species in all nodes with [C] being a diagonal matrix of 
node mass values and {X} the vector of mass fractions.  The total number of equations equals the 
number of nodes (= zones + junctions) times the number of contaminants. These equations are 
divided into two parts – trace and non-trace – and solved at different points in the overall 
solution for a single time step. {Q} could also be the vector of node energies with [C] being a 
diagonal matrix of node thermal capacities and {X} the vector of node temperatures, but thermal 
simulation has not been implemented..   

The basic time discretization is 

t t - t{Q   {Q  + {Q} t} } ∆≈ ∆  ( 8 ) 

where the following linear approximation will be used: 

{Q} = [K ]{X} + {G}  ( 9 ) 

For mass transfer [K] is the matrix of interzonal mass flows (and reactions), and {G} is the vector 
of net mass generation rates.  For heat transfer [K] is the matrix of heat transfer coefficients 
(conduction, convection, and radiation), and {G} is the vector of heat generation rates.  For large 
problems [K] will be sparse. 

Equation (8) will be solved using a trapezoidal approximation of the derivative term: 

t t - t t - t{Q   {Q  + (  1- ) t {Q  + t {Q} } }γ γ∆ ∆≈ ∆ t}∆  ( 10 ) 

where γ is a parameter controlling the stability and accuracy of the integration:  

γ = 0 corresponds to the standard explicit method, 

γ = 1/2 corresponds to the Crank-Nicolson method, 

γ = 2/3 corresponds to the Galerkin method, and 

γ = 1 corresponds to the standard implicit method. 

γ must be greater than or equal to 0.5 for unconditional stability, although values below about 
0.75 may show oscillations. 

Equation (10) can be rearranged as  

t t- t{Q   {Q  + t{Q} } γ∆≈ ∆ t}  ( 11 ) 

where 

t- t t- t t- t{Q  = {Q  + (  1- ) t {Q} } γ∆ ∆ ∆ } ∆  ( 12 ) 
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is a quantity based entirely on values known at end of the last time step, time t-∆t. 

Equation (11) can be converted into the form to solve for {X}: 

[A]{X}  {B}≈  ( 13 ) 

with 

t t[A ] = [C  - t  [K ] ]γ ∆  ( 14 ) 

and 

t- t t{B} = {Q  + t{G} }γ∆ ∆  ( 15 ) 

In equation (14) there appears to be the possibility of a coefficient on the diagonal going to zero.  
This should not happen because kn,n < 0 (and kn,m ≥ 0) which forces an,n > 0 (and an,m ≤ 0).  The 
only possible problem is in the case of an isolated node, kn,n = 0, that is also massless, cn = 0, 
which will require special handling. 

CONTAMW maintains the same equation ordering for the contaminant equations as is used for 
airflows except that for each zone there is an equation for each contaminant species. These 
simultaneous linear equations for the implicit calculation of contaminant concentrations may be 
solved by any of four methods:  a direct skyline algorithm, an the iterative biconjugate gradient 
(BCG) algorithm, an iterative successive over-relaxation (SOR) algorithm, or LU decomposition. 
[Press 1992]. The skyline algorithm is the most reliable solution, and it is very fast for small 
problems but can be slow for large problems. The SOR algorithm requires much less memory 
and is faster unless there are convergence problems. In that case try the BCG solution. Before 
doing a long simulation, it may be useful to test the different methods to determine which will 
give optimum performance. 

5.2.3 Contaminant Source/Sink Elements 
CONTAMW allows you to define the generation, Gα, and removal, Rα, coefficients for some 
simple cases.  

� Constant Coefficient Model 
The constant coefficient or general source/sink model uses the following equation: 

S G R Cα α α= − ⋅ α  ( 16 ) 

where Sα is called the contaminant α “source strength.” The CONTAMW internal units for the 
terms in equation (16) are:  Cα [kgα / kgair], Gα, Sα [kgα / s], and Rα [kgair / s]. You may express 
these values in a large number of units with automatic conversion to the internal values.  

For a room air filtering device, G = 0.0 and R = fAAe where f is the flow rate of the room air 
passing through the filter and e is the single pass removal efficiency of the device. 

� Pressure Driven Model 
The pressure driven source/sink model is intended to model contaminant sources which are 
governed by the inside-outside pressure difference, such as radon or soil gas entry into a 
basement. In this case the source equation is: 
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( )n
ambt iS G P Pα α= ⋅ −  ( 17 ) 

� Cutoff Concentration Model 
For volatile organic compounds the source equation is sometimes expressed in the form 

1
cutoff

CS G
C

α
α α

 
= −  

   ( 18 ) 

where Ccutoff is the cutoff concentration at which emission ceases. 

� Decaying Source Model 
Another source equation for volatile organic compounds is the exponentially decaying source 
which is expressed in the form 

/t tcS G eα α
−=  ( 19 ) 

where 

Sα  =  the contaminant source strength 
Gα  =  the initial emission rate  
t  =  the time since the start of emission 
tc  =  the decay time constant 

� Boundary Layer Diffusion Controlled Model 
The boundary layer diffusion controlled reversible source/sink model follows the descriptions 
presented by Axley 1991. The rate at which a contaminant is transferred into the sink is 







 −⋅⋅

k
C

CAh s
iρ

 ( 20 ) 

where 

h  = average film mass transfer coefficient over the sink 
ρ  = film density of air, average of bulk & surface densities 
A  = surface area of the adsorbent 
Ci  = concentration in the air 
Cs  = concentration in the adsorbent 
k  = Henry adsorption constant or partition coefficient 

� Burst Source Model 
A user-specified mass of contaminant is added to a zone in a single time step, effectively an 
instantaneous addition – nothing can be resolved at less than one time step. 
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5.3 Airflow Analysis 
Over the years many methods have been developed to compute the building airflows which are 
necessary for the contaminant analysis. Feustel and Dieris report 50 different computer programs 
for multizone airflow analysis [Feustal and Dieris 1992]. Note that “zones” go by many other 
names in these programs, e.g., nodes, cells, and rooms are common alternatives. The airflow 
calculations in CONTAMW are based on the algorithms developed in AIRNET [Walton 1989a 
and 1989b].  

5.3.1 Basic Equations 
The air flow rate from zone j to zone i, Fj,i [kg/s], is some function of the pressure drop along the 
flow path,  Pj - Pi: 

( )ijij PPfF −=,     ( 1 ) 

The mass of air, mi [kg], in zone i is given by the ideal gas law 

i

ii
iii RT

VP
Vm == ρ

 ( 2 ) 

where 

Vi  = zone volume [m3], 
Pi  = zone pressure [Pa], 
Ti  = zone temperature [K], and 
R  = 287.055 [J/kg⋅K] (gas constant for air). 

For a transient solution the principle of conservation of mass states that 
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where  

mi  = mass of air in zone i,  

Fj,i  = airflow rate [kg/s] between zones j and zone i:  positive values indicate flows from j to i 
and negative values indicate flows from i to j, and 

Fi  = non-flow processes that could add or remove significant quantities of air from the zone. 

CONTAMW 1.0 did not provide for such non-flow processes and flows were evaluated by 
assuming quasi-steady conditions leading to the following equation 

0, =∑
j

ijF
 ( 5 ) 
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This version of CONTAMW can provide for such non-flow processes by allowing the density to 
vary during time steps when performing transient simulations.  

5.3.2 Solving the Equations 
The steady-state airflow analysis for multiple zones requires the simultaneous solution of 
equation (5) for all zones. Since the function in equation (1) may be, and usually is, nonlinear, a 
method is needed for the solution of simultaneous nonlinear algebraic equations. The Newton-
Raphson (N-R) method [Conte and  de Boor 1972 p 86] solves the nonlinear problem by an 
iteration of the solutions of linear equations. In the N-R method a new estimate of the vector of 
all zone pressures, {P}*, is computed from the current estimate of pressures, {P}, by  

{ } { } { }CPP −=∗
 ( 6 ) 

where the correction vector, {C}, is computed by the matrix relationship 

[ ]{ } { }BCJ =  ( 7 ) 

where {B} is a column vector with each element given by 

∑=
j

iji F ,B
 ( 8 ) 

and [J] is the square (i.e. N by N for a network of N zones) Jacobian matrix whose elements are 
given by 

∑ ∂
∂

=
i j

ij
ji P

F ,
,J

  ( 9 ) 

In equations (8) and (9) Fj,i and MFj,i/MPj are evaluated using the current estimate of pressure {P}. 
The CONTAMW program contains subroutines for each airflow element which return the mass 
flow rates and the partial derivative values for a given pressure difference input.  

Equation (7) represents a set of linear equations which must be set up and solved for each 
iteration until a convergent solution of the set of zone pressures is achieved. In its full form [J] 
requires computer memory for N2 values, and a standard Gauss elimination solution has 
execution time proportional to N3. Sparse matrix methods can be used to reduce both the storage 
and execution time requirements. A skyline solution process following the method presented in 
[Dhatt 1984] was chosen. This method can be used to solve equations with symmetric or 
asymmetric matrices. It stores no zero values above the highest nonzero element in the columns 
above the diagonal and no zero values to the left of the first nonzero value in each row below the 
diagonal. In this case the Jacobian matrix is symmetric. CONTAMW provides two solution 
methods for the linear equations: Skyline (also called profile method) and Pre-conditioned 
Conjugate Gradient (PCG). PCG may be useful for problems with many zones and junctions. 

Analysis of the element models will show that  

∑
+

=
ij

jii,i ,JJ
 ( 10 ) 
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This condition allows a solution without pivoting, although scaling may be useful. Note that the 
degree of sparseness of the Jacobian matrix after factoring is dependent on the ordering of the 
zones. Ordering can be improved by various algorithms or rules-of-thumb. In AIRNET it was 
easy to define an airflow network which had no unique solution. The CONTAMW user interface 
insures the correct interconnection of the airflow elements in the network. 

CONTAMW allows zones with either known or unknown pressures. The constant pressure zones 
are included in the system of equations and equation (7) is processed so as to not change those 
zone pressures. This gives flexibility in defining the airflow network while maintaining the 
symmetric set of equations. A sufficient condition for the Jacobian to be nonsingular [Axley 
1987] is that all of the unknown pressure zones be linked by pressure dependent flow paths to (a) 
constant pressure zone(s). In CONTAMW the ambient (or outdoor) air is treated as a constant 
pressure zone. The ambient zone pressure is assumed to be zero for the flow calculation causing 
the computed zone pressures to be values relative to the true ambient pressure and helping to 
maintain numerical significance in calculating ∆P.  

Conservation of mass at each zone provides the convergence criterion for the N-R iterations. 
That is, when equation (4) is satisfied for all zones for the current system pressure estimate, the 
solution has converged. Sufficient accuracy is attained by testing for relative convergence at each 
zone: 

ε<
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∑
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j ij
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 ( 11 ) 

with a test ('*Fj,i* < ε1, the absolute convergence factor) to prevent division by zero. The 
magnitude of ε can be established by considering the use of the calculated airflows, such as in an 
energy balance. In any case, round-off errors may prevent perfect convergence (ε = 0). 

Numerical tests of the N-R method solution indicated occasional instances of very slow 
convergence as the iterations almost oscillate between two different sets of values. In AIRNET, 
this was handled by a Steffensen acceleration process. More recent tests by the author and by 
Wray [Wray 1993] indicate that the use of a simpler constant under-relaxation coefficient 
produces a faster, reliable convergence acceleration process. Equation (6) for the iteration 
process becomes  

{ } { } { }CPP ω−=*
 ( 12 ) 

where ω is the relaxation coefficient. A relaxation coefficient of 0.75 has been found to be usable 
for a broad range of airflow networks. This value is not a true optimum but appears to work quite 
well without the computational cost of finding the theoretically optimum value.  

When convergence is progressing rapidly, under-relaxation (ω < 1) slows convergence compared 
to no relaxation. To prevent this a global convergence value is computed: 
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When γ* < α γ, ω is set to 1. Currently CONTAMW uses α = 30 %. This often reduces the 
number of iterations. This is simple under-relaxation. CONTAMW 2.0 also may alternatively 
use a simple trust region method implemented by David M. Lorenzetti based on [Dennis and 
Schnabel 1996]. 

Newton's method requires an initial set of values for the zone pressures. These may be obtained 
by including in each airflow element model a linear  approximation relating the flow to the 
pressure drop: 

( )ijijijij PPbcF −+= ,,,  ( 14 ) 

Conservation of mass at each zone leads to a set of linear equations of the form 

[ ]{ } { }BPA =  ( 15 ) 

Matrix [A] in equation (15) has the same sparseness pattern as [J] in equation (7) allowing use of 
the same sparse matrix solution process for both equations. This initialization handles stack 
effects very well and tends to establish the proper directions for the flows. The linear 
approximation is conveniently provided by the laminar regime of the element models used by 
CONTAMW. When solving a set of similar problems, as when approximating a transient 
solution by successive steady-state solutions, it tends to be preferable to use the previous solution 
for the zone pressures as the initial values for the new problem. 

5.3.3 Airflow Elements 
Infiltration is the result of air flowing through openings, large and small, intentional and 
accidental, in the building envelope. Simulation programs require a mathematical model of the 
flow characteristics of the openings. For a general introduction see Chapter 25 of [ASHRAE 
1997] and section 2.2 of [Feustel 1990]. 

Flow within each airflow element is assumed to be governed by Bernoulli's equation: 
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where 

∆P  = total pressure drop between points 1 and 2 
P1, P2 = entry and exit static pressures 
V1, V2 = entry and exit velocities 
ρ  = air density 
g  = acceleration of gravity (9.81 m/s2) 
z1, z2 = entry and exit elevations. 

The following parameters apply to the zones:  pressure, temperature (to compute density and 
viscosity), and elevation. The zone elevation values are used to determine stack effect pressures. 
When the zone represents a room, the airflow elements may connect with the room at other than 
its reference elevation. The hydrostatic equation is used to relate the pressure difference across a 
flow element to the elevations of the element ends and the zone elevations, assuming the air in 
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the room is at constant temperature. Pressure terms can be rearranged and a possible wind 
pressure for building envelope openings added to give 

WSij PPPPP ++−=∆
  ( 17 ) 

where 

Pi, Pj = total pressures at zones i and j 
PS  = pressure difference due to density and elevation differences, and 
PW  = pressure difference due to wind. 

Equation (17) establishes a sign convention for direction of flow:  positive is from zone j to zone 
i. Since the airflow elements will be described by a relationship of the form w = f(∆P), the partial 
derivatives needed for [J] in equation (9) are related by Mw/MPj = -Mw/MPi which establishes the 
relation in equation (10). Many forms of airflow elements are available in CONTAMW. 

5.3.3.1 Powerlaw Flow Elements 
Most infiltration models are based on the following empirical (powerlaw) relationship between 
the flow and the pressure difference across a crack or opening in the building envelope: 

( )nPCQ ∆=   ( 18 ) 

The volumetric flow rate, Q [m3/s], is a simple function of the pressure drop, ∆P [Pa], across the 
opening. A common variation of the powerlaw equation is: 

( )nPCF ∆=   ( 19 ) 

where the mass flow rate, F [kg/s], is a simple function of the pressure drop. A third variation is 
related to the orifice equation: 

ρ
PACQ d

∆= 2

 ( 20 ) 

where  

Cd  = discharge coefficient, and  
A  = orifice opening area. 

Theoretically, the value of the flow exponent should lie between 0.5 and 1.0. Large openings are 
characterized by values very close to 0.5, while values near 0.65 have been found for small 
crack-like openings.  

The primary advantage of equations (18-20) for describing airflow components is the simple 
calculation of the partial derivatives for the Newton's method solution of the simultaneous 
equations: 
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=
∂

∂ ,,

 ( 21 ) 
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The sign in equations (21) will agree with the sign of F. However, there is also a problem with 
equations (21): the derivatives become unbounded as the pressure drop (and the flow) go to zero. 
A simple way to avoid this problem is suggested by what physically happens at low flow rates: 
the physical character of the flow (and the form of the equation) changes. It goes from turbulent 
to laminar. Equations (18-20) can be replaced by 

µ
ρ PC

F k ∆
=

 ( 22 ) 

where  

Ck  = laminar flow coefficient, and  
µ  = viscosity.  

The partial derivatives are simple constants: 

µ
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P
F k

j

ij =
∂
∂ ,

    and    µ
ρk

i

ij C
P

F −
=

∂
∂ ,

 ( 23 ) 

The origin of this laminar relationship is shown by the duct equations in the next section. This 
technique has been independently discovered and used by several researchers [Axley 1987] and 
[Isaacs 1980]. Although there is physical reason for using equation (22) at low pressure drops, its 
purpose here is to assure convergence of the equations when ∆P approaches zero for one of the 
many flow paths in a complex network, instead of accurately representing airflows which are too 
small to be of interest. Because the linear flow expression is not used as a true flow model but as 
a mathematical artifice, it is not necessary to adjust its flow coefficient. Given the uncertainty in 
estimating the temperature of the air as it flows through an opening, especially a crack, this 
additional detail is of debatable usefulness. 

The CONTAMW functions for powerlaw elements calculate flows using both the laminar and 
the turbulent models and select the method giving the smaller magnitude flow. There is a 
discontinuity in the derivative of the F(∆P) curve where the two equations intersect. This 
discontinuity is a violation of one of the sufficient conditions for convergence of Newton's 
method [Conte and de Boor 1972, p 86]. However, numerical tests conducted by the author for 
flows at that point using a small airflow network have shown no convergence problem. 
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Temperature Dependence 
It is useful to think of the coefficient C as a simple constant, Cα, evaluated at a particular set of 
conditions (µ0, ρ0 and ν0=µ0/ρ0) multiplied by a correction factor to account for actual air 
properties. Equations (18-20) are converted to a common form and summarized below with their 
appropriate temperature correction factors.  

∆P > 0 ∆P < 0 Correction Factor  

( )n
jaaij PCKF ∆= ρ,  ( )n

iaaij PCKF ∆−−= ρ,  ( ) ( ) 12// −= n
o

n
oa vvK ρρ  

 

( )n
jbbij PCKF ∆= ρ,  

( )n
ibbij PCKF ∆−−= ρ,  ( ) ( ) 122/1

0 // −−= n
o

n
b vvK ρρ ( 24 ) 

( )n
ccij PCKF ∆=,  ( )n

ccij PCKF ∆−−=, ( ) ( ) 121 // −−= n
o

n
oc vvK ρρ  

 

CONTAM uses the following formulae for computing ρ and ν: 

ρ = P / (287.055 T) 

µ = 3.7143@10-6 + 4.9286@10-8 T 

ν = µ / ρ 

Using reference conditions of standard atmospheric pressure and 20°C gives ρo = 1.2041 kg/m3 
and νo = 1.5083@10-5 m2/s. 

Fitting Powerlaw Coefficients 
Experimental data can be used to determine the coefficients in the orifice form of the powerlaw 
equation:  

( ) ( 10 =∆±±= b
n

b KPCF ρ )
 ( 25 ) 

If n is known or can be assumed, Cb, in equation (24), can be computed from the inverse of 
equation (25) 

( )nb P
FC
∆

=
0ρ  ( 26 ) 

When two points (F1, ∆P1) and (F2, ∆P2), are known, n can be computed from: 

( ) ( )
( ) ( )21

21

lnln
lnln

PP
FF

n
∆−∆

−
=

 ( 27 ) 

with Cb then computed from equation (26).  
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Leakage Areas 
The powerlaw model can be used with the component leakage area formulation which has been 
used to characterize openings for infiltration calculations [ASHRAE 1997, pp 25.18]. The 
leakage area is based on a series of pressurization tests where the airflow rate is measured at a 
series of pressure differences ranging from about 10 to 75 Pa. The effective leakage area is based 
on a rearrangement of equation (20) 

d

rr

C
PQ

L
∆

=
2/ρ

 ( 28 ) 

where  

L  = equivalent or effective leakage area [m2], 
∆Pr  = reference pressure difference [Pa], 
Qr  = predicted airflow rate at ∆Pr (from curve fit to pressurization test data) [m3/s], and 
Cd  = discharge coefficient. 
 

There are two common sets of reference conditions: 

Cd = 1.0  and ∆Pr = 4 Pa 

 or 

Cd = 0.6  and ∆Pr = 10 Pa. 

A leakage area can be converted to the flow coefficient by 

( ) n
rdb PLCC −∆= 2/12  ( 29 ) 

This equation requires a value for n. If it is not reported with the test results, a value between 0.6 
and 0.7 is reasonable. 
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Stairwells 
A stairwell will normally be modeled as a vertical series of zones connected by low resistance 
openings through the floors. The CONTAMW model for airflow in stairwells is based on a fit to 
experimental data [Achakji and Tamura 1988]. They expressed the airflow resistance per floor as 
an effective area Ae in the orifice equation (20) with a 0.6 discharge coefficient. The effective 
area is expressed in terms of the area of the shaft AS, the distance between floors h, the density of 
people on the stairs d, and whether the treads are open or closed. A large number of people on 
the stairs, as in an evacuation scenario, influences the flow resistance. The experiment used 
densities of 0, 1, and 2 persons/m5. For open treads the effective area is approximately 

( )( )dhAA se 14.00.1089.0 −≈  ( 30 ) 

and for closed treads 

( )( )dhAA se 24.00.1083.0 −≈  ( 31 ) 

The coefficients for the powerlaw equation are 

0.5 and 0.6 2b en C= = ⋅ A⋅  ( 32 ) 

Cracks 
A relationship for flow through cracks that can be converted directly into a powerlaw airflow 
element is presented in [Clarke 1985, p 204] as: 

( )nQ ka P= ∆
 ( 33 ) 

where 

( )2/exp5.05.0 Wn −+= ,  ( 34 ) 

and 

( )nk 0092.00097.0 ⋅=  ( 35 ) 

with 

W = crack width (mm), and 

a  = crack length (m). 

Therefore, the coefficients in the powerlaw equation (19) are given by n in equation (34) and 

( )0 0.0097 0.0092 n
bC aρ=

 ( 36 ) 
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5.3.3.2 Quadratic Flow Elements 
Baker, Sharples, and Ward [Baker 1987] indicate that infiltration openings can be more 
accurately modeled by a quadratic relationship of the form 

 

0, >∆PQ  0, <∆PQ  
2BQAQP +=∆  

2BQAQP −=∆  
( 37 )

 

This form can be used as an airflow element by solving the quadratic equation for F (= ρQ). 
Letting a = A/ρ and b = B/ρ2 allows equations (37) to be rewritten as 

22 bFaFPandbFaFP −=∆+=∆  ( 38 ) 

These quadratic equations solve as 
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b
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with the partial derivatives given by 
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Equations (39) require that b be nonzero to prevent a division by zero and equations (40) requires 
that a be nonzero to prevent a division by zero as F goes to zero. There are contrary opinions that 
the powerlaw relationship is better. 

Temperature Dependence 
It is useful to think of the coefficients a and b as simple constants evaluated at a particular set of 
conditions (µ0, ρ0 and ν0=µ0/ρ0) multiplied by correction factors to account for actual air 
properties as was done for the powerlaw equations. That is 
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and 
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ρ
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 ( 42 ) 

Note that ρ0/ρ = T/T0 for a perfect gas of constant composition.  
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Fitting Quadratic Coefficients 
The quadratic coefficients can also be computed from measured flow and pressure data. Given 
two points (F1, ∆P1) and (F2, ∆P2), the values of a0 and b0 are: 
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0 FF
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and 

10
1

1
0 Fb

F
P

a −
∆

=
 ( 44 ) 

The main advantage of the quadratic model over the powerlaw model is computation speed 
achieved by avoiding the slow power function. (Tests have shown pow(x) four to eight times 
slower than sqrt(x). This performance is hardware and software dependent.)  It must still be 
determined which model is the most accurate representation for a particular airflow element. For 
example, it has been found that the powerlaw model is a better approximation for smooth ducts 
while the quadratic model is a better approximation for rough ducts. However, for very large 
openings the derivatives (40) can become quite large leading to slow convergence of the 
simultaneous mass balance equations. 

Crack Description 
Theoretical relationships have been developed between the coefficients A and B of the quadratic 
airflow element model and the physical characteristics of the openings [Baker 1987]. These are 

22
00

3
00 2//12 LdCBandLdzA ρµ ==  ( 45 ) 

where  

µ  = viscosity,  
ρ  = density,  
z  = distance along the direction of flow,  
d  = crack width,  
L  = crack length, and  
C  = 1.5 + number of bends in the flow path.  

For the mass flow form of the equations (38) the coefficients are 

22
00

3
000 2//12 LdCbandLdza ρρµ ==  ( 46 ) 
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5.3.3.3 Ducts 
The theory of flows in ducts (and pipes) is well established and summarized in Chapter 34 of the 
2001 ASHRAE Fundamentals Handbook [ASHRAE 2001] and treated more extensively in 
[Blevins 1984] in a chapter on pipe and duct flow. See the Duct Fitting Database [ASHRAE 
1994] for extensive data on dynamic losses in duct fittings. Analysis is based on Bernoulli's 
equation and its assumptions. The friction losses in a section of duct or pipe are given by 

2

2V
D
LfPf

ρ=∆
 ( 47 ) 

where  

f  = friction factor, 
L  = duct length, and  
D  = hydraulic diameter.  

The dynamic losses due to fittings and so forth are given by 

2

2VCP dd
ρ=∆

 ( 48 ) 

where Cd = dynamic loss coefficient. Total pressure losses are given by 

∑∆+∆=∆ df PPP
 ( 49 ) 

Since F = ρVA, where A is the cross section (or flow) area, 

∑+
∆=

dCDfL
PAF

/
2 2ρ

 ( 50 ) 

The friction factor can be computed using the nonlinear Colebrook equation [ASHRAE 1997, p 
2.9, eqn. 29b]: 
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

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⋅⋅
+⋅−⋅+=
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f /Re
3.91log2/log244.11

ε
ε

 ( 51 ) 

where  

ε  = roughness dimension, and  
Re  = Reynolds number = ρVD/µ = FD/µA.  

This nonlinear equation may be readily solved using the following iterative expression derived 
from equation (51) by Newton's method: 

( )
( )βγβ

βγα
g

gggg
++

++−−=∗

1/1
1ln

  ( 52 ) 
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where 

g = f -1/2, 
α = 1.14 - γ ln(ε/D), 
ß = 9.3/(Re@ε/D), and 
γ = 2@log(e) = 0.868589. 

The convergent solution is achieved in 2 or 3 iterations of equation (52) using g = α as a starting 
value. If the value of g has been saved from the previous time it was computed for a particular 
duct element, and the flow rate has not changed greatly, only one iteration of equation (52) will 
be needed to compute the friction factor. 

The exact derivatives of equation (50) are difficult to compute, so CONTAMW uses a secant 
approximation. The derivatives suffer the standard problem of powerlaw equations, i.e., they go 
undefined as ∆P approaches zero. This is solved in CONTAMW by the linear approximation 
(22) with the coefficient computed to give the same flow as equation (50) at the user specified 
transition Reynolds number (default = 2000). A more detailed description of the flow in the 
laminar region could be developed, but that would probably exceed the level of detail with which 
the rest of the problem is described in CONTAMW. 

5.3.3.4 Fans 
This section describes the theory of how forced flow elements are modeled with CONTAMW. 
Forced flow elements include constant flow fans and variable flow fans. Constant flow fans 
include both constant volume and constant mass flow. Variable flow fans are modeled based on 
the input of a fan performance curve that relates pressure drop to airflow through the fan flow 
element. 

Constant Flow Fans 
One particularly simple but useful airflow element sets a constant flow between two nodes. Since 
the flow is constant, the partial derivatives of flow with respect to the node pressures must be 
zero. The constant flow element does not contribute to the Jacobian, [A], but it does add to the 
right side vector, {B}. 

Constant flow elements do not mathematically link the pressures of the adjacent nodes. It is 
necessary that all node in the network be linked to constant pressure nodes in order to have a 
unique solution. Violation of this restriction will produce a division by zero somewhere in the 
solution of the equations. Consider the following simple network: 
 

     !----C1----!----F1----!----C2----!----F2----!----C3----! 

     P1         P2         P3         P4         P5         P6 

 

where P1 and P6 are known pressures, and F1 and F2 are known flows. Since the flow through C2 
is determined by P3 - P4, and no other flow is related to those pressures, there are not enough 
equations to determine P3 and P4 uniquely. This is a mathematical expression of the fact that it is 
possible for F1 and F2 to be assigned different flows, which produces a physically impossible 
condition.  
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CONTAMW provides two constant flow elements: one for constant mass flow and one for 
constant volumetric flow. 

Variable Flow Fans 
The theory of flows induced by fans is summarized in Chapter 18 of the 2000 ASHRAE HVAC 
Systems and Equipment Handbook [ASHRAE 2000]. More extensive treatment is given in 
[Osborne 1977]. Fan performance is normally characterized by a performance curve which 
relates the total pressure rise to the flow rate for a given fan speed and air density. Conversion to 
another fan speed or density is done with the fan laws. 

00 // NNQQ =  ( 53 ) 

or 

000 // ρρ NNFF =  ( 54 ) 

and 

2 2
0 0/ /P P N N 0ρ ρ=  ( 55 ) 

where  

Q = volume flow rate 
F = mass flow rate 
P = total pressure rise 
ρ = density 
N = rotational speed 
  subscript 0 indicates values at the rating conditions for the fan. 
 

These laws are valid if all flow conditions at the two speeds are similar. In particular, they will 
not apply at very low flows where fully turbulent conditions have not been developed.  

In CONTAMW the fan performance curve is represented by a cubic polynomial: 

3
3

2
210 FaFaFaaP +++=  ( 56 ) 

with 

2
321 32 FaFaa

dF
dPP ++==′

 ( 57 ) 

The polynomial coefficients are developed with air density and fan speed at the rating 
conditions. Therefore, when N and ρ are not at the rating conditions, convert the actual pressure 
rise P to P0. 

ρρ 2
0

2
00 / NPNP =  ( 58 ) 

Solve (56) for F0 and (57) for P0N. Convert these values to current conditions. 
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000 / ρρ NNFF =  ( 59 ) 

and 

00 / NNPP =′  ( 60 ) 

The derivative for flow with respect to pressure drop is given by 

PdP
dF

′
−= 1

 ( 61 ) 

There are two important factors to note on the shape of the fan performance curve. First, it is 
described by a relationship of the form P(F) instead of F(P) which would be more appropriate 
for the calculation of flow and partial derivatives for the Jacobian. The basic shape of the 
performance curve cannot be well represented by a simple polynomial with P as the independent 
variable. CONTAMW uses an analytic solution of the cubic polynomial (56) to determine F as a 
function of P.  

Second, it is common for the performance curve to contain points of contraflecture (where PN = 
0) creating up to three different flow rates at certain values of fan pressure rise. This causes 
difficulty in solving for the flow rate and has points where dF/dP goes to infinity. However, it is 
usually not recommended that the fan operate in the region of the contraflecture points. 
Therefore, the fan can be modeled with a performance curve that does include the contraflecture 
so long as you make sure that the air distribution system has not operated in that region. 

You can identify the points of contraflecture from the coefficients of the polynomial. Solving 
equation (56) for F gives: 

3

31
2
22

6
1242

a
aaaa

F
−±−

=
 ( 62 ) 

2
2 14 12a a> 3a

3a

3a

 
There are two real points of contraflecture 

2
2 14 12a a=  

There is a point of inflection which still has the derivative 
problem 

2
2 14 12a a<  

The fan performance curve is monotonic and well-behaved for 
computing the derivatives for the Jacobian. 
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5.3.3.5 Doorways (Large Openings) 
The powerlaw and quadratic models allow flow in only one direction at a time. Flows through 
large openings (e.g. doorways) tend to be more complex with the possibility of flows in opposite 
directions in different parts of the opening. The temperature and resulting density differences 
between two rooms may mean that the stack effect causes a positive pressure difference at the 
top of the doorway and a negative pressure difference at the bottom (or vice versa) allowing a 
two-way flow in the opening. A summary of research on heat transfer through doorways is 
presented in [Barakat 1987]. Most research has attempted to develop dimensionless correlations 
(using Nusselt, Prandlt, and Grashoff numbers) of the form  

b
Dd GrCN ⋅=Pr/  ( 63 ) 

where b is approximately 0.5 and C lies between 0.22 and 0.33 depending on the temperature 
difference used for the correlation. It has been shown that such a heat transfer is equivalent to an 
airflow which can be modeled by powerlaw elements by dividing the total opening into several 
smaller openings having the same total area but configured to properly account for the magnitude 
and direction of airflows at different heights in the opening. 

An alternative approach is to create a single airflow element which accounts for the flow over the 
entire opening. A simple theory which estimates the stack induced air flow through a large 
opening in a vertical partition is given in [Brown and Solvason 1962]. This model of a doorway 
tends to be faster that the multiple opening approach. However, it also complicates the assembly 
process for the Jacobian matrix because one or two flows may exist. More importantly, 
development of the doorway element model requires knowledge of the vertical temperature 
profile used in the node model (here assumed to be constant) in order to compute the pressure 
difference as a function of height across the opening. This requirement compromises the 
independence of the modularity of airflow network program. 

Multiple Opening Model 
By assuming that the air density in each room is constant, the hydrostatic equation is used to 
relate pressures at various heights in each room: 

( ) ( )0 0 0andj j j j i i i iP P g h h P P g h hρ ρ= + − = + − 0

i

 ( 64 ) 

( ) ( )0 0andj j j i iP y P gy P y P gyρ ρ= − = −
 ( 65 ) 

where 

P0j, P0i pressure in zones j and i at y = 0, the reference elevation of the opening, 
ρj, ρi air densities of zones j and i, 
Pj, Pi reference pressures of zones j and i, 
hj, hi reference elevations of zones j and i, and 
h0  elevation of the center of the opening. 

Following [Brown and Solvason 1962] it is assumed that the velocity of the airflow as a function 
of height is given by the orifice equation: 
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( ) ( ) ( )( ) 2/12
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 −
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yPyP

CyV ij
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 ( 66 ) 

where  

Cd  = discharge coefficient, and 

ρ  = density of the air going through the opening. 

The opening, H high by W wide, may be divided into multiple openings each representing a thin 
horizontal strip ∆y high and W wide. The mass flow through each strip would be 

yWPCF dy ∆∆= ρ2
 ( 67 ) 

The coefficient for the powerlaw model (20) for each sub-opening is thus given by  

yWCC d ∆= 20  ( 68 ) 

Two Opening Model 
An approximate model can be constructed by considering an opening between two zones which 
have no flow paths to any other zones. Then the flow in each direction must be equal and P0j = 
P0i. Integration of equation (66) from y=0 to y=H/2 using (65) to compute ∆P gives the flow 
through the top half of the opening. 
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 ( 69 ) 

This is equivalent to a simple powerlaw model with 
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2
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HWCC d
 ( 70 ) 

(a simple orifice with one half the total opening area) placed at an elevation of y = 2H/9. The two 
opening model is completed with an identical opening at y = -2H/9 elevation allowing an equal 
flow in the opposite direction. Since the orifice is being modeled with simple orifice openings, 
any additional pressure drop between the zones due to other forces is included in the two opening 
model. The model becomes less accurate as the neutral plane shifts from the center of the 
opening. 

Single Opening Model 
A third approach is to create a single airflow element which accounts for the flow over the entire 
opening. Begin by defining the neutral height, Y, where the velocity of the air is zero. From 
equation (66) this must occur when Pj(y) = Pi(y). From equations (65) this must be 
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If |Y| < H/2, there is two-way airflow through the opening. If ρj = ρi, the neutral height cannot be 
computed, but, since there is no possibility of two-way flow, the opening can be considered a 
simple orifice opening.  

Define ∆ρ ≡ ρj - ρi and a transformed height coordinate z ≡ y - Y. Then the pressure difference 
across the opening is given by 

( ) ( ) ρ∆−=− gzzPzP ij  ( 72 ) 

The mass flow through the opening above the neutral height is given by 

iorjmdzVWF
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 ( 73 ) 

and the mass flow below the neutral height by 

iorjmdzVWF
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 ( 74 ) 

Whether the subscript m should be j or i depends on the direction of flow. Integration of 
equations (73) and (74) gives several different solutions for the airflow depending on the value 
of Y and the sign of ∆ρ. Defining: 
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 ( 75 ) 

gives the following equations for flows. 

Case 0>∆ρ  0<∆ρ   

2/HY −≤  bzi ffGF −−= ρ  bzj ffGF −= ρ
 

( 76 )

2/HY ≥  bzj ffGF −= ρ
 bzi ffGF −−= ρ  

( 77 )

2/2/ HYH <<−  aja fGF ρ−=
 aja fGF ρ=

 
( 78 )

 
bjb fGF ρ=
 bjb fGF ρ−=

 
( 79 )
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